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CUSTOMER SOFTWARE LICENSE 
THE LICENSE (USA) 
Image Processing and Vision Company Limited (trading as 

Improvision) (the "Licensor", which expression shall include 

its subsidiaries, agents, successors and assigns) is 

authorized to license the software, documentation and any 

fonts contained in this package (the "Software") and upon 

opening the sealed package containing the Software, the 

Licensee accepts a non-exclusive License to "Use" (as 

hereinafter defined) the Software on a single computer 

system (the "System") for single use specified below upon 

the terms and subject to the conditions contained 

herein.  The Licensee owns the media on which the 

Software is recorded, but the Licensor retains title to the 

Software.  

This License entitles the Licensee to:  

(a)  load, install and Use the Software contained in this 

package on one Central Processing Unit ("CPU") of the 

System (a separate LICENSE fee being required for 

each CPU upon which the Licensee wishes to use the 

Software)  

(b) Use the Software in accordance with the provisions of 

Section 2 of this License; 

and, where the Licensee signs and returns the warranty 

card enclosed with the Software, to:  

(a)  receive telephone technical support relating to the 

Software during the Licensor's usual business hours, 

within the period of the software maintenance 

agreement; 

(b) receive information on upgraded versions of the 

Software at such cost (if any) as may be notified to the 

Licensee. 

1. Acceptance of this LICENSE 
The terms and conditions of this License are deemed to be 

accepted:  

(a)  by the Licensor upon dispatch/delivery by the Licensor 

of this package to the Licensee; and  

(b) by the Licensee by breaking the seal of this sealed 

package containing the Software; or 

(c) by the Licensee signing and returning the enclosed 

warranty card. 

2. Use of the Software 

(a)  For the purposes of this License "Use" shall mean and 

include: 

(i)   utilization of the Software by copying, transmitting 

or loading the same into the temporary memory 

(RAM) or installing into the permanent memory (e.g. 

hard disk, CD ROM or other storage device) of the 

System for the processing of the System 

instructions or statements contained in such 

Software; 

(ii)  copying the Software which is in machine-readable 

form for Use by the Licensee on the System for the 

purposes only of understanding the contents of 

such machine-readable material and for back-up 

provided that (A) no more than one (1) non-

transient copy will be in existence under this 

License at any one time without prior written 

consent from the Licensor or as otherwise 

permitted by the applicable law, and (B) such 

backup copy includes all copyright information 

contained on the original; 
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(iii)  storing the whole or any part of the Software on the 

System or other storage unit or disk; and 

(iv) utilizing (but not copying) the instructional and/or 

operational manuals relating to the Software. 

(b)  The Licensee acknowledges and accepts that the 

Software is protected against unauthorized use by 

means of a serial number. 

(c)  The Licensee shall also be permitted to Use the 

Software on a portable, lap-top or home computer 

where the Software is permanently installed on the 

hard disk or other storage device of the System (but not 

a file server) and the Licensee or its relevant employee 

as the case may be is the predominant user of the 

Software and such Use will not breach the concurrent 

user limit where applicable.  

(d)  THE SOFTWARE IS NOT INTENDED FOR USE IN 

THE OPERATION OF NUCLEAR FACILITIES, 

AIRCRAFT NAVIGATION OR COMMUNICATION 

SYSTEMS, OR AIR TRAFFIC CONTROL MACHINES 

IN WHICH CASE THE FAILURE OF THE SOFTWARE 

COULD LEAD TO DEATH, PERSONAL INJURY, OR 

SEVERE PHYSICAL OR ENVIRONMENTAL DAMAGE. 

(e)  The Licensee's rights under this License will terminate 

automatically without notice from the Licensor if the 

Licensee fails to comply with any term(s) of this License. 

3. License Fee 

(a) Where the License Fee has not been paid by the 

Licensee at the time the Software is obtained from the 

Licensor or its agent the License Fee will be payable 

within the number of days specified in the Licensor's 

invoice unless otherwise agreed to in writing by the 

Licensor. 

(b) An additional License Fee is payable for each CPU of 

the System upon which the Licensee wishes to Use the 

Software. In the event that the Licensee's System is 

inoperable, the Licensee shall be permitted to Use the 

Software on a back-up system at no extra charge, until 

the System is operational. 

4. Licensee's Undertakings 

(a)  The Licensee undertakes not to perform any of the acts 

referred to in this sub-clause (a) except to the extent 

and only to the extent required by the applicable law as 

applied to the Licensee as a lawful user (i.e. a party 

with a right to use) of the Software and only then for the 

specific limited purpose stated in such applicable law or 

hereunder. 

The Licensee undertakes: 

(i)   not to copy the Software (other than for normal 

System operation and as specified in Section 2 

above) nor otherwise reproduce the same provided 

that the Licensee may copy the Software for back-

up or archival purposes or incidentally, in the 

course of converting the Software in accordance 

with  Section 4(a)(iii) below; 

(ii)  not to translate, adapt, vary, or modify the Software 

or its source or object code; 

(iii)  subject to subsection (iv) below, without the 

Licensor’s prior written consent, not to disassemble, 

decompile, reverse engineer, modify, or create 
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derivative works based on the Software in whole or 

in part or transmit the Software over a network, 

provided however that in the case of decompilation, 

the Licensee may incidentally decompile the 

Software only if it is essential to do so in order to 

achieve interoperability of the Software with 

another software program (“Permitted 

Purpose”)and provided the information obtained by 

the Licensee during such decompilation is only 

used for the Permitted Purpose and is not disclosed 

or communicated to any third party to whom it is not 

necessary to disclose or communicate such 

information and it is not used to create any software 

which is substantially similar to the Software or the 

expression of the Software nor used in any manner 

which would be restricted by copyright. 

(iv) It shall be a condition precedent to the 

decompilation of the Software permitted in 

accordance with the terms referred to in subsection 

(iii) above, that the Licensee shall have notified the 

Licensor in writing (a) that it wishes to perform the 

decompilation; (b) the purposes for which it wishes 

to perform the decompilation; and (c) the 

information which it requires for such 

purposes.  Only when the Licensor has either (a) 

not responded within a reasonable time or (b) has 

not offered to provide the Licensee with information 

required under (c) above (for which the Licensor 

may require payment) shall the Licensee be 

permitted to continue with the decompilation. 

The Licensee undertakes: 

(b) to maintain accurate and up-to-date records of the 

number and location of all copies of the Software. 

(c)  to supervise and control Use of the Software in 

accordance with the terms of this License. 

(d) to ensure that its employees, agents and other duly 

authorized parties who will use the Software (including 

any transferee of the Software) are notified of this 

License and the terms hereof prior to such use. 

(e) to reproduce and include the copyright notice of the 

Licensor or such other party as may be specified in or 

on the Software (the "Owner") on all and any copies, 

whether in whole or in part, in any form, including 

partial copies or modifications of the Software made 

herein. 

(f) not to provide or otherwise make available the Software 

in whole or in part (including where applicable, but not 

limited to program listings, object code and source 

program listings, object code and source code), in any 

form to any person other than the Licensee's 

employees or as specified in (d) above without prior 

written consent from the Licensor.   

(g) within 14 days after the date of termination or 

discontinuance of this License for whatever reason, to 

destroy the Software and all updates, upgrades or 

copies, in whole and in part, in any form including 

partial copies or modifications of the Software received 

from the Licensor or made in connection with this 

License, and all documentation relating thereto and 

certify in writing that the Licensee has complied with 

this subsection.  
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5. Disclaimer of Warranty 
The Licensee acknowledges and agrees that use of the 

Software is at the Licensee's sole risk.  The Software is 

provided "AS IS" and without warranty of any kind and the 

Licensor and Licensor's licensor(s) (for the purposes of 

Sections 5 and 6, Licensor and Licensor's licensor(s) shall 

be collectively referred to as "Licensor") EXPRESSLY 

DISCLAIM ALL WARRANTIES AND/OR CONDITIONS, 

EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED 

TO, THE IMPLIED WARRANTIES AND/OR CONDITIONS 

OF MERCHANTABILITY OR SATISFACTORY QUALITY 

AND FITNESS FOR A PARTICULAR PURPOSE AND 

NONINFRINGEMENT OF THIRD PARTY RIGHTS.  THE 

LICENSOR DOES NOT WARRANT THAT THE 

FUNCTIONS CONTAINED IN THE SOFTWARE WILL 

MEET THE LICENSEE'S REQUIREMENTS, OR THAT 

THE OPERATION OF THE SOFTWARE WILL BE 

UNINTERRUPTED OR ERROR-FREE, OR THAT 

DEFECTS IN THE SOFTWARE WILL BE 

CORRECTED.  FURTHERMORE, LICENSOR DOES NOT 

WARRANT OR MAKE ANY REPRESENTATIONS 

REGARDING THE USE OR THE RESULTS OF THE USE 

OF THE SOFTWARE OR RELATED DOCUMENTATION 

IN TERMS OF THEIR CORRECTNESS, RELIABILITY, OR 

OTHERWISE.  NO ORAL OR WRITTEN INFORMATION 

OR ADVICE GIVEN BY THE LICENSOR OR A LICENSOR 

AUTHORIZED REPRESENTATIVE SHALL CREATE A 

WARRANTY OR IN ANY WAY INCREASE THE SCOPE 

OF THIS WARRANTY.  SHOULD THE SOFTWARE 

PROVE DEFECTIVE, LICENSEE (AND NOT LICENSOR 

OR A LICENSOR AUTHORIZED REPRESENTATIVE) 

SHALL ASSUME THE ENTIRE COST OF ALL 

NECESSARY SERVICING, REPAIR OR 

CORRECTION.  SOME JURISDICTIONS DO NOT ALLOW 

THE EXCLUSION OF IMPLIED WARRANTIES, SO THE 

ABOVE EXCLUSION MAY NOT APPLY TO YOU.  THE 

TERMS OF THIS DISCLAIMER DO NOT AFFECT OR 

PREDJUDICE THE STATUTORY RIGHTS OF A 

CONSUMER ACQUIRING LICENSOR PRODUCTS 

OTHERWISE THAN IN THE ORDINARY COURSE OF 

BUSINESS, NEITHER DO THEY LIMIT OR EXCLUDE 

ANY LIABILITY FOR DEATH OR PERSONAL INJURY 

CAUSED BY LICENSOR'S NEGLIGENCE. 

6. Licensor's Limitation of Liability 
THE LICENSOR SHALL NOT BE LIABLE TO THE 

LICENSEE FOR ANY LOSS OR DAMAGE, EXCEPT AS 

SPECIFICALLY SET FORTH IN THIS AGREEMENT, 

ARISING DIRECTLY OR INDIRECTLY IN CONNECTION 

WITH THIS LICENSE, THE SOFTWARE, ITS USE OR 

OTHERWISE. NOTWITHSTANDING THE GENERALITY 

OF THE FOREGOING, THE LICENSOR EXPRESSLY 

EXCLUDES LIABILITY FOR NEGLIGENCE, INDIRECT, 

SPECIAL, INCIDENTAL OR CONSEQUENTIAL LOSS OR 

DAMAGE WHICH MAY ARISE IN RESPECT OF THE 

SOFTWARE, ITS USE, THE SYSTEM OR IN RESPECT 

OF OTHER EQUIPMENT OR PROPERTY, OR FOR LOSS 

OF PROFIT, BUSINESS, REVENUE, GOODWILL OR 

ANTICIPATED SAVINGS.  LIABILITY OF THE LICENSOR 

AND ITS SUPPLIERS TO THE LICENSEE, IF ANY, FOR 

BREACH OF WARRANTY ARISING OUT OF CONTRACT, 

NEGLIGENCE OR STRICT LIABILITY IN TORT, OR ANY 

OTHER CLAIM RELATING TO THIS LICENSE, OR IN 

THE EVENT THAT ANY EXCLUSION CONTAINED IN 

THIS LICENSE SHALL BE HELD TO BE INVALID FOR 

ANY REASON AND THE LICENSOR BECOMES LIABLE 

FOR LOSS OR DAMAGE, SHALL BE LIMITED TO FIFTY 

DOLLARS ($50.00). 

7. Copyrights Patents, Trade Marks and 
Other Intellectual Property Rights  

The Licensee acknowledges that any and all of the 

copyright, trade marks, trade names, patents and other 
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intellectual property rights subsisting in or used in 

connection with the Software including all documentation 

and manuals relating thereto are and remain the sole 

property of the Licensor and the Owner. The Licensee shall 

not during or at any time after the expiration or termination 

of this License in any way question or dispute the 

ownership by the Licensor and/or the Owner thereof.  

8. Indemnity 

(a) The Licensor agrees to indemnify and save harmless 

and defend at its own expense the Licensee from and 

against any and all claims of infringement of any patent, 

trade mark, industrial design, copyright or other 

proprietary right affecting the Software provided that (i) 

the Licensee shall not have done, permitted or suffered 

to be done anything which was not expressly 

authorized by this License or which may have been or 

become an infringement of any such rights (including 

but not limited to using the Software to perform the 

Licensee's or other party's applications or using the 

Software in combination or merged with other software 

programs or devices) and (ii) the Licensee shall have 

exercised a commercially reasonable standard of care 

in protecting the same; failing which, the Licensee shall 

indemnify the Licensor against all actions, proceeding 

costs, claims and expenses incurred in respect thereof.  

(b) In the event that any such infringement occurs or may 

occur, the Licensor may at its sole option and expense: 

(i)   procure for the Licensee the right to continue using 

the Software or infringing part thereof; or  

(ii)      modify or amend the Software or infringing part 

thereof so that the same becomes non-infringing; or  

(iii) replace the Software or infringing part thereof by 

other software of similar capability; or  

(iv)    repay to the Licensee the License Fee or balance 

thereof relating to the whole or the infringing part of 

the Software.  

(c) The Licensor’s obligations under subsection (a) or (b) 

above are expressly conditioned upon and subject to: 

(i)   the Licensor having sole control of the defense 

and/or settlement of any such infringement claim;  

(ii) the Licensee promptly notifying the Licensor in 

writing of any claim specified in subsection (a) 

above that is made against the Licensee and 

providing the Licensor with the authority to proceed 

as set forth in (i) above; and  

(iii) the Licensee providing the Licensor with all 

information known to the Licensee relating to such 

infringement claim and otherwise providing the 

Licensor with such assistance as the Licensor may 

reasonably require to settle or oppose any such 

claims. 

 (d) The Licensor's liability under this clause shall, at the 

Licensor's option, be limited to the License Fee, less an 

equitable proportion thereof, as relates to the period 

prior to cessation of the use of the Software by the 

Licensee because of such claims of infringement. 
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9. Confidential Information 

(a) All information, data, drawings, specifications, 

documentation, software listings, source or object code 

which the Licensor may have imparted and may from 

time to time impart to the Licensee relating to the 

Software (other than the ideas and principles which 

underlie the Software) is proprietary and confidential. 

The Licensee hereby agrees that it shall use the same 

solely in accordance with the provisions of this License 

and that it shall not at any time during or for a period of 

six years after expiration or termination of this License, 

disclose the same, whether directly or indirectly, to any 

third party without the Licensor's prior written consent.   

(b) The Licensee further agrees that it shall not itself or 

through any subsidiary, agent or third party use such 

confidential information to copy, reproduce, translate, 

adapt, vary, modify, decompile, disassemble or reverse 

engineer the Software nor shall the Licensee lease, 

license, sub-license or otherwise deal with the Software 

(other than by sale as specifically referred to in sub-

clause (d) below) or any part or parts or variations, 

modifications, copies, releases, versions or 

enhancements thereof or have any software or other 

program written or developed for itself based on any 

confidential information supplied to it by the Licensor.  

(c)  The foregoing provisions shall not prevent the 

disclosure or use by the Licensee of any information 

which is or hereafter, through no fault of the Licensee, 

becomes public knowledge or to the extent required by 

law.  

(d)  The Licensee may sell this License provided that: 

(i)   all copies of the Software held by the Licensee 

pursuant to this License shall either be destroyed or 

transferred to the Transferee on completion of the 

sale;  

(ii)      the Licensee procures written agreement by the 

Transferee accepting the terms of the License; and 

 (iii) the Licensee gives prior notice to the Licensor of 

the transfer and the identity and address of the 

Transferee and receives Licensor’s prior written 

consent.  

10. Force Majeure 
The Licensor shall be under no liability to the Licensee in 

any way whatsoever for destruction, damage, delay or any 

other matters of any nature whatsoever arising out of war, 

rebellion, civil commotion, strikes, lock-outs or industrial 

disputes, fire, explosion, earthquakes, acts of God, flood, 

drought, bad weather or power outages; the unavailability 

of deliveries, supplies, software disks or other media or the 

requisitioning or other act or order by any government 

department, council or other constituted body.  

11. Termination 

(a) This License shall terminate and any and all rights 

granted to the Licensee hereunder shall revest in the 

Licensor: 

(i)   upon thirty (30) days written notice in the event that 

Licensee or any of its directors, officers, employees 

or agents is in breach of any term, condition or 

provision of this License and fails to remedy such 

breach (if capable of remedy) within such thirty (30) 

days; and 
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(ii) should the Licensee, its successors or permitted 

assigns, suspend business, make an absolute 

assignment of the bulk of its assets for the benefit 

of creditors, consent to the appointment of a trustee, 

custodian or receiver, or be declared insolvent or 

bankrupt; or if a trustee or custodian or receiver is 

appointed for the Licensee for a substantial part of 

its property without its consent and is not 

discharged within sixty (60) days of such 

appointment, or if bankruptcy, reorganization, 

rearrangement, insolvency or liquidation 

proceedings are instituted by or against the 

Licensee and are not dismissed within sixty (60) 

days of the commencement thereof.  

(b) Upon termination, the Licensee shall pay to the Licensor 

all costs and expenses, including legal and other fees 

incurred and all arrearages of fees, charges or other 

payments arising in respect of the Software, this 

License or otherwise and shall comply with its 

undertaking specified in Section 4(g) above.  

(c) Termination of this License shall be in addition to and 

not in lieu of any rights and remedies the Licensor may 

have under this License or under the applicable 

law.  Notwithstanding the termination of this License, 

the provisions of Sections 6, 7, 9 and 13 through 19 

shall survive such termination. 

12. Assignment 
The Licensee shall not assign rent, lease, loan, sublicense, 

distribute, or otherwise transfer all or any part of the 

Software or this License without the prior written consent of 

the Licensor, in accordance with Section 9(d) above.  

13. Waiver 
Failure or neglect by either party to enforce at any time any 

of the provisions hereof shall not be construed nor shall be 

deemed to be a waiver of that party's rights hereunder nor 

in any way affect the validity of the whole or any part of this 

License nor prejudice that party's rights to take subsequent 

action.  

14. Headings 
The headings of the terms and conditions herein contained 

are inserted for convenience of reference only and are not 

intended to be part of or to affect the meaning or 

interpretation of any of the terms and conditions of this 

License.  

15. Severability 
In the event that any of these terms and conditions or 

provisions shall be determined by any competent authority 

to be invalid, unlawful or unenforceable to any extent, such 

term, condition or provision shall to that extent be severed 

from the remaining terms, conditions and provisions which 

shall continue to be valid to the fullest extent permitted by 

law.  

16. Law 
The parties hereby agree that the License concluded 

between them and constituted on these terms and 

conditions shall be construed in accordance with the law of 

the State of Massachusetts without regard to its conflict of 

laws principles.  

17. Jurisdiction 
In any legal action related to this License, the Licensee 

agrees (a) to the exercise of jurisdiction over it by a state or 

federal court in Boston, Massachusetts and (b) that all legal 

actions relating to this License shall be instituted in one of 

the courts specified in (a) above.  
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18.        Export Law Assurances 
The Licensee may not use or otherwise export or reexport 

the Software except as authorized by United States law 

and laws of the jurisdiction in which the Software was 

obtained.  The Licensee agrees and certifies that (i) neither 

the Software nor any related documentation or product 

thereof is intended to be shipped, transferred or reexported, 

directly or indirectly, into any country prohibited by the 

United States Export Administration Act of 1979 and the 

regulations thereunder, as amended, nor will be used for 

any purpose prohibited by the Act, and (ii) that Licensee is 

not located in, under control of, or a national or a resident 

of a country on the U.S. Treasury Department's list of 

Specially Designated Nationals or the U.S. Department of 

Commerce's Table of Denial Orders.  The Licensee agrees 

to comply with all laws and regulations pertaining to the 

export of the Software. 

19.        Restricted Rights 
If any Software or related documentation is to be used by 

the United States government, it shall be provided with 

“Restricted Rights.”  Use, duplication or disclosure by the 

government is subject to restrictions set forth in 

subparagraph (C)(1)(ii) of the Department of Defense 

Regulations Supplement (“DFARS”) 252.227-7013, Rights 

in Technical Data and Computer Software (October 1988), 

Federal Acquisition Regulation (“FAR”) 52.227-14, Rights in 

Data-General, including Alternate III (June 1987), as 

applicable, and FAR 52.227-19.  Supplier:  Image 

Processing and Vision Company Limited, Viscount Centre 

II, University of Warwick Science Park, Millburn Hill Road, 

Coventry, CV4 7HS, England. 

20.        Complete Agreement 
This License constitutes the entire agreement between the 

parties with respect to the use of the Software and 

supersedes all prior or contemporaneous understandings 

regarding such subject matter.  No amendment to or 

modification of this License will be binding unless in writing 

and signed by the Licensor. 
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THE LICENCE (EUROPE) 
Image Processing and Vision Company Limited (trading as 

Improvision) (the "Licensor" which expression shall include 

its subsidiaries, agents, successors and assigns) is 

authorised to license the software (the "Software") 

contained in this package and upon opening the sealed 

package the Licensee accepts a non-exclusive Licence to 

"Use" (as hereinafter defined) the Software on a single 

computer system (the "System") for single use specified 

below upon the terms and subject to the conditions 

contained herein. 

This Licence entitles the Licensee to: 

(a)    load, install and Use the Software contained in this 

package on one Central Processing Unit ("CPU") of the 

System (a separate licence fee being required for each 

CPU upon which the Licensee wishes to use the 

Software); 

(b)  Use the Software in accordance with the provisions of 

Clause 2 of this Licence; 

and, where the Licensee signs and returns the warranty 

card enclosed with the Software, to: 

(a)  receive telephone technical support relating to the 

Software within the Licensor’s usual business hours, 

within the period of the software maintenance 

agreement; 

(b)  receive information on upgraded versions of the 

Software at such cost (if any) as may be notified to the 

Licensee. 

 

1.  Acceptance of this Licence 
The terms and conditions of this Licence are deemed to be 

accepted by the parties in any one of the following 

circumstances: 

(a)  by the Licensor upon dispatch/delivery by the Licensor 

of this package to the Licensee direct or to the 

Licensor's agent as the case may be; 

(b)  by the Licensee by breaking the seal of this sealed 

package containing the Software; 

(c)  the Licensee signing and returning the enclosed 

warranty card. 

2.  Use of the Software 

(a)  For the purposes of this Licence "Use" shall mean and 

include: 

(i)   utilization of the Software by copying, transmitting 

or loading the same into the temporary memory 

(RAM) or installing into the permanent memory 

(e.g. hard disk, CD ROM or other storage device) of 

the System for the processing of the System 

instructions or statements contained in such 

Software; 

(ii)  copying the Software which is in machine-readable 

form for Use by the Licensee on the System for the 

purposes only of understanding the contents of 

such machine-readable material and for back-up 

provided that no more than three (3) non-transient 

copies will be in existence under any Licence at 

any one time without prior written consent from the 

Licensor or as otherwise permitted by the 

applicable law; 
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(iii)  storing the whole or any part of the Software on the 

System or other storage unit or disk; 

(iv) utilizing (but not copying) the instructional and/or 

operational manuals relating to the Software. 

(b)  The Licensee acknowledges and accepts that the 

Software may be protected against unauthorised use 

by means of a dongle device.  

(c)  The Licensee shall also be permitted to Use the 

Software on a portable, lap-top or home computer 

where the Software is permanently installed on the 

hard disk or other storage device of the System (but not 

a file server) and the Licensee or its relevant employee 

as the case may be is the predominant user of the 

Software and such Use will not breach the concurrent 

user limit where applicable. 

3.  Licence Fee 

(a)  Where the Licence Fee has not been paid by the 

Licensee at the time the Software is obtained from the 

Licensor or its agent the licence fee will be payable 

within the number of days specified in the Licensor’s 

invoice unless otherwise agreed in writing by the 

Licensor. 

(b)  An additional Licence Fee is payable for each CPU of 

the System upon which the Licensee wishes to Use the 

Software.  In the event that the Licensee's System is 

inoperable or requires or is under repair, the Licensee 

shall be permitted to Use the Software on a back-up 

system at no extra charge, until the System is 

operational. 

4.  Licensee's Undertakings 

(a)  The Licensee undertakes not to perform any of the acts 

referred to in this sub-clause (a) except to the extent 

and only to the extent permitted by the applicable law 

to the Licensee as a lawful user (i.e. a party with a right 

to use) of the Software and only then for the specific 

limited purpose stated in such applicable law or 

hereunder.  The Licensee undertakes: 

(i)   not to copy the Software (other than for normal 

System operation and as specified in Clause 2 

above) nor otherwise reproduce the same Provided 

that the Licensee may copy the Software for back-

up purposes or incidentally, in the course of 

converting the Software in accordance with 4(a)(iii) 

below; 

(ii)  not to translate, adapt, vary, modify the Software; 

(iii)  subject to sub-clause (iv) below not to disassemble, 

decompile or reverse engineer the Software 

Provided however that in the case of decompilation, 

the Licensee may incidentally decompile the 

Software only if it is essential so to do in order to 

achieve interoperability of the Software with 

another software program ("Permitted Purpose") 

and provided the information obtained by the 

Licensee during such decompilation is only used for 

the Permitted Purpose and is not disclosed or 

communicated to any third party whom it is not 

necessary to disclose or communicate such 

information without the Licensor's prior written 

consent and is not used to create any software 
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which is substantially similar to the expression of 

the Software nor used in any manner which would 

be restricted by copyright. 

(iv) It shall be a condition precedent to the 

decompilation of the software permitted in 

accordance with the terms referred to in sub-clause 

(iii) above that the Licensee shall have notified the 

Licensor in writing (a) that it wishes to perform the 

decompilation (b) the purposes for which it wishes 

to perform the decompilation and (c) the 

information which it requires for such purposes. 

Only when the Licensor has either (a) not 

responded within a reasonable time and (b) has not 

offered to provide the Licensee with the information 

required under (c ) above (for which the Licensee 

may require payment) shall the Licensee be 

permitted to continue with the decompilation. 

The Licensee undertakes: 

(b)  to maintain accurate and up-to-date records of the 

number and location of all copies of the Software. 

(c)  to supervise and control Use of the Software in 

accordance with the terms of this Licence. 

(d)  to ensure that its employees, agents and other parties 

who will use the Software (including any transferee of 

the Software) are notified of this Licence and the terms 

hereof prior to such employee, agent or party using the 

same. 

(e)  to reproduce and include the copyright notice of the 

Licensor or such other party as may be specified in or 

on the Software (the "Owner") on all and any copies, 

whether in whole or in part, in any form, including 

partial copies or modifications of the Software made 

herein. 

(f)  not to provide or otherwise make available the Software 

in whole or in part (including where applicable, but not 

limited to program listings, object code and source 

program listings, object code and source code), in any 

form to any person other than the Licensee's 

employees or as specified in (d) above without prior 

written consent from the Licensor. 

(g)  within 14 days after the date of termination or 

discontinuance of this Licence for whatever reason, to 

destroy the Software and all updates, upgrades or 

copies, in whole and in part, in any form including 

partial copies or modifications of the Software received 

from the Licensor or made in connection with this 

Licence, and all documentation relating thereto. 

 

5.  Warranty 
THE LICENSEE ACKNOWLEDGES THAT SOFTWARE IN 

GENERAL IS NOT ERROR-FREE AND AGREES THAT 

THE EXISTENCE OF SUCH ERRORS SHALL NOT 

CONSTITUTE A BREACH OF THIS LICENCE. 

IN THE EVENT THAT THE LICENSEE DISCOVERS A 

MATERIAL ERROR WHICH SUBSTANTIALLY AFFECTS 

THE LICENSEE'S USE OF THE SAME AND NOTIFIES 

THE LICENSOR OF THE ERROR WITHIN 90 DAYS 

FROM THE DATE OF PAYMENT OF THE LICENCE FEE 

(THE "WARRANTY PERIOD") THE LICENSOR SHALL AT 

ITS SOLE OPTION EITHER REFUND THE LICENCE FEE 

OR USE ALL REASONABLE ENDEAVOURS TO 

CORRECT BY PATCH OR NEW RELEASE (AT ITS 
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OPTION) THAT PART OF THE SOFTWARE WHICH 

DOES NOT SO COMPLY PROVIDED THAT SUCH 

NON-COMPLIANCE HAS NOT BEEN CAUSED BY ANY 

MODIFICATION, VARIATION OR ADDITION TO THE 

SOFTWARE NOT PERFORMED BY THE LICENSOR OR 

CAUSED BY ITS INCORRECT USE, ABUSE OR 

CORRUPTION OF THE SOFTWARE. 

THE LICENSOR’S WARRANTY IN RELATION TO THE 

FUNCTIONING OF THE SOFTWARE (INCLUDING A 

DONGLE, IF PROVIDED) ON ANY PARTICULAR 

SYSTEM ONLY APPLIES WHERE THE SYSTEM 

COMPLIES WITH THE LICENSOR’S HARDWARE AND 

SOFTWARE COMPATIBILITY LIST AS ISSUED FROM 

TIME TO TIME 

TO THE EXTENT PERMITTED BY THE APPLICABLE 

LAW, AND SUBJECT TO CLAUSE 6 BELOW, THE 

LICENSOR DISCLAIMS ALL OTHER WARRANTIES WITH 

RESPECT TO THE SOFTWARE, EITHER EXPRESS OR 

IMPLIED, INCLUDING BUT NOT LIMITED TO ANY 

IMPLIED WARRANTIES OF MERCHANTABILITY OR 

FITNESS FOR ANY PARTICULAR PURPOSE. 

THE LICENSEE ACKNOWLEDGES THAT THE 

SOFTWARE IS NOT DESIGNED FOR USE IN MISSION- 

OR SAFETY-CRITICAL SITUATIONS. THE ALGORITHMS 

UPON WHICH IT IS BASED INVOLVE STATISTICAL AND 

OTHER METHODS OF INTERPOLATION AND 

EXTRAPOLATION AND VISUAL OR OTHER OUTPUT 

WHICH IT MAY PRODUCE ARE THEREFORE LIABLE TO 

ARTEFACTS AND ERRORS INHERENT IN THE USE OF 

THESE TECHNIQUES. OUTPUT FROM THE SOFTWARE 

SHOULD ALWAYS BE CONFIRMED AND VERIFIED IN 

ACCORDANCE WITH RECOGNISED SCIENTIFIC AND 

EXPERIMENTAL PRACTICE. THE LICENSOR MAY BE 

PREPARED TO CREATE A SPECIALLY MODIFIED OR 

RE-WRITTEN VERSION OF THE SOFTWARE AT EXTRA 

COST TO COMPLY WITH ANY SAFETY OR MISSION-

CRITICAL REQUIREMENTS. 

ALTHOUGH THE LICENSOR DOES NOT WARRANT 

THAT THE SOFTWARE SUPPLIED HEREUNDER SHALL 

BE FREE FROM ALL KNOWN VIRUSES IT HAS USED 

COMMERCIALLY REASONABLE EFFORTS TO CHECK 

FOR THE MOST COMMONLY KNOWN VIRUSES PRIOR 

TO PACKAGING BUT THE LICENSEE IS SOLELY 

RESPONSIBLE FOR VIRUS SCANNING THE 

SOFTWARE. 

THE LICENSOR WARRANTS THAT THERE ARE NO 

DISABLING PROGRAMS OR DEVICES IN THE 

SOFTWARE OTHER THAN THAT NECESSARY TO 

DETECT THE PRESENCE OF AN APPROPRIATE 

DONGLE (IF PROVIDED). 

PROVIDED THAT ANY DONGLE PROVIDED HAS NOT 

BEEN MAL-TREATED THE LICENSOR UNDERTAKES 

THAT IN THE CASE OF THE FAILURE OF THE DONGLE 

IT WILL, AT ITS OPTION, AND AT ANY TIME DURING 

THE CURRENCY OF THIS LICENCE EITHER  

(i)   replace the dongle; or 

(ii)  replace the Software with a version of identical or 

enhanced functionality but which is not protected by the 

dongle device or is protected by an alternative dongle. 

 

6.  Licensor's Liability 

(a)  The Licensor shall not be liable to the Licensee for any 

loss or damage whatsoever or howsoever caused 

arising directly or indirectly in connection with this 

Licence, the Software, its use or otherwise, except to 

the extent that such liability may not be lawfully 

excluded under the applicable law. 
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(b)  Notwithstanding the generality of (a) above, the 

Licensor expressly excludes liability for indirect, special, 

incidental or consequential loss or damage which may 

arise in respect of the Software, its use, the System or 

in respect of other equipment or property, or for loss of 

profit, business, revenue, goodwill or anticipated 

savings. 

(c)  In the event that any exclusion contained in this 

Licence shall be held to be invalid for any reason and 

the Licensor becomes liable for loss or damage that 

may lawfully be limited, such liability shall be limited to 

the licence fee paid by the Licensee for the Software. 

The Licensor does not exclude liability for death or personal 

injury to the extent only that the same arises as a result of 

the negligence of the Licensor, its employees, agents or 

authorised representatives. 

Where the Software is to be used in any state of Australia 

and it is determined by a competent authority that the law 

of any such Australian state law apply to this licence, 

notwithstanding any other provisions contained herein, 

where any Act of Parliament implies any term into this 

Licence, and that Act avoids or prohibits provisions in a 

contract excluding or modifying such term, that term shall 

be deemed to be included in this Licence, but the 

Licensor's liability for breach of that term shall be limited in 

one or more of the ways (at the Licensor's option) permitted 

by section 68A(1) of the Trade Practices Act 1974 (Cth). 

7.  Copyright, Patents, Trade Marks and 
Other Intellectual Property Rights 

The Licensee acknowledges that any and all of the 

copyright, trade marks, trade names, patents and other 

intellectual property rights subsisting in or used or in 

connection with the Software including all documentation 

and manuals relating thereto are and remain the sole 

property of the Licensor and/or the Owner.  The Licensee 

shall not during or at any time after the expiry or termination 

of this Licence in any way question or dispute the 

ownership by the Licensor and/or the Owner thereof. 

8.  Indemnity 

(a)  The Licensor agrees to indemnify and save harmless 

and defend at its own expense the Licensee from and 

against any and all claims of infringement of any patent, 

trade mark, industrial design, copyright or other 

proprietary right affecting the Software PROVIDED 

THAT (i) the Licensee shall not have done, permitted or 

suffered to be done anything which may have been or 

become an infringement of any such rights (including 

but not limited to using the Software to perform the 

Licensee's or other party's applications or using the 

Software in combination or merged with other software 

programs or devices) and (ii) the Licensee shall have 

exercised a reasonable standard of care in protecting 

the same; failing which, the Licensee shall indemnify 

the Licensor against all actions, proceedings, costs, 

claims and expenses incurred in respect thereof. 

(b)  The Licensee undertakes that the Licensor shall be 

given prompt notice of any claim specified in (a) above 

that is made against the Licensee and the Licensor 

shall have the right to defend any such claims and 

make settlements thereof at its own discretion and the 

Licensee shall give such assistance as the Licensor 

may reasonably require to settle or oppose any such 

claims. 
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(c)  In the event that any such infringement occurs or may 

occur, the Licensor may at its sole option and expense: 

(i)   procure for the Licensee the right to continue using 

the Software or infringing part thereof; or 

(ii)  modify or amend the Software or infringing part 

thereof so that the same becomes non-infringing; or 

(iii)  replace the Software or infringing part thereof by 

other software of similar capability; or 

(iv) repay to the Licensee the Licence Fee or balance 

thereof relating to the whole or the infringing part of 

the Software. 

(d)  The Licensor's liability under this clause shall, at the 

Licensor's option, be limited to the Licence Fee less an 

equitable proportion thereof as relates to the period 

prior to cessation owing to infringement. 

 

9.  Confidential Information 

(a)  All information, data, drawings, specifications, 

documentation, software listings, source or object code 

which the Licensor may have imparted and may from 

time to time impart to the Licensee relating to the 

Software (other than the ideas and principles which 

underlie the Software) is proprietary and 

confidential.  The Licensee hereby agrees that it shall 

use the same solely in accordance with the provisions 

of this Licence and that it shall not at any time during or 

for a period of six years after expiry or termination of 

this Licence, disclose the same, whether directly or 

indirectly, to any third party without the Licensor's prior 

written consent. 

(b)  Subject only to the specific, limited provisions of Clause 

4(a) above, the Licensee further agrees that it shall not 

itself or through any subsidiary, agent or third party use 

such confidential information to copy, reproduce, 

translate, adapt, vary, modify, decompile, disassemble 

or reverse engineer the Software nor shall the Licensee 

lease, licence, sub-licence or otherwise deal with the 

Software (other than by sale as specifically referred to 

in sub-clause (d) below) or any part or parts or 

variations, modifications, copies, releases, versions or 

enhancements thereof or have any software or other 

program written or developed for itself based on any 

confidential information supplied to it by the Licensor. 

The foregoing provisions shall not prevent the disclosure or 

use by the Licensee of any information which is or hereafter, 

through no fault of the Licensee, becomes public 

knowledge or to the extent permitted by law. 

The Licensee shall be permitted to sell this licence 

PROVIDED THAT: 

(i)   all copies of the Software held by the Licensee 

pursuant to this Licence shall either be destroyed or 

transferred to the Transferee on completion of the sale; 

(ii)  the Licensee procures that the Transferee accepts the 

terms of the Licence; 

(iii)  the Licensee gives notice to the Licensor of the transfer 

and the identity and address of the Transferee. 

10.        Force Majeure 
The Licensor shall be under no liability to the Licensee in 

respect of anything which, apart from this provision, may 

constitute breach of this Licence arising by reason of force 

majeure. 
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11.        Termination 

(a)  In addition to provisions for termination as herein 

provided, the Licensor may by notice in writing to the 

Licensee terminate this Licence if the Licensee is in 

breach of any term, condition or provision of this 

Licence or required by the applicable law and fails to 

remedy such breach (if capable of remedy) within 

30 days of having received written notice from the 

Licensor specifying such breach. 

(b)  Upon termination, the Licensee shall pay to the 

Licensor all costs and expenses, including legal and 

other fees incurred and all arrears of fees, charges or 

other payments arising in respect of the Software, this 

Licence or otherwise and shall comply with its 

undertaking specified in Clause 4(g) above. 

(c)  Termination, howsoever or whenever occasioned shall 

be subject to any rights and remedies the Licensor may 

have under this Licence or under the applicable law. 

12.        Assignment 
The Licensee shall not assign or otherwise transfer all or 

any part of the Software or this Licence without the prior 

written consent of the Licensor or in accordance with the 

provisions of clause 9(d) above. 

13.        Waiver 
Failure or neglect by either party to enforce at any time any 

of the provisions hereof shall not be construed nor shall be 

deemed to be a waiver of that party's rights hereunder nor 

in any way affect the validity of the whole or any part of this 

Licence nor prejudice that party's rights to take subsequent 

action. 

14.        Headings 
The headings of the terms and conditions herein contained 

are inserted for convenience of reference only and are not 

intended to be part of or to affect the meaning or 

interpretation of any of the terms and conditions of this 

Licence. 

15.        Severability 
In the event that any of these terms and conditions or 

provisions shall be determined by any competent authority 

to be invalid, unlawful or unenforceable to any extent, such 

term, condition or provision shall to that extent be severed 

from the remaining terms, conditions and provisions which 

shall continue to be valid to the fullest extent permitted by 

law. 

16.        Law 
The parties hereby agree that the Licence concluded 

between them and constituted on these terms and 

conditions shall be construed in accordance with English 

law. 
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What is Volocity? 

Overview 
Volocity is an innovative, high performance 3D imaging software product designed specifically for 
Life Science research. It allows the scientist to visualize, explore and analyze multi-channel 3D 
volumes over time, providing information that is difficult to obtain in any other way. 

Volocity can be used for 2D imaging as well as 3D and 4D imaging and will accept image sequences 
from confocal and wide field microscopes. The software consists of a core product and four unique, 
totally integrated extension products that provide a full suite of tools for 3D image acquisition, volume 
visualization, restoration, publication, and object classification, tracking and charting.   

The Volocity products can be purchased individually or in combination, according to requirements. In 
addition, a reduced version of the core, Volocity LE, is available to download free of charge from the 
Improvision website. 

Volocity Acquisition 
Volocity Acquisition is designed specifically for high performance acquisition of time-resolved, multi-
channel 3D sequences. It supports a range of hardware suitable for 3D imaging, including wide field 
microscopes, scientific grade digital cameras, fast focus drives and wavelength changers. 

Volocity Quantitation  
Volocity Quantitation is designed to identify, measure and track biological structures in 2D, 3D and 
4D. This unique module incorporates innovative classification technology for rapid identification and 
quantitation of populations of objects in 2D, 3D and 4D. 

Volocity Restoration  
Volocity Restoration includes restoration algorithms and measured or calculated PSF generation 
options for confocal and wide field microscopes. The Volocity restoration algorithms are designed for 
rapid, high-quality restoration of 4D and 3D volumes and for accurate comparison and quantitation of 
time-resolved changes. 

Volocity Visualization  
Volocity Visualization provides an extensive range of visualization and publication features. The 
Volocity 3D View enables the user to interactively explore a 3D rendered object. The user can, in real 
time, rotate, zoom and animate the 3D object whilst simultaneously varying the contribution and 
rendering mode for each channel. The user can also position the viewing point either outside or 
inside the 3D object, and then watch as structures change and develop over time. Bookmarks may 
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be used to store the position and appearance of the 3D volume and the movie interface may be used 
to animate transitions between bookmarks.  

About this Manual 
This manual describes all the features of Volocity. The initial chapters describe the features that are 
available to all users. Each extension product then has its own chapter, so that the reader can easily 
locate relevant information. The manual is designed for users of both Mac and PC versions of 
Volocity. The screenshot examples show the Mac interface. The screenshots often assume that all 
features are enabled. If you do not have access to a command, it probably belongs to one of the 
extension products. 

Technical Support 
If you have any queries about installing and using Volocity, contact Improvision Support: 

USA: 
E-mail:                support@improvision.com 

Telephone:         +1 (866) 310 0932 

Europe and Rest of World: 
E-mail:                support@improvision.com 

Telephone:         +44 (0) 24 7669 8121 

Web Page 
You can also get additional information about Improvision and its products from the web page: 
http://www.improvision.com/support 

Information to Provide 
When contacting Technical Support please be prepared to provide information about your system 
including the dongle or serial number. 

You may be asked to provide information about your computer hardware and from the Volocity 
system Session Log, see page 33. 
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Installation 

Minimum System Requirements 
The computer hardware market changes rapidly and, as a result, information about minimum and 
recommended system requirements also changes. Please refer to the technical notes published on 
the Support area of the Improvision web site, http://www.improvision.com, for the up-to-date 
specifications. 

Volocity is available for Windows and Mac. The exact specification for your computer depends on the 
type of Volocity configuration that you intend to run. If you are running Volocity extension products 
you will require a much higher specification than if you are using Volocity LE. Similarly, if you are 
working with large volumes you will require a fast, powerful processor and the maximum possible 
capacity of RAM for the machine.   

Please note: Volocity 2.5 was the last version of the software to include support for the following 
operating systems: Mac OS 9, Windows 98, Windows NT4 and Windows ME. 

Note: A Volocity dongle will work with both Volocity for Macintosh and Volocity for Windows. 

Installing Volocity (Single License) 
To install Volocity LE you require an unlock code and a serial number. You obtain these when you 
download Volocity LE from the website. This is all you need to install the software.  

To use any of the chargeable products you must purchase a dongle, which is a security device that 
will be registered for your required package. It must be plugged into an unused USB port. Software 
for the full version of Volocity with chargeable products is also available on CD-ROM. Additional 
functionality can be added later using a serial number provided when you purchase the product. 
Please ensure that you read the accompanying license before installing the product. 

Follow the instructions supplied with the web download or CD-ROM to install Volocity. 

Installation for Server Systems 
If you are using the Improvision License Server, you will first need to install and configure the license 
server application on a machine with a static IP address that all client machines will be able to 
access. See the “License Server User Guide” for complete instructions on how to do this. 

Install Volocity on machines that will access the License Server as described in “Installing Volocity 
(Single License)”. These client machines will not need their own dongle, they will obtain Volocity 
licenses by connecting to the license server. 
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Starting Volocity for the First Time 
 Volocity LE requires a serial number and unlock code which you may obtain by registering on the 

Improvision website. 

 If your license is on a dongle, ensure that the dongle is plugged in and the light inside the dongle 
is illuminated. This indicates that the dongle drivers are correctly installed. 

 If your license will be obtained from the license server, make sure that you know the license 
server IP address and port number. You will also need a user ID and, possibly, a password for 
the license server. This is normally set up by the person who installs and manages the license 
server. 

1. Start Volocity.   

On the Mac: Volocity is installed in the Applications folder. Start by double clicking on the icon.   

On Windows: Volocity can be found by navigating through All Programs in the start menu. 

2. If you have a dongle installed you should see no further messages, Volocity will run. If a licensing 
message does appear, make sure the dongle is plugged in and click Retry. 

To use a license server click Server… at the dialog shown and enter the details of the Improvision 
License Server for which you have a user ID and password. 

To use Volocity LE click Unlock... at the dialog shown and enter the serial number and unlock code. 
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Changing Your License Server Password 
1. When the Connect To Server dialog is shown click on the Change Password… button. 

 
2. Enter the new password twice to confirm it and click OK. 

You may also be required to change passwords, when a dialog to that effect is shown. This may be 
to change a default password or at the request of the Improvision License Server administrator. 

Switching from a License Server to Individual Licenses 
Volocity LE: Start up Volocity holding down the ‘Apple’ key (Mac OS) or the ‘R’ key (Windows) to 
bring up the License dialog. Click Unlock… to enter the serial number and registration code for your 
individual license. 

Volocity: Plug a Volocity dongle (not an Improvision License Server dongle) into a free USB port on 
the machine. Start Volocity. Volocity will recognize the presence of the dongle. 

Switching from Individual Licenses to a License Server   
Volocity LE: Start up Volocity holding down the ‘Apple’ key (Mac OS) or the ‘R’ key (Windows) to 
bring up the License dialog. Click Server… and enter the server IP address and port number.  

Volocity: Remove the Volocity dongle from the USB port that it is connected to. Start up Volocity. 
You will be shown the license dialog. Click Server… and enter the server IP address and port 
number. 

Preferences 
The Preferences dialog allows you to customize various settings. 

1. Mac OS X users select Preferences… from the Volocity menu. All other users select Preferences... 
from the Edit menu. 

2. Select the required preference by clicking on the icon in the left-hand pane.  
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3. Make the required changes and click on Save (Mac) or OK (PC). 

The Import preferences allow you to define how images will be imported and to either switch 
thumbnails off or select the quality (Standard or Better).  

The Confirmations preferences include settings for displaying hints and checking for software 
updates. Click on Reset Hints if you want the hints to be displayed. Click on Automatically check 
for software updates to ensure that you are informed when new software is available from 
Improvision. 

Other preferences are only applicable if you are running extension products and are described in 
those chapters. 
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Session Log 
The Session Log records information from when Volocity is started up until it is quit. Session logs 
always display: 

 The version of Volocity that is being run 

 The build date of that version which will be on or before the SMA expiry date for the license 

 The serial number for that product 

 Information about the computer hardware on which Volocity is running 

 Any products that are loaded 

 Any error messages. 
Session logs provide valuable information to Improvision Technical Support engineers when 
diagnosing hardware or software problems. 

Show the Session Log by selecting Show Session Log from the Window menu.  

Session logs may be saved by clicking on the save button or emailed directly from the Session Log 
window. 

 

 

 

pause log save log 

e-mail log 
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Quitting Volocity 
Select Quit from the Volocity menu (Mac) or Exit from the File menu (PC).  

Volocity automatically saves all changes to a library before it quits. 

Upgrades from the Website  
For Mac OS or Windows simply download the latest installer from the Improvision website and 
double click to start the installation process. To perform installations you will need an administrator 
user name and password for the computer. Follow the instructions on screen and restart your 
computer when requested. 

Automatic Software Updates 
Alternatively, use the Preferences dialog to enable automatic checking for software updates. Select 
Confirmations and check the box next to Automatically check for software updates.  
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The Improvision server is checked for a newer version on start up. In order to query the Improvision 
server, the machine running the software must be connected to the Internet. When a later version is 
detected a message similar to the following is displayed: 

 
Click Download and download the installer for the application you wish to upgrade. Run the installer 
and follow the instructions on screen. 

Note: During the upgrade process, the installer will check that you have a valid Software 
Maintenance Agreement. No information is sent to Improvision during this check, but the upgrade will 
fail if you do not have one. 

Upgrading Applications on Client Machines for a License Server System 
Upgrading an application served by the Improvision License Server is simple. All the information 
relating to users, groups and configurations is stored on the server so there is no special process for 
installation.  See the instructions for Upgrades from the Website on page 34. 

Activating Additional Products after Installation (Single License) 
Note: This section is not relevant if your organization has a network license. Refer to the separate 
“Improvision License Server User Guide” for instructions on adding licenses to a server.  

If you purchase additional products to add to your original installation, you will receive an unlock 
code which you must enter in the Unlock Codes dialog. You can do this at any time after installing 
the software, as long as you have a valid dongle attached to your computer.  

Note: If you are upgrading from Volocity LE, you will need to purchase a dongle. When you attach 
the dongle and run Volocity, the purchased extension modules are automatically enabled.  

1. Mac OS X users: Select Unlock Codes... from the Volocity menu. 
Windows users: Select Unlock Codes... from the Help menu. 

2. You now need to enter a Code for each additional product that you have purchased. 
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3. Enter the Code for the first product and click on Unlock. There is no need to specify which product is 

being added and you can enter codes for products in any order. 

4. Repeat step 3 for each product that you have purchased. 

5. Quit and restart the software so that the unlock code can take effect. 
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Getting Started 

Overview 
This chapter describes: 

 important concepts 

 what a library is 

 how to create libraries  

 how to open existing libraries 

 how to close libraries and windows 

 how to acquire and add images to a library 

 how to create an image sequence  

 how to create volumes 

 how to import items 

 supported file formats 
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Important Concepts 
 Data is kept and organized in libraries. A library may contain many experiments and associated 

information. See page 39. 

 Libraries are files which are created using the New option in the file menu. Existing libraries are 
opened using Open from the File menu. 

 Libraries are databases, changes to databases are saved as they are made, there is no Save 
command. 

 Image sequences organize images that represent channels, time and/or z slices. See page 74. 

 Data imported into Volocity have properties. Properties record information about the experiment 
that acquired the information and affect how items are visualized or processed elsewhere in the 
software. Properties may be searched for. 

 Image data is explored in different ways using views. When an item is opened in the library the 
views are shown in tabs along the top of the window. See page 61. 

 Toolbars update when views change to show the appropriate tools. Tooltips, shown when the 
cursor is moved over a tool, indicate the purpose of that tool. 

 View-specific menus with the same name as the view configure the appearance of the view and 
access processing specific to that view. For example, when working with the Image View the 
menu bar will show an Image menu. 

 Most menu commands have shortcut keys. If you look at the command in the menu, you will see 
any shortcut keys to the right of the command name. PC users can use the standard Windows 
shortcut; right click on the mouse, to display a list of valid menu commands. 

 Work with views is enhanced by tools in palettes, which are floating windows containing tools and 
information that are relevant to different views. Choose Show Palette from the Window menu to 
see available palettes. 

 Menu items open dialogs allowing data processing and image enhancement. Dialogs support 
batch processing of many data sets with one command. See page 96. 

 Choose to apply a process to items from a group by selecting them, this highlights them in the 
interface. 
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 What is a Library? 
A library is the term given to the data storage format used by Volocity. A library must be created and 
images added to it before they can be viewed in Volocity. A library must be opened for Volocity to 
acquire data. 

A Volocity library is a collection of digital images, but the images themselves do not have to be 
physically stored within the library. The library can act both as:  

 an index with links to (and thumbnail views of) the images that are physically stored somewhere 
else on a hard disk, CD-ROM or other storage medium, and 

 a repository for images that have been acquired or edited by Volocity and are physically located 
within the library (adopted).  

The icons on the right hand side of each item in a library indicate where the originals of unadopted 
data are stored.  

This distinction between files that are linked to the library and files that are adopted in the library is 
important. You will be able to sort and create different views of linked files, but you will not be able to 
change the source data in any way. Only files that are adopted (physically stored) within a library 
may be edited. 

Libraries are based on a database structure and will store changes as they are made. 

Creating Libraries 
1. You can select Create a new library from the prompt shown when Volocity starts (unless you have 

disabled it). 

Or, once you are running the application, select New Library… from the File menu. (You can only 
have one library open at a time. If you already have a library open, you will be prompted to close it 
first.)  

2. Use the dialog to name the library and choose a location to store it. 
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On the Mac, a dialog similar to the following is displayed. Enter a Name for the library. The library 
format is called Multi-file (version 2) with the extension .mvd2. Click on Save. 

 
On the PC, a dialog similar to the following is displayed. Enter a File name for the library. Currently, 
the only library format is Multi-file Library Version 2 (*.mvd2).  

 
3. A library window is displayed. You are now ready to add items to the library.  

Library Format 
The application creates libraries in a multi-file format, which handles large data sets well and gives 
fast data access. When you create a multi-file library, it is created within a folder. This folder is 
labeled with an icon and the name of the library (as entered in the New Library dialog).  

 
a multi-file library folder  
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Inside the folder are the library file and a data folder, which contains all the data required to view the 
images and volumes kept in that library. Multi-file library files have a .mvd2 suffix. 

It is essential that the library file and data folder are kept together, which is why the application 
creates them together in a separate folder. To open the library, you must first open this folder and 
locate the library file. If you want to move a multi-file library to another location you must move the 
whole folder. If you only move the library file, the application will not be able to display any of its 
contents. 

Opening Libraries 
Once you have created a library, you can either double click on the library icon to open it, or select 
Open Library… from the File menu and choose the required library in the dialog. All libraries must 
have a .mvd2 extension or they will not be visible in the file list.  

Only one library may be open at a time. If you already have a library open, the application will prompt 
you to close it. Once the Library window is displayed, you can add new files to it, as described on 
page 42.  

Closing Windows and Libraries 
The application conforms to the standard Mac and PC conventions for closing windows.   

On a Mac, close the current window by selecting Close from the File menu. If the current window is 
the Library window, this command closes the library. You can also close any window by clicking on 
the top left-hand corner of the window. 

On a PC, close the library by selecting Close Library… from the File menu. Close the current 
window(s) by selecting Close (or Close All) from the Window menu. You can also close any window 
by clicking on the top right-hand corner of the window. 

Acquiring Data 
Data may be acquired during experiments using hardware for acquisition, that is, cameras and 
devices for microscope automation. All hardware must be installed and configured before use. This is 
described in full detail in “Volocity Acquisition Installation and Reference” starting on page 125. This 
chapter describes how to: 

 Install and configure devices 

 Use the Video preview to work with devices 

 In the Video Preview use light paths to coordinate changes to devices to meet the requirements 
of imaging modes 
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Once light paths have been configured they may be used in acquisition protocols. Acquisition 
protocols allow different combinations of channels, focus movement and XY control to be used in 
experiments that capture data. 

Example Acquisition Protocols for a variety of different experiments are described in the section 
starting on page 148. 

Adding Data 
Libraries can contain 2D and 3D images, which may be viewed in a number of different ways. The 
way that you add items to the library depends upon the type of images and how you want to view 
and work with them. 

 Acquisition from a camera adds images directly to image sequences. Image sequences are used 
to work with time and/or channels.  

 You can also drag and drop folders of images into an open Library window to add them to the 
library. 

 If you are adding a series of slices from one object at one timepoint on one channel, import the 
data as a folder of images and then create a volume as described in "Creating volumes." on page 
46. For example, you may be creating a volume of data from which to measure a PSF (Volocity 
Restoration only). 

Note: You can also use the Import command from the File menu to add single, unrelated items. 

Adding Images Using Drag and Drop 
The easiest way of adding items to the library is to drag an item from the desktop and drop it onto the 
Library window.  

For ease of use when image sequences are required set the Import preference to create image 
sequences rather than create folders of images. To do this, select Preferences... from the Edit menu 
(Windows) or the Volocity menu (Mac OS).  
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In the following drag and drop example, an image sequence is created. 

  
Double click on the library item to view the image sequence. For a detailed description of the 
different views, see the “Views on Data” chapter starting on page 61.  
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If the item dragged is a folder, such as a series of slices for a volume, the application will scan the 
contents of the folder and add all the files it recognizes to the library. Any hierarchy within the item 
that you drag and drop onto the Library window is retained.  

You can continue to drag as many folders or files as required onto the library, and you can add items 
to any level of folder structure. Items are inserted into the library at the red drag insertion arrow. The 
amount of indentation indicates the level at which an item is located within the library hierarchy.  

Note: The only limit on library size is the hard disk space. However, it is usually more practical to 
separate work into more manageable sets and create separate libraries for each one. 
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Creating an Image Sequence 
Image sequences are a collection of images arranged by channel and timepoint. Multi-channel 
and/or time-resolved data with one or more planes in z is best viewed using an image sequence.  

Set the Import Preference to Create image sequences to make image sequences automatically 
when importing related data. 

The Image Sequencer is a powerful tool for working with data related by time and/or channel. Once 
you have created an image sequence, you will be able to interact with the data in a number of 
different ways. See page 76. 

There are rules about the type of data that may be made into an image sequence. 

 All images in a channel must have the same depth and color look-up table.   

 The images must make up volumes that have identical X, Y and Z dimensions. 

To Create an Image Sequence Item: 

1. Select Create New from the Actions menu. 

2. Select Image Sequence to create a new image sequence item in the library.  

3. The Image Sequence window opens automatically. 

 
4. Drag and drop all the data for an experiment into the open Image Sequence view. Tabs in this 

window allow you to display different views of the data. You use the Image Sequence tab to add 
items to the sequence; it provides an overview of each channel and timepoint.  
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Hold the cursor over an item in the Image Sequence view to show a tip that gives the timestamp, 
channel and type 

 

Creating Volumes 
A volume is the name for a 3-dimensional object within Volocity, it is made up of a stack of images.  

If you are working with images from a single object at one timepoint or one channel, use the Make 
Volumes command to create a volume. For example, once you have added an image sequence that 
contains 2D images related in the Z-dimension, such as confocal microscope, wide field microscope 
or magnetic resonance image stacks, you can use this command to create a volume within Volocity.  

Note: If you are working with multi-channel or time-resolved data, the easiest way of doing this is to 
use the Image Sequencer. 

1. Select the item(s) in the library. From any folder or file containing many images you can select 
individual images; for example, all the images belonging to a channel.  

2. Select Make Volumes from the Tools menu.  

3. The PC version of the software always gives you the option of scaling down the source images in the 
volume.  
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Mac users should hold down the Alt key when selecting Make Volumes, if they want to apply scaling.   

 
4. Enter scaling values as a percentage and click on Create. Volocity creates the volume and the 

Library window now contains an image item for the 3D data.  

 

thumbnail 
for new 
volume 

location icon  

Volume items 
only exist within 
the library.   
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Importing Items (File Menu) 
To add single files to a library you can use the Import command.  

1. Select Import… from the File menu to display a dialog similar to the following. 

 
2. The Show: drop-down menu at the bottom of the dialog allows you to specify a file format, so that 

you can locate the required file more quickly. 

3. Locate the required image. If it is in a folder, select the folder and click on Open to open it. Once you 
have located and selected the image, click on Import to add it to the library. 
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Supported File Formats 
For reading, Volocity currently supports the following formats:  

 BioRad PIC  

 Windows BMP  

 Volocity Library Clipping  

 DeltaVision  

 ICS/IDS (Image Cytometry Format)  

 JPEG  

 Leica LIF (generated by Leica confocals) 

 Neurolucida Tracing XML format 

 Openlab LIFF  

 PerkinElmer AIC  

 Apple PICT  

 QuickTime Images (this includes formats such as Photoshop PSD and any other still image 
format supported by QuickTime)  

 TIFF  

 Improvision TIFF extensions (metadata included in the ImageDescription tag)  

 Leica TIFF (generated by Leica confocals)  

 Olympus TIFF (generated by Olympus confocals)  

 PerkinElmer TIFF (generated by PerkinElmer UltraView systems)  

 GE TIFF (generated by GE Healthcare INCell 1000 systems) 

 OME TIFF (as described by the Open Microscopy Environment http://openmicroscopy.org ) 

 Zeiss LSM (this is a TIFF variant)  

 MetaMorph STK (this is a TIFF variant)  

 Olympus OIF (this is a TIFF variant)  

 TILLVision  
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For writing, Volocity supports the following formats:  

 Windows BMP  

 Volocity Library Clipping  

 JPEG  

 Openlab LIFF  

 TIFF (with Improvision extensions)  

 OME-TIFF (2007 schema, as described by the Open Microscopy Environment 
http://openmicroscopy.org) 

 TIFF for Publication 

 QuickTime Movies  

 AVI Movies  

Volocity supports writing views as QuickTime movies and as AVI movies.  
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Organizing Data in a Library 

Overview 
This chapter describes: 

 the library format 

 the library menu and toolbar 

 library thumbnails and icons  

 how to tell where data is stored 

 how to set item properties 

 how to create new folders  

 how to copy and move folders and items 

 how to find items 

 how to compact libraries 
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Library Format 
The application creates libraries in a multi-file format, which handles large data sets well and gives 
fast data access. When you create a multi-file library, it is created within a folder. This folder is 
labeled with an icon and the name of the library. 

Inside the folder are the library file and a data folder, which contains all the data required to view the 
images and volumes kept in that library. Multi-file library files have the suffix .mvd2. 

 It is essential that the library file and data folder are kept together, which is why the application 
creates them together in a separate folder. To open the library, you must first open this folder and 
locate the library file. If you want to move a multi-file library to another location you must move the 
whole folder. If you only move the library file, the application will not be able to display any of its 
contents. 

Library View 
The Library view shows you a list of all the items in your library. If there are sub-folders or single files 
containing multiple images within your library, click on the arrow next to the folder/file thumbnail to 
expand and contract the folder and view/hide the contents. See also page 62. 

Library Menu and Toolbar 
Whenever a Library view is active, there is a Library menu and a Library toolbar.  

Library Menu 
Use the Thumbnail commands on the menu to control the size of the thumbnails in the library. Use 
the Show data and Sort by commands, to determine what information is displayed with a library 
item and how items are sorted in the library.  
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Library Toolbar 
Use the rotate tools to rotate single items 90 degrees in a clockwise or counter-
clockwise direction.  

The rotate commands are available in the toolbar and from the Actions menu. (You 
can also flip single images using the Flip commands in the Actions menu, but you 
must first adopt the item, see page 96.) 

 

Library Thumbnails and Icons  
The item's thumbnail tells you what kind of item it is.  

 
This is a folder or multi-layered file. 

 
This is an Openlab LIFF file containing multiple images. 

 
This is a thumbnail of the image (2D) or volume (3D). 

 
This is a PSF (used with Volocity Restoration, see also the glossary). 

 
This is an image sequence. 

 
This is a movie sequence (only available with Volocity Visualization). 

 
This is a measurement item (only available with Volocity Quantitation). 

 
This is a background correction. 

 
This is a registration correction. 

 
This is a spectral signature. 
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How Do I Tell Where the Data is Stored? 
When you create a library, folders and images are catalogued within the library structure. However, 
the source image remains in its original location - on the hard disk, CD or server - and the application 
will need access to this information for certain operations, unless you explicitly adopt it into the library 
structure. Icons indicate whether an item in the Library View is stored within the library hierarchy or is 
located somewhere else. The following list provides examples of the icons.  

 
The item only exists within the library or has been adopted into the library. All volumes 
have this icon as they are created within the library. Files copied within or between 
libraries also have this icon. 

 The item is stored on the hard disk and catalogued within the library. 

 
The item is stored on a CD and catalogued within the library. 

 
The item is stored on a network server and catalogued within the library. 

 
The item is stored on a Zip disk and catalogued within the library. 

 
The item is stored on a floppy disk and catalogued within the library. 

Setting Item Properties (Edit menu) 
Every item has a number of properties associated with it.  

Some properties are fixed and are assigned by the system, such as the kind, time modified and date 
modified. Others are user-defined, which provides you with a useful method of recording additional 
data against an item by which you can also search for items. You can set properties on both 2D and 
3D items.  

The correct XYZ properties (in micrometers per pixel) are essential for generating correct scale bars, 
calibrated measurements in Quantitation and the correct application of PSFs in Restoration. These 
properties effectively set the calibration of the data. 

The Volocity file filters read XYZ calibration information from supported file formats when they are 
imported. Acquisition directly into the application will set the relevant properties automatically.  
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In the following example, we have set up properties for a single item. To change common properties 
for several items at the same time, select the required items before selecting Properties… from the 
Edit menu. 

1. Select an item and then select Properties… from the Edit menu. We have selected an item called 
"Neuron".  

2. Enter properties as appropriate. Use commas to separate multiple entries, for example keywords. 

 

3. Click on Change.   

Creating New Folders 
Create folders to organise data within a library.  

1. Select Create New from the Actions menu and then select Folder. This will create a new, untitled 
folder underneath whatever item is currently selected in the library. If nothing is selected, the untitled 
folder will be the last item in the library. 
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2. Drag and drop items into the new folder as required.  

Copying and Moving Folders and Items 
Copy Items Between Libraries 

There are several ways of copying items from one library to another. You can use the Copy and 
Paste commands from the Edit menu. Select the items that you want to move in the first library. 
Select Copy from the Edit menu, close the library, open the other one and select Paste from the Edit 
menu.  

Alternatively, you can create a clipping file. Select the item in the open library, use the Export... 
command and select the Library Clipping format. The Export command allows you to specify a 
unique name for the clipping file; it will have an .acff suffix. See also page 120. 

To copy the clipping file to a new library, open the library and drag and drop the clipping into the 
library view. You can also use the Import... command to import the .acff file into the library. See 
page 48. 

Move Folders into Other Folders 
Click on the folder and drag it to the required position in the library hierarchy. 
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Move Items from One Folder into Another 
You can move sub-folders and individual, unrelated image files, such as TIFF files. You cannot move 
items from multi-layered files, such as Openlab LIFF files or multi-layered TIFF files, because the 
relationship is set by the source data. Moving the item would change the way the original entry in the 
library is linked to the source data. If you try to do this, you will be prompted to create a copy of the 
item.  

Copy Items from One Folder into Another 
 If you have tried to move an item from a multi-layered file, click Copy at the prompt. 

 Or select the item and use the Duplicate command in the Edit menu. This duplicates the item in 
the same folder and you can drag and drop it into another folder.  

 On a Mac, hold down the Alt key as you drag the item into a different folder. A progress message 
is displayed telling you that the application is copying the item into the folder.  

 On a PC, hold down the Ctrl key as you drag the item into a different folder. A progress message 
is displayed telling you that the application is copying the item into the folder.  

The copied item is automatically adopted into the library so you will be able to make changes to it 
without changing the source data.   

Finding Items (Edit menu) 
The Find command allows you to quickly locate images within a library. 

1. Select Find from the Edit menu. 

2. Enter the search criteria, as appropriate. You will be able to select from a number of search criteria. 

 
3. Click Find to display the Search Results window, which is displayed as a Gallery window. There is 

also a Results menu which has the same commands as the Gallery menu described on page 87.  
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4. Double click on the required item in the Search Results window to open it in a new window.  
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5. If you want to enter multiple search criteria, select Find again and click on the More Choices button. 

 
6. Enter as many search criteria as required and click on Find to display the search results. 

Note: Find remembers the search criteria, so use the Fewer Choices button if you want to remove 
search criteria that you have already set up.  

Delete/Remove Items from a Library 
Highlight the item(s) to be removed and select Remove Items from the Actions menu. If you change 
your mind, use the Undo command from the Edit menu.  

Items cannot be removed if they are part of a linked file that is not adopted into the library. 

To remove part of an item, for example a selected channel, an ROI, a measurement item row, select 
the part that is to be removed and use delete (Windows) or backspace (Mac OS). 
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Locating an Item (Actions menu) 
The Show in Library (see page 90) and Reveal in Finder/Explorer commands in the Actions menu 
allow you to quickly locate an image link in the library or the source data in the Finder (Mac) or 
Explorer (PC).  

Reveal in Finder/Explorer 
This command works from a Library, Single Image or Gallery View and highlights the location of the 
source data for the selected item in the Macintosh Finder or Windows Explorer. If the source data 
has been removed from the hard disk, the application just displays the Finder or Explorer. If the 
source data was on a removable medium, it prompts you to insert the relevant disk or medium. 

Compacting Libraries 
Even though libraries will increase in size under normal use, Volocity will always make best use of 
available disk space. However, when moving or backing up libraries you may like to use the 
Compact Library command. This optimizes the library size. Cached data includes stored rendering 
settings, therefore, it may take longer to view data once the library has been compacted.  

1. Select Compact Library… from the File menu. 

2. Leave the checkbox selected to remove cached data and preferences. Then click on Compact.   
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Views on Data 

Overview 
Once you have added data, you can view library items and items within an image sequence in a 
number of different ways. Each type of view has its own window, menu and toolbar. View-specific 
menus and toolbars contain commands that are particularly relevant to that view. The menu title 
and/or contents will update according to the active view. 

In addition, there are two palettes that may appear in a separate window on the screen: the 
Navigation palette and the Voxel Spy palette. (If these are not visible, use the Show Palette 
command in the Window menu to display them.) 

This chapter describes: 

 the Library View 

 how to look at and select items in the library 
 the Image View 

 the Image Sequence view  

 the Voxel Spy palette 

 the Navigation palette 

 the Gallery View, menu and toolbar 

 the Movie View, menu and toolbar 

 the Notes tab 

 how to capture snapshots 

 how to show data 

 how to sort items 
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Library View 
The Library View shows you a list of all the items in your library. If there are sub-folders or single files 
containing multiple images within your library, click on the arrow next to the folder/file thumbnail to 
expand and contract the folder and view/hide the contents.  

 

 

Click on arrow to 
expand/contract an 
item 

Click on a thumbnail 
or item name to 
select it. If you select 
the name, you can 
edit the text. 

Use the scroll 
bar to view more 
items in the 
library 

Click and drag to 
expand/contract 
the window 



VIEWS ON DATA 

February 2008   63 

How Do I Look at Items in the Library? 
Double click on an item in the library to open it in a separate window. The window will have a toolbar 
and a number of tabs that allow you to display different views of the image data. The type of item 
determines what tabs and tools are available. 

 If you select a single image from the library, you will display the item in an Image View. See page 
64.  

 If you select an image sequence, you will display the item in an Image Sequence view. See page 
76. You can click on the Image tab within the sequence to display it an Image window and then 
use the Navigation palette to move to other images in the sequence. 

 If you select a folder or multi-image file, you will display the contents in the Gallery View. See 
page 87. If there are sub-folders, you can double click on those to open them. Once you have 
displayed a Gallery View, you can create a Movie View of the images within the gallery. 

 If you select a movie sequence, you will open the item in the Movie Sequence View. This item is 
only available with Volocity Visualization, see page 249.  

 If you select a PSF, you will display the item in an Image window together with the PSF data that 
was used to carry out restoration. This item is only available with Volocity Restoration, see page 
339.  

Note: It is possible to open the same data multiple times. This is an extremely useful feature as it 
allows you to compare different views of the data. 

Selecting Items in the Library 
You select items in the library in the same way that you select items in Macintosh Finder or Windows 
Explorer. 

 Click on an item thumbnail or item name to select the item.  

 To select a group of consecutive items, hold down the shift key and click on the first and last item 
in the group.  

 To select multiple items not in sequence, hold down the Apple key on the Mac or the Ctrl key on 
the PC and click on the required items.   

See “Organizing Data in a Library” on page 51 for more information about working with the Library 
View. 

Status Bar on Windows 
The status bar is a standard Windows feature that appears in all views on the PC at the bottom right-
hand corner of the application window. This is also the first place that progress information is 
displayed, even before a progress bar is posted to the screen. Error messages may also appear in 
the status bar. 
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Image View 
When you double click on an image item in the library or click on the Image tab within an image 
sequence, the data is displayed in an Image View. Whenever an Image View is displayed, you will 
see an Image menu and toolbar, which contain commands and tools that are appropriate for the 
image data.  

2D Items  

 
If the image is from an image sequence you can use the Navigation palette to move to different 
timepoints in the sequence, turn channels on and off, and increase or decrease brightness. 
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3D Items 
When you double click on a volume item in the library or click on the Image tab within an image 
sequence consisting of 3D data, it is also displayed in an Image window. However, the window is 
now sectioned into four to show the 3-dimensional cross-section of all planes (top left section) and 
each of the axes/planes.  

 
In an image sequence, the view displays a brightest point merge of all the channels at the current 
location in the object.  

You can use the Navigation palette to play through all the volumes in the sequence, turn channels on 
and off, and increase or decrease brightness. 
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Image Menu  
Whenever an Image View is active, there is an Image menu available in the menu bar. The menu 
commands are appropriate to the type of image data. For example, the Reset Channels command 
only applies to an image that has been selected from an image sequence.  

Use the Smooth Zoom command on the Image menu to apply interpolation to the view to give better 
quality when viewing zoomed images and automatically set the best quality for printing.   

When viewing the image view of an image sequence consisting of two or more channels, the user 
can choose the method that is used to merge the two channels for display from the Overlay 
channels using menu.  

 Brightest point: The brightest intensity in the source images is displayed.  

 Accumulate: The total intensity of the voxels in the source images is displayed.  

 Average: The average intensity of the source images is displayed.  

  

Scale Options… are described on page 69, View Options… are described on page 72, Color 
Reference Options… are described on page 67, Show Data is described on page 92,  Show Time 
is described on page 67, Capture Snapshot is described on page 91,  

Other commands allow you to show or hide elements of the view. Some of these will be grayed out 
for 2D data. For example: with a volume item you can select Hide 3D Planes to simplify the 3D 
cross-section part of the view.  
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Extended Focus (not available in Volocity LE) 
This option is available when viewing 3D images in the Image View. It displays a single image by 
making a brightest-point merge of all the Z-slices of a volume.  

Use the Image Menu to toggle between XYZ Planes and Extended Focus. The XYZ view displays a 
single plane in each of the three dimensions. The Extended Focus view displays a single image, 
which is a brightest-point merge of all the Z-slices of a volume. 

  
Selections can be made within the volume, using the tools in the Image View toolbar, and 
measurements can be made from these selections. Note that the volume and all selections made are 
three-dimensional and have depth and volume.  

Show Time 
The timestamp of an image in an image sequence can be shown when viewing the Image View.  

 Select Show Time or Hide Time in the Image menu to toggle the timestamp on or off. 

 Select Absolute Times or Relative Times to choose the style of timestamp to be displayed.  

 Select View Options… and change the Frame time color to change the color of the timestamp.  

Showing Color Reference 
On all Image Views, apart from millions of colors images, you can display a legend that shows the 
colors in the image and the values they represent.  
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To display the legend, select Show Color Reference from the Image menu.  

 
The color reference may be moved to any corner of the XY area of the image view. 

Note: There is a separate color reference for each visible channel. Therefore, if multiple channels 
are selected in the Navigation palette, multiple legends will be displayed. Hide unwanted color 
references by hiding the channels from which they are derived on the Navigation palette. 

Select Color Reference Options… from the Image menu to choose how the color reference is 
displayed. 

Color 
reference  
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Showing Scale on Images 
Whenever an Image View is active, you will also be able to display scaling information. Select Show 
Scale from the Image menu to activate this feature.  

 
 The scale displayed will depend on the properties set for the size of voxels in the X,Y and Z 

dimensions. Choose Show Properties... from the Edit menu to check these values and ensure 
the correct scale is displayed. 

 Use Scale Options... from the Image menu to change how scale is displayed. 

 Move the scale to any of the four corners of the image by dragging it. 

 Extend or shorten the scale bar by clicking and dragging one end of it. 

Use Scale 
Options… to 
show/hide 
labels  
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Image Toolbar  
The image toolbar contains the rotate and library navigation tools, and a number of other tools for 
zoom and pan, and selecting regions of interest (ROI) on the image. Tooltips, shown when the cursor 
is held over the tool, indicate its purpose. 

                                                                         

Inspection Tool  

 
Shortcut key I 

This tool is only available with a 3D Image View. Use the cross-hair tool to 
position the pointer on any of the planes and drag to explore the Image View 
moving through the different parts of the slices. 

 

selection tools 

rotate tools 

library navigation tools

inspection tool 

zoom and pan tools 

line tool 
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Note on the screen how the cross-hair colors are different for each plane and are also shown on the 
3D preview in the top left-hand corner (the colors will show on the electronic version of this manual, 
but not on the printed version).  

 

blue = YZ plane 

red = XY plane 

green = XZ plane 

 

YZ, blue 

 

XY, red 

 

XZ, green 
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Zoom and Pan Tools 
 

 
Shortcut key Z 

Use the Magnifying tool to zoom in on a region of interest. Click with the tool to 
zoom in. On a Mac, Alt-click zooms out again. On a PC, use Ctrl-click. On a 
3D Image View, the zoom command allows you to magnify any of the three 
planes. If you zoom in on one of the planes, then all three planes will be 
magnified to the same factor and the 3D cross-section has a fixed, relative 
size. 

 
Shortcut key H 
 

On 2D Image and Movie Views, use the Hand tool to pan through a magnified 
image. On 3D Image Views, use the Hand tool to pan the XYZ planes. Over 
the 3D cross-section the cursor will always appear as a hand. Click and hold, 
then spin and release to make the preview tumble. Use Alt-click (Mac) or Ctrl-
click (PC) and drag to zoom the 3D cross-section.  

View Options 
The View Options dialog is available in the Image menu.  This is a tabbed dialog with options for: 

 General: showing line length with line drawn using the line tool and the color that image 
timestamps are shown on the Image view. 

 Color Reference: to change the nature of the color reference overlay, its orientation, color 
and caption. 

 2D- Scale: to change the style, color and labeling of the scale bar overlay. 

 ROI: to change the appearance of ROIs in the image view 

Selection Tools  
Use the Selection tools to draw regions of interest (ROIs) and lines on the image. Although the tools 
are available with all versions of Volocity, they are mainly used for measuring with Volocity 
Quantitation. Refer also to the chapter on "Volocity Quantitation" for worked examples using these 
tools for measurements. 

 

  
Shortcut key R 

The Rectangular ROI selection tool is available for all image data. It allows you 
to draw rectangles or squares.  

 

 
Shortcut key S 

 

The Lasso tool allows you to trace the outline of a selection. The Lasso tool 
selects regions based upon the color similarities of adjacent pixels. The initial 
point clicked sets the color to compare and the tool has the effect of shrinking 
around the pixels that fall outside of the tolerance value.  
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Shortcut key C 

The Elliptical ROI selection tool allows you to draw ovals or circles.  

 
Shortcut key F 

 

The Freehand tool is available for all image data. It allows you to make a 
freehand selection of an area on the image.  

 

 

Shortcut key W 

 

The Magic Wand tool is available for all image data. It allows you to select 
regions based upon the color similarities of adjacent pixels. The initial point 
clicked sets the color to compare. This tool has the effect of expanding 
outwards from the original color.   

 

 

 

Shortcut key L 

 

The Line tool is available for all image data, but is of limited use without the 
Volocity Quantitation functionality. Use it to add lines in the Image View. The 
tool draws a straight line between points that you specify by holding down the 
Shift key and clicking with the cursor. You can have any number of points in a 
single draw action, as long as you hold down the Shift key. When you release 
the Shift key, Volocity assumes that the last click was the end point.  

Tips on Using the Selection Tools 

Once you have selected an area, you can also use the Copy command from the Edit menu. Cut, 
Paste and Clear commands are only active if the item is adopted (see page 96).  

As long as the selection is still active, you can use the pointer to click in the selected area and drag it 
to another part of the image.  

The following key combinations also apply:  

Macintosh 

 Control-drag on a selection centers the selection on the image.  

 Command-drag locks the dimensions, to make a square or circular selection rather than oblong 
or oval. 

 Shift allows you to add to the ROI or draw multiple ROIs. 

 Shift + alt (option) allows you to subtract from the ROI or subtract the whole of the existing ROI 
by drawing around it.  

 Alt (option) carries out an AND operation leaving only the intersection of the two ROIs.        
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Windows 

 Shift allows you to add to the ROI or draw multiple ROIs.  

 Shift + ctrl allows you to subtract from the ROI or subtract the whole of the existing ROI by 
drawing around it.  

 Ctrl carries out an AND operation leaving only the intersection of the two ROIs.  

ROI Options 
The ROI is shown as marching ants on the Image View with color projected onto the image to 
highlight the area of interest. You can define the color and transparency used for the ROI.  

 

marching ants 
outline the ROI 

color block 
shows projection 
of ROI on each 
plane 
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1. Select View Options… from the Image menu. 

 
2. Use the ROI color drop-down menu to select the required color and use the slider control to set the 

ROI opacity.  

3. Click on OK. 
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Image Sequence View 
Image sequences are collections of images arranged by channel and timepoint. Multi-channel and/or 
time-resolved data with one or more planes in z is best viewed using an image sequence.  

Image sequences are created when the data is added to a library or by dragging all the related 
images onto a new Image Sequence View. 

The Image Sequence View shows the brightest point merge of data for each channel and timepoint 
as thumbnails. The header information shows the XYZ dimensions of the source image data and the 
number of channels and timepoints in the sequence. 

1. Click on the title bar of any channel or timepoint to select it. 

2. Hold the cursor over an item in the Image Sequence View to show a tip that gives the timestamp, 
channel and type 

 
 To remove a channel or timepoint select it and either choose Clear from the Edit menu or use the 

backspace or delete keys.  

 Double click on any channel to rename it. Type in a new name and click on Change. 

Channels run 
horizontally 
across the 
view. Channel 
1 has been 
selected. 

Timepoints 
run vertically 
down the 
view. 

 

Note the time 
stamp at the 
top of each 
timepoint. 
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Image Sequence Timeline View (not available in Volocity LE)  
The Timeline View provides a way of viewing time-resolved image sequences. Click on the 
Switch to Timeline button at the top of the Image Sequence View.  

Each row in the Timeline View represents a channel in the image sequence. At the left of the row is a 
thumbnail image of the current timepoint. To the right of this thumbnail is a “timeline”. On the timeline 
a vertical red bar signifies the current timepoint. 

 
Use the Navigation palette to ‘play’ the timeline view of the image sequence. The red bar will move 
across the timeline and the current timepoint thumbnail on the left will update as the timepoint is 
changed.  

Note: The red bar can also be moved by using the mouse to drag it across the timeline. 

thumbnail 
image of 
current 
timepoint 

timeline 

red bar 
shows 
current 
timepoint 

Channel 1 
has been 
selected 
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Relative and Absolute Times 
Thumbnails in the Image Sequence View are labeled with a timepoint number and timestamp. The 
display of these timestamps can be altered to show:  

 Absolute Times: the timestamp given to the volume or the image, or  

 Relative Times: when timepoint one is designated as time zero and all other times are displayed 
relative to that.   

Use the appropriate option in the Sequence menu to choose which time is shown. 

Merge Channels  
This command creates a brightest point merge of the selected channels in an Image Sequence.   

1. Select two or more channels in an image sequence and select Merge Channels from the Sequence 
menu.  

2. A new channel will be created in the sequence. The new channel will have the same dimensions as 
all other channels in the sequence, and the previously selected channels remain unaltered. The new 
channel will be named “Merged Channel”. 

Copy Timepoints to a New Sequence 
Create a copy of part of an image sequence by dragging the portion required into the library.  

1. Select the timepoints that you wish to copy, using the Timeline View, as described above. 

2. Click and hold the mouse button on the column header of one of the selected columns. 

3. Drag the selected timepoints out of the sequence and into the library.  

4. A new image sequence will be created containing the selected timepoints. The new image sequence 
is named appropriately to indicate which timepoints were selected. 
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Resample Timepoints 
This command allows the image sequence to be resampled according to a desired frequency of 
timepoints. This will reduce the number of timepoints in the sequence and therefore its size. A 
reduced number of timepoints may assist analysis of a time-resolved sequence.  

1. Select Resample Timepoints… from the Sequence menu. 

 
2. Click the appropriate button to resample timepoints according to a desired number of frames per 

second or seconds per frame.  

3. Check Output to a new sequence if the results are to be used to create a new image sequence; it 
will have “(resampled)” appended to the name. 

4. Click OK. 

Note: If timepoints in the image sequence are already at or below the selected frame rate, 
Resample Timepoints… will make no change. 

Image Sequence View Zoom 
The Timeline View can be zoomed to view more or less of the sequence in the window. This is done 
using the three buttons at the top of the Image Sequence View: Zoom In, Zoom Out, and Zoom to 
Fit.   

 

Zoom in 

Zoom out 

Zoom to fit 
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Play Back Timepoints  
Use the Navigation Palette movie type play controls to play through the thumbnails of each timepoint.  

 

You can also make a selection in the image sequence and use the Navigation palette to play back 
the selected timepoints. 

Click and drag the tabs at the top of the timeline. A shaded selection will appear between these tabs, 
corresponding to the period of time selected. If space permits, the start and end timestamps of the 
selection will be shown, and a thumbnail of the first and last images in the selection. A shaded 
selection will also appear on the slider control in the Navigation palette.  

 

tabs 

play 
controls 
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Compress Channels 
This option allows you to compress channels within image sequences, which will reduce the file size 
of libraries containing large image sequences.  

Note: Only image sequences created in version 2.5 or higher may be compressed. 

1. View an image sequence and select the channels to be compressed. 

2. Select Compress Channels from the Sequence menu. 

3. Select the compression type, and the codec (the encoding to use) for that compression type from 
the drop-down menus. When using the compression type, QuickTime, the codec drop-down will offer 
all installed QuickTime codecs. 

 
Lossless compression means that no data is lost from the image. The data compressed in this way 
will remain effectively unaltered. The Better Compression codec will result in smaller file sizes, 
while the Faster Compression codec will result in less delay when opening image sequences. 

When compressing 8-bit channels, QuickTime compression is available. Not all QuickTime codecs 
are lossless, which means that data may be slightly altered after compression; however, it will 
usually result in an efficient and fast data compression of large sequences. When using QuickTime 
compression, use the slider bar on the dialog to choose a Smaller File size or a Better Image with 
less data loss. Using lossy compression on a data set will affect the results of measurements, 
deconvolution, and such like, therefore, it is not recommended for data that is to be processed further. 

4. Click OK. 
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The Navigation Palette  
The Navigation palette is available whenever you are working with an image sequence. If it is not 
visible select Show Palette from the Window menu.  

Note: The Navigation palette is also available with Movie Views. 

 

 
The Navigation palette is useful if you want to play back an image sequence in the Timeline, Image 
or Rendering views and provides the following controls. 

 The digital display gives the timestamp of the image and the timepoint number in the sequence. 

 

timepoint

controls for each 
channel 

mode of play 
buttons 

play controls 

speed of playback 
control 

speed

drop-down list of all 
timepoints in sequence 

channel brightness 
control channel cloak and 

target controls 

timestamp  

timepoint 
timestamp  
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 Select the required mode of play by clicking on the appropriate button, and adjust the speed, if 
required, by using the slider. 
 

 
 

 

 Click on the selection button to switch between Fixed Rate and Real Time, and to Skip 
Timepoints, if required.  

 

Use the slider to set the multiple of real time, based on the 
timestamp of the image. Volocity will play the sequence at the 
desired multiple, even if the time gap between successive 
frames is uneven. When playing back large data sets or 
attempting high rates of playback, there may not be enough 
capacity to maintain the rate shown in the palette and play 
back will slow. Select Skip Timepoints to maintain the rate 
required. 

mode of play buttons 

speed slider control 

shuttle loop  once through 
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 Use the play controls to play through the volumes in the sequence. 
 

 
 

 Use the drop-down list of timepoints for rapid viewing of the required timepoint. 
 

 
 

 To play only a selected range selection hold down the Shift key and click on the slider area. Drag 
to mark the required range. A shaded selection will appear. 

 

If the loop option is selected as the mode of play, the sequence will 
start again from the beginning of the selected area, once the end of 
the selected area is reached. 

   

slider control for playing the sequence 

play/stop back/forward one frame 

click to display drop-down 
list of all timepoints in 
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 While you play the sequence, you can use the channel slider control to adjust the brightness on 
individual channels, as required.  

 

 The two buttons in the channel controls allow you to show or hide the channel, and to target a 
channel for selections. 

  
Some tools make different selections depending on which channel is used as the basis for 
selection. For example, the magic wand tool works on voxel intensity so the size and shape of the 
selection made by the tool can be very different according to which channel is targeted when the 
selection is drawn.  

The show/hide button cloaks and uncloaks the channel in the Image Sequence View so you can 
choose to work with a channel or not. If a channel is cloaked in the Image Sequence View, it is 
also cloaked in the Image View. 

 

show/hide channel  target channel for selections 
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Voxel Spy Palette 
The Voxel Spy palette may be used on any Image View. For the voxel under the cursor and for each 
channel, it shows: 

 The X, Y and Z co-ordinates.   

 The color according to the active look up table. 

 Value(s). 

Choose Show Palette from the Window menu, if the Voxel Spy palette is not already visible on the 
screen, and position the cursor on the Image View at the point of interest.  

Click on the preview area in the palette to zoom in and out on the voxel.  

    
Note: Values shown for voxels are typically intensity values but may represent other properties 
depending on the source of the channel. 

click on preview to 
zoom in and out  

value of voxel  

XYZ co-ordinates and 
µm according to XYZ 
properties  
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Gallery View 
If you double click on a folder in the library, you will see the contents of that folder in a Gallery View.  

Use the scroll bars to move through all the contents of the gallery. Once you have displayed a 
Gallery View of image items, you can use the Movie tab to play these frames as a movie in the Movie 
View. The Notes tab is used to store text. It is described on page 91 and is common to all items in a 
library. 

 

Note: Double click on an image item within the Gallery View to display that item. 

Gallery Menu and Toolbar 
Whenever a Gallery View is active, there is a Gallery menu and a Gallery toolbar, which contain 
relevant commands and tools. 



Gallery View 
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Gallery Options 
When you have a Gallery View active, you will be able to use the Options command under the 
Gallery menu. This command allows you to set the display options and table style for the gallery. It is 
particularly useful if you want to print or publish the Gallery View.  

   
Select a table style of Normal or Minimalist (which removes the gray border). 

Check the appropriate display options and click on OK. The "source" icon indicates the location of 
the source image data and, when selected, appears in the bottom right-hand corner of each image in 
the Gallery View. If you select a Minimalist table style, you will also be able to show/hide the 
thumbnail borders. 
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Movie View 
Once you have displayed a multi-layered item in the Gallery View, you can also play the contents of 
that gallery as a movie.  

1. Click on the Movie tab. 

 
2. Use the Navigation palette to play the movie.  

See page 82 for a detailed description of this palette. Note that in Movie mode the palette does not 
show any controls for individual channels as these are not relevant.  
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Show in Library 
If you have a single image displayed in the active window or a single image selected in a Gallery 
View, this command highlights the image in the library structure. From a Movie or Gallery View (with 
no images selected), it highlights the folder or multi-layered file in the library structure. 

 
 

mode of play buttons 
play controls 

speed of playback 
control 

locates R Image 007, selected in Gallery 
View, in the library 
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Notes View 
For all items in a library, there is a Notes View. You can add notes to any library item and view or edit 
the notes at any time.  To add or edit notes, just select the Notes View and type in the text. You can 
use the Copy and Paste commands from the Edit menu and you can also print the notes, using the 
Print command from the File menu.  

Capture Snapshot Command (View-Specific menu)  
Although print commands are available from the 3D Views, they are not useful for publishing 
volumes. However, Capture Snapshot in the Image and/or 3D menu allows you to capture 2D 
snapshots of the 3D image data that you can then print.   

When used with the Image View, Capture Snapshot captures a 2D snapshot of the 3D image data. 
It creates a new folder in the library containing four 2D images: the XY, XZ, and YZ planes plus the 
3D cross-section. 

The Capture Snapshot command also captures any scale information, lines or ROIs that are 
displayed on the active view.  

Volocity Visualization users only 

When used with the 3D View, Capture Snapshot creates a single 2D image and adds it as a new 
image to the library. If you want to publish a volume and preserve the 3D effect, use the Create 
QTVR Movie… command from the Tools menu. 
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Show Data (View-Specific menu) 
You can select one item of data to display next to a library item. In the Library and Gallery Views the 
data appears below the thumbnail. For the Image and Movie views on the Mac the data appears just 
below the tab in the view-specific window; on a PC data appears in the status bar in the bottom right-
hand corner of the application window.   

1. Select Show Data from the view-specific menu. 

2. Select a property from the drop-down menu. 
 

 
3. The additional data is displayed. For Image and Movie views, you may need to resize the window to 

see all of the data. 

Sort Items (View-specific menu) 
You can sort items in a number of different ways. 

1. Select Sort By from the view-specific menu.  

2. Select a property or image brightness or color as the sort criterion.  

3. A progress meter is displayed briefly as the application sorts the images and rearranges them. 
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Docking Palettes (Windows Only) 
Palettes may be docked to the left or right-hand edge of the application window. Drag the palette to 
one side of the application window and release it when the outline of the palette changes. In the 
example below the Voxel Spy palette is dragged to the right and will dock to the right -hand side of 
the application window when the mouse is released.  

 

 
Open views will be sized accordingly. Palettes may be further docked on top of each other into the 
same window or stacked vertically in their fixed location. Palettes may also be arranged side by side. 
Drag the palette back onto the main window to release it. 

 



Docking Palettes (Windows Only) 
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Manipulating Data 

Overview 
The actions described in this chapter are applicable to both 2D and 3D image data. The commands 
are ordered alphabetically. 

 Undoing Commands 
 Batch Processing 
 Adopting Items (Actions menu)  
 Applying and Uses of Auto Contrast (Tools menu) 
 Changing Color Depth (Tools menu) 
 Changing Colors (Tools menu) 
 Changing Size (Tools menu) 
 Cloaking Items (Actions menu) 
 Color Balance (Tools menu) (Not available in Volocity LE) 
 Contrast Enhancement (Tools menu) (Not available in Volocity LE) 
 Creating Background Corrections (Actions Menu) 
 Correcting Background (Tools menu) 
 Creating Registration Corrections (Actions menu) 
 Correcting Registration (Tools menu) 
 Cropping Items (Actions menu) 

 Merge Planes (Actions Menu) 
 Removing Noise (Tools menu) 
 Splitting Multi-Colored Items (Actions menu) 
 Splitting Volumes (Tools menu) 



Undoing Commands 
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Undoing Commands 
The Edit menu has an Undo command that allows you to undo the most recent actions. It supports 
multiple undo actions, starting with the most recent and working backwards in sequence.  

Batch Processing 
Most image processing and enhancement tasks may be applied to batches of image sequences. 
Typically, the user will select a series of image sequences in the Library view and the dialog for the 
process concerned will present a list of unique channel names against which the user selects a 
process. If channels or items are selected, the option to change selected items will be presented. 

Adopting Items (Actions menu) 
Permanent changes to data may only be made if that data is saved in the library rather than linked to 
a source file which remains outside the library. Permanent changes include changing data size, 
cropping data and many image processing tools. Changing a file so that it is part of the library is 
called adopting.  Adopting increases the library file size. 

1. Select the required item(s) in the Library or Gallery window.  

2. Select Adopt Items from the Actions menu. The application searches for the source item(s). If they 
are not on the hard disk, it will prompt for the removable medium. It will be unable to adopt an item 
that was once on the hard disk but has since been deleted or moved.   

3. The icon indicating the location of the file changes to show that the file is in the library. 

  
Note: There is no Unadopt command. You can use the Undo command in the Edit menu to undo the 
most recent action(s), but you cannot select items and expressly apply an Unadopt command. 

Note how the icon on the 
right shows that the 
images are now held within 
the library structure.  

 

If you adopt a single layer 
within a multi-layered item, 
all layers within that item 
are adopted. 
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Applying Auto Contrast (Tools menu) 
Auto Contrast automatically sets the black and white points of the display image.   

Auto Contrast finds the brightest and darkest pixels or voxels in an item and modifies the lookup 
table so that the brightest point is at the maximum display value, the darkest point is at the minimum 
display value and all others are adjusted according to a linear best fit. The underlying intensity values 
within the data are not changed. 

1. Select the required item(s). Multiple image sequences can be processed at once. 

2. Select Auto Contrast from the Tools menu. 

 
3. The Auto Contrast dialog will offer a list of available channels. Selected channels, if applicable, or all 

channels may be adjusted. 

 



Changing Color Depth (Tools menu) 
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4. Choose the appropriate option depending on how data will be compared. The dialog explains the 
options.  

To manually adjust: 

 Black and white points: use Contrast Enhancement, see page 103. 

 Gamma: use Contrast Enhancement, see page 103. 

 Red, green and blue contributions in color images: use Color Balance, see page 102. 

Uses for Auto Contrast 
Auto Contrast provides a tool to adjust the LUT on imported data that appears extremely dark or 
completely black due to a mismatch between LUTs from different software applications. 

Auto Contrast can be applied to any item. However, as the contrast achieved depends on the 
brightest point in each item, the result of applying Auto Contrast to a series of 2D sections (many 
separate items) will be very different from the result of applying it to a volume (one single item) made 
from them. In most cases you will want to reapply Auto Contrast after making a volume or image 
sequence so that the whole data set is treated in the same way. 

When working with Auto Contrast, it is important to note that a single voxel that is very much brighter 
than any other will be enough to set the brightest level. This can lead to Auto Contrast causing no 
apparent change to data. 

Changing Color Depth (Tools menu) 
1. Select the required item(s.) Multiple image sequences may be processed at once, simply select them 

in the library. Select Change Color Depth… from the Tools menu.  

2. Click on the drop-down menu and select the required color depth.  

 
3. Click on Change. 
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Changing Colors (Tools menu)  
This command allows you to apply a different color lookup table to images, it does not change any 
underlying data.  Multiple items may be changed in a batch by selecting them all in the library view. 

1. Select the required item(s) and select Change Colors… from the Tools menu. 

 
2. Select the channel or channels to change 

3. Click on the appropriate grayscale or RGB color. You can also click on This color and select a color 
from the drop-down menu, enter a wavelength value or apply a Rainbow LUT. 

4. Click on Change.  



Changing Size (Tools menu) 
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Changing Size (Tools menu) 
Use Change Size to scale data changing the spatial resolution of the data and preserving the field of 
view. 

With 3D image data you can change the size of a volume in all axes, which uses less memory and 
saves time for some processes.  

Where resolution of data is important, for example when performing measurements or restoration it is 
preferable to preserve resolution and crop data instead, using the Crop to Selection command in 
the Actions menu. 

To scale data when making single volumes see page 46.  

The following example illustrates how to change the size of 3D items. (The process is the same for 
2D items, but step 3 is not required.) 

1. Select the required item(s) and select Change Size… from the Tools menu. 

 
2. Enter a scaling factor.  

3. For 3D images only, enter a scaling value as a percentage. The X and Y dimensions are scaled 
automatically, but you can choose how you want to change the Z size of the volume.  

4. Select Resizing the volume in Z to change the amount of data in the volume by discarding some of 
the z slice data. This command changes the number of frames in z. 

5. If the volume is short of z data, select Changing the Z calibration to retain all of the data but 
recalibrate the volume in z. This command does not change the data. It maintains calibration, which 
is taken into account in other processes. 

6. Click on Change. 
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Cloaking Items (Actions menu) 
Temporarily hide an image to exclude it from movie playback or inclusion in an image sequence by 
cloaking it. Show or Hide channels in image sequences by cloaking them. 

1. Select the item(s) that you wish to hide in the Library or Gallery View. Select the channel in the 
Image Sequence View. 

2. Select Cloak from the Actions menu. Note how the icon changes to show that the images are now 
cloaked. On both Mac and PC, the shading indicates a cloaked item. On a PC, the item's title is also 
grayed out. 

 
To Uncloak the item select it again and choose UnCloak from the Actions menu. 



Color Balance (Tools menu) 
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Color Balance (Tools menu) 
Color Balance is a dialog that allows the user to adjust the contributions of red, green and blue in a 
color image. 

1. Select the item(s) to be adjusted in the library.  

2. Select Color Balance... from the Tools menu. 

 
 If multiple 2D images are selected, the preview shows the first in the list; the same contrast 

enhancement settings are applied to all images. 

 If multiple 3D volumes are selected, the preview shows a brightest point merge of the first in the 
list; the same contrast enhancement settings are applied to all images. 

 If multiple image sequences are selected, the preview shows the first of the selected sequences.  
Only one channel at a time is previewed as a brightest point merge. The drop-down at the top of 
the screen shows a list of the unique channel names detected in the selected sequences. 
Controls under the preview allow navigation to different timepoints. 

1. Use the sliders to increase or decrease the contribution of the colors to the final image. 

2. Adjust one channel at a time; clicking Apply will change the selected channel but keep the dialog 
open allowing more changes to be made. Only one channel at a time may be enhanced but channels 
with the same name in multiple sequences may be enhanced in a batch. 

3. Click Change to apply the last change and close the dialog 
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Contrast Enhancement (Tools menu) (Not available in Volocity LE) 
Contrast Enhancement is a dialog that allows the user to manually set the black and white points of 
the display lookup table for an image, thus changing the contrast. It also allows gamma adjustment 
which will set a non-linear distribution of that lookup table between the black and white points. 

1. Select the required item(s) in the library. If working with an image sequence, select the channel to be 
enhanced. 

2. Select Contrast Enhancement… from the Tools menu.  

 
 If multiple 2D images are selected, the preview shows the first in the list; the same contrast 

enhancement settings are applied to all images. 

 If multiple 3D volumes are selected, the preview shows a brightest point merge of the first in the 
list; the same contrast enhancement settings are applied to all images. 

 If multiple image sequences are selected, the preview shows a brightest point merge of the first 
channel in the first sequence. A drop-down at the top of the screen shows a list of unique channel 
names detected in the selected sequences. Controls under the preview allow navigation to 
different timepoints, if applicable.  



Contrast Enhancement (Tools menu) (Not available in Volocity LE) 
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The red line across the histogram shows the current relationship between the input intensity values 
(X-axis) and the output LUT (Y-axis).  

 
Use the control points (red squares on the red line) to move the black, white and gamma points. 

 
 Change the Y-axis of the histogram to see detail more clearly, cycling through four possible 

resolutions; linear, log, base 10 and base 100. To do this: 

PC: Ctrl-click in the histogram area 
Mac: Alt-click in the histogram area 
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3. Click Apply to enhance all the channels with the selected name and leave the dialog open so that 
other channels may be enhanced. 

Calculate black and white points based on the darkest and brightest intensities in the data set by 
clicking on the Calculate button. For time series data choose to set these using just the current 
timepoint. 

Note: The controls on the Contrast Enhancement dialog cannot be used on data sets that have been 
colored with rainbow colors, see page 99.  

4. Once you are satisfied with the adjustments in the preview area, click on Enhance. 

To adjust contribution of red, green and blue in a color image use Color Balance, see page 102. 

Background Corrections  
In order to perform accurate analysis of your images or to improve their appearance, you may need 
to perform Background correction. Background corrections include dark current correction, 
background subtraction, shading correction or offset application. Bright or dark reference images 
may be required for your correction. 

Shading 

Shading defects can be introduced into images by poorly aligned light sources, stray light and dirt in 
the light path.   

Shading artefacts are corrected by including division of a bright reference image in your background 
correction. A suitable bright reference image for fluorescence images can be acquired from an 
illuminated, uniformly fluorescent sample. A bright reference image for bright field images can be 
acquired from a blank field (with no specimen present), which has been slightly defocused.   

Dark Current, DC Offset. 

Ideally, acquiring images from a digital camera in complete darkness would result in images with 
gray levels close to zero. However, this is not the case. A combination of factors including dark 
current and DC offset will result in gray levels 10s or 100s of levels from zero. These offset values 
are present in all images acquired with digital cameras.  

This is of no consequence for purely observational experiments when only the appearance, position 
or size of structures is of interest. However, when the intensity of objects is of interest these factors 
introduce error to all measurements made. The margin of error is small compared to the intensity of 
very bright objects, however, it becomes increasingly significant the fainter objects of interest 
become.   

A background correction that subtracts a “dark reference” image from all images corrects this 
problem, increasing the accuracy of all intensity measurements made. “Dark reference” images are 
acquired by blocking all light from the camera and acquiring an image. Ideally, the exposure time of 
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the “dark reference” should be the same as the exposure time of the experimental images to be 
corrected. 

A background correction that subtracts a fixed value from all images could also be used to correct 
this problem, but this is likely to be less accurate than using a dark reference image.  

Background (fluorescence)  

Further error can be introduced into intensity measurements by the presence of background 
fluorescence in a sample. This can be corrected by building a background correction that subtracts a 
“dark reference” image from all images. In this case the dark reference should be acquired from an 
illuminated area of your sample in an area in which no cells (or debris) are present. Again, the 
exposure time of the “dark reference” should match the exposure time of the experimental images to 
be corrected. A “dark reference” image acquired under these circumstances would correct 
background fluorescence in addition to dark current and DC offset. 

Defects that can be corrected are summarized in the table below:  

Defect Correction  Image Required for correction 

Shading 
(fluorescence) 

Division with a bright reference Illuminated uniformly fluorescent slide 

Shading (bright 
field) 

Division with a bright reference Slightly-defocused bright field image (with 
no specimen present) 

Dark current, DC 
offset  

Subtraction of dark reference Image acquired with light to camera blocked 

Dark current, DC 
offset  

Subtraction of a fixed value 
from every pixel 

None, set a negative offset in the correction 
(this correction is less accurate than 3a.) 

Background 
(fluorescence) 

Subtraction of a background 
image as a dark reference 

Illuminated sample with no cells in the field 
of view 

Creating Background Corrections (Actions Menu) 
You should acquire or add bright and/or dark reference images to your library before you build 
background corrections. Bright and dark reference images should be the same dimensions in X and 
Y, and the same depth as your images to be corrected.  

1. Select Create New from the Actions menu. 

2. Select Background Correction… to create a new background correction item in the library.   
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3. The Create Background Correction dialog opens. 

 
You can use the dialog to create a variety of corrections. As you build your correction, it is 
summarized at the bottom of the dialog. When you first open the dialog the summary reads 
“corrected image=image” to reflect that you have yet to specify any corrections. 

You may apply as many or as few elements of the equation as you wish in your corrections, 
depending on what you wish to correct for and how accurately you wish to do so. 

Volocity uses the following equation when building background corrections:- 

Corrected Image = Scaling Factor x ((Raw Image - Dark Reference + Offset)/(Bright Reference -Dark Reference)) 

Bright Reference Images 
If you wish to divide your raw images by a bright reference image, select a bright reference image 
from the drop-down menu. All of the images in the library will be displayed in the list. The degree of 
shading in the bright reference is displayed in the dialog using the formula:  

Shading = (Intensity max – Intensity min / Intensity max) x 100%).  
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If you select a bright reference image, your corrected image will be multiplied by a scaling factor to 
bring its gray levels into a convenient range. The scaling factor is the brightest pixel value in the 
bright reference image (after subtraction of the dark reference image, if selected). 

 

Dark Reference Images 
To subtract a dark reference image from your raw images, and bright reference images if you have 
selected one, select an image from the dark reference drop-down menu. All of the images in the 
library are listed in the drop-down menu. 
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Offsets 
To apply an offset to your images, enter a positive or negative value into the offset field of the 
dialog. Positive values will be added to raw images, negative values will be subtracted. 

When you have built a satisfactory background correction, select Create. A new background 
correction item is added to the library. 

 
Background correction items can be exported from libraries as library clippings and imported into 
other libraries. 

Inspecting Background Corrections 
Double click a background correction item in the library to inspect it. The background correction will 
open and you can review the names and thumbnails of images that were selected as either bright or 
dark reference images, as well as a summary of the background correction that will be applied. 

 

Correcting Background (Tools menu)  
In order to perform accurate analysis of your images or to improve their appearance, you may need 
to perform Background correction. Background corrections include dark current correction, 
background subtraction, shading correction or offset application. Bright or dark reference images 
may be required for your correction. 
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For further information on background correction and the images required please see page 105. 

To use the Correct Background... command the library must contain appropriate background 
correction items. See page 105. 

1. Select any images or image sequences that you wish to background correct.   

2. Select Correct Background… from the Tools menu. The Background Correction dialog opens.   

 
3. Volocity will attempt to match the names of the background correction items in your library to the 

names of the channels in your selected images or image sequences. If you have many correction 
items in your library, you may need to manually select the background correction by clicking on the 
drop-down menu for each channel and making a more appropriate selection. 

Background corrections can be applied to 3D image sequences in the same way that they are 
applied to 2D datasets. The same background correction will be applied to each plane of your 
volume. 

 
 For image sequences: Volocity will create new background corrected channels in image 

sequences in which your background corrections have been applied. 

 For images: background corrected images will be placed beneath the original images in the 
library. 
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Creating Registration Corrections (Actions menu) 
“Registration Corrections” are items that record the degree by which channels need to be moved in 
X,Y and Z in order to bring them into perfect register. Once Registration Corrections have been 
generated they can be applied to image sequences indefinitely, provided that the degree of shift 
between channels remains constant. 

We recommend that you first acquire an image sequence of a fluorescent bead set from which 
registration shifts can be accurately calculated. You should acquire a multi-channel image sequence 
and ensure that you acquire every channel and every magnification with which you intend to work in 
your experiments. If you intend to do 3D work, you should acquire 3D image sequences of the beads 
so that you can detect and correct any registration problems in the Z axis. 

1. Select the image sequence on which you wish to base your corrections in the library. 

2. Select Create New from the Actions menu. 

3. Select Registration Correction…  

The Create Registration Correction dialog opens.  

 
4. You should enter a name for your registration correction. 

5. Volocity will automatically select an anchor channel, this is the channel relative to which the 
remaining channels will be shifted. If you wish to use another channel as the anchor, select one from 
the drop-down menu. 
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Manual Creation of Registration Corrections  
1. Select one of the remaining channels from the list to see its position relative to the anchor channel.   

2. Change the View displayed in the preview from XY to XZ or YZ by selecting the appropriate radio 
button, and change the magnification of the preview by dragging the magnification slider. 

3. Change the position of the currently displayed plane by either dragging the current plane arrow on 
the depth control or by clicking anywhere on the depth control.  

4. Move the currently selected channel relative to the anchor channel by clicking on the four direction 
arrows, which will move the selected channel relative to the anchor channel. Move the channel so 
that it is in perfect register with the anchor channel in the X, Y and Z planes. 

5. When you are satisfied that your channel is in perfect register with the anchor, select your next 
channel and repeat the process.   

6. Ensure that all your channels are correctly registered with the anchor. Ensure that you have checked 
all channels and all views. Registration Corrections are likely to be applied to many image 
sequences so accuracy at this stage is essential. 

7. Click Create. 

Automated Creation of Registration Corrections 
1. To make Volocity attempt to automatically place each channel in register with the anchor channel, 

click Auto. 

2. A progress bar is displayed as Volocity calculates the degree of shift between each of the channels. 
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3. Volocity displays the number of pixels by which each channel has been shifted in X, Y and Z in order 
to place it in perfect register with the anchor channel. 

 
4. To check the correction of a channel, select the channel from the list. Volocity will display only that 

channel and the anchor channel in the preview.   

5. Manually edit the position of a channel relative to the anchor channel by clicking on the four direction 
arrows.  

6. When you are satisfied that the corrections are accurate, click Create. 

Registration correction items can be exported from libraries as library clippings and imported to new 
libraries, so you should not have to repeat the process of generating registration corrections. 

Inspecting Registration Corrections 
Volocity adds registration corrections to the library. Corrections made at the same time are placed in 
a folder. The folder and the corrections have the name that was entered in the Create Registration 
dialog.  
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You can inspect registration corrections by double clicking on the associated item in the library. You 
can check the anchor channel and the relative pixel shift associated with each correction. 

 

Correcting Registration (Tools menu) 
When working with multi-channel image sequences you may find that channels are not always 
aligned with each other in perfect register. Channels may be shifted in the X, Y, or Z (or a 
combination of) planes relative to each other. Often this problem can be corrected by making 
improvements to your acquisition hardware such as purchasing shift-free fluorescence filter 
sets. Should this prove impractical you can use Volocity to correct registration problems. 

To use the Correct Registration... command the library must contain the appropriate registration 
corrections. See page 111. 

To apply registration corrections to image sequences: 

1. Select the relevant image sequences in the library. 

2. Select Correct Registration… from the Tools menu.  

3. The registration correction dialog will open. 

 
4. Volocity will attempt to match the names of the registration correction items in your library to the 

names of the channels in your selected image sequences. If you have many correction items in your 
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library you may need to manually select the registration correction by clicking on the drop-down 
menu for each channel and making a more appropriate selection.  

  

5. We recommend that you avoid mixing corrections that were generated at different times. Volocity will 
warn you if you choose to do this. 

6. When you are satisfied that each of your channels is paired with the appropriate correction item, click 
Correct. 

7. Volocity will create new image sequences in which your registration corrections have been applied, 
each sequence will have the original name with the suffix (registration corrected).   

Any areas in registration corrected sequences for which Volocity does not have data from all the 
channels in the sequence are cropped from the sequence, so registration corrected image 
sequences always have slightly smaller dimensions than the originals.     
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Cropping Items (Actions menu) 
Cropping data to a selection reduces the physical size and therefore the file size of an item in the 
library. Cropping a dataset means information outside the selection is lost but the spatial resolution of 
the remaining data remains the same. 

1. In the Image or Movie window, use one of the selection tools to outline the ROI (region of interest). 
See page 72 for more information about using Selection tools 

2. Select Crop to Selection from the Actions menu.  

In a 2D Image, this crops to the selected area. In a Movie window, this crops all frames to the 
selected area. In a 3D Image, this crops all Z slices. In an Image Sequence, this crops the XY 
dimensions of all Z slices in all channels in all timepoints.  

Smaller files use less memory and take less time to process. 
  

 
Change the size of data sets by scaling, changing resolution but preserving the field of view using 
the Change size command see page 100. 

Scale data when making single volumes see page 46.   
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Merge Planes (Actions Menu) 
Merging planes creates a brightest point merge of 3-dimensional data to create a 2-dimensional 
image. It effects a permanent change to the data set by creating a copy of the original data. 

It may be used to reduce data size or simplify movie playback. 

1. Select the item(s) which are to be merged from 3-dimensional to 2-dimensional. 

2. Select Merge Planes from the Actions menu. 

3. A new item is created in the library. It has the same name as the old item with “(merged)” appended. 
The actual number of channels and timepoints in the image is not altered, but the image at each 
timepoint will be two-dimensional. 
 

 
Note: Unlike the Extended Focus view described on page 67, which creates a brightest-point merge 
of all the Z-slices in a volume, Merge Planes does actually create a two-dimensional image, and any 
selections and measurements performed on this image will be two-dimensional.   

Removing Noise (Tools menu) 
The application provides a number of median filters that can be applied to remove noise from an 
image. These filters range from fine to very coarse offering an increasing size of filter matrix and 
degree of filtering.  

1. Select the required item(s) and select Remove Noise… from the Tools menu. The item must be 
adopted. Multiple image sequences may be selected for processing at once. 
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2. Select All Channels or the channel name to be adjusted. Click on the drop-down menu and select the 
required filter.  

 
3. Click on Change. This command may take some time to complete if you have selected a large 

number of items.  

Splitting Multi-Colored Items (Actions menu) 
If you have a multi-colored item, you can split it into its three channels. Select the required item(s) 
and select Split RGB from the Actions menu. 

In our example we have selected a multi-colored volume item (Neuron). The Split RGB command 
creates a new folder using the name of the volume (Neuron RGB) and creates a separate volume 
item for each channel.  
   

 

new folder item created 
containing volume item 
for each channel  

Fine = 3x3(x3) 

Medium = 5x5(x5) 

Coarse = 7x7(x7) 

Very coarse = 9x9(x9)  

item for splitting 
selected in the library 
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Splitting Volumes (Tools menu) 
You can split a volume from the library or from any of the volume views. This converts the volume 
into a layered format to produce a stack of two-dimensional images. 

1. Select the volume(s) and select Split Volumes from the Tools menu. 

2. At the prompt choose how you want the volume to be split. You can put all images into a single folder 
or organize them into a number of folders, in which case you will also need to specify Order by 
criteria from the drop-down menu. 

 
3. Volocity creates new folder item(s) in the library containing stack(s) of 2D images. 
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Printing and Exporting Data 

Overview 
This chapter describes how to: 

 Print from the application. 
 Export items. 

Printing from the Application (File menu) 
You can print the contents of the active window. This may be the Library View, a Single Image View 
or a Gallery View, as appropriate. Although print commands are available from the 3D Views, they 
are not useful for publishing volumes—you can use the Capture Snapshot command from the 
Image menu to create 2D images of the 3D View that you can print.  

The dialogs for print and page setup commands vary according to the type of printer that you are 
using. 

1. Click with the cursor in the window that you want to print. 

2. Use the view-specific menu options, as appropriate to control how the image appears. 

3. Select Print from the File menu. (Or from the Print Preview window, if that is displayed.)                 

Print Preview 
If you want to check the result before printing, select Print Preview from the File menu. You can 
usually access the Page Setup and Print commands directly from the preview. 

Page/Print Setup 
1. Click on Page Setup... in the File menu (Mac). Click on Print Setup... in the File menu (PC).          

2. The Setup dialog varies, depending upon which printer you are using. Amend the settings, as 
appropriate and click on OK.                

Exporting Items (File menu) 
The Export command allows you to export an item from the library as any of a variety of formats. You 
can also use it to copy files between libraries. 

1. Select the required items in the library or switch to the appropriate view.   

2. Select Export... from the File menu.              
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3. Change the file name, if required, and select a folder for the exported file(s).  

4. Select the Format.  Some file formats have an Options... button which allows configuration of the 
setting relevant to that format. If multiple items are selected for export the Export file dialog will show 
a Naming… button allowing you to define how the individual files will be named. Set the options, as 
appropriate, and click OK. 
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5. Click on Export. 

The export options depend on the view open and the product being used: 

 Export single images to create single images in formats such as TIFF or JPEG. Select multiple 
single images to export all the images as the same format in one step. 

 Exporting a folder of images will make a multi-layered item such as a QuickTime movie or a 
multilayered TIFF. 

 Export volumes and image sequences to export the item as a multi-layered file: Openlab LIFF, 
Openlab Raw, QuickTime movie or TIFF. The order of layers in the exported file will be z-slices 
then channels then time. 

 Working with an image sequence which contains time resolved data, selecting export from an 
Image (Extended Focus) or 3D View, offers the ability to export the view as a movie which will 
make a simple movie of that view stepping through timepoints. 

 Quantitation: Export Measurements as tab delimited or comma separated text. 

 Exporting Movies: Use the library clipping format to movie any library item easily between 
libraries. 

Volocity LE does not allow the creation of QuickTime or AVI movies. 

It is also possible to export settings from many parts of the software. Users of Volocity Acquisition 
are able to export acquisition protocols, users of Volocity Quantitation are able to export 
measurement protocols. Users of Volocity Visualization are able to export movies. In the dialog 
where these settings are saved there will be an Export... option allowing users to save their settings. 

For the latest information on supported file formats, please look at the Release Notes on 
Improvision's Support web pages at http://www.improvision.com. 

Export as AVI Movie for Windows Only (Not available in Volocity LE) 
Windows users have an additional movie format available for export, the AVI format. 

1. Select a folder of images in the Library view. 

2. Select Export… from the File menu. 

3. Enter the file name and select a location for the completed movie. 

4. Choose AVI Movie from the Format drop-down and click Export. 

Export as QuickTime Movie (Not available in Volocity LE) 
This option allows you to export a QuickTime movie with a frame rate based on the timestamps of 
the original files.  

1. Select a folder of images in the Library view.  

2. Select Export... from the File menu. 

3. Choose a name for the movie file.  
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4. Select QuickTime Movie from the Format: drop-down menu and click on Options… 

 
5. Select the Compression codec that should be used. The Compressor type and the bias towards a 

Smaller File or Better Image will affect the size and quality of the file created. This is a subjective 
decision, however, we suggest that Apple Animation or the Sorenson compression may provide a 
good balance between quality and file size. 

 
6. Select the timing required for the finished movie and click OK.  
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Export View as QuickTime or AVI Movie (Not available in Volocity LE) 
When working with an image sequence which contains two or more timepoints and viewing the 
Image View, it is possible to make a simple QuickTime or AVI (Windows only) movie from that view. 

Note: If each timepoint contains more than one plane in z, use the Extended Focus view. 

1. Configure the view, as required with scale bars, selections, and so on. 

2. Select Export from the File menu, change the file name, if required, and select a folder for the 
exported movie. Select View as QuickTime movie. 

 
The QuickTime Movie format provides additional export options. Select the compression codec and 
quality, and the timing required for the finished movie, and click OK.   
 

 
3. Click Export. The movie will be made by stepping through each of the timepoints. 
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Volocity Acquisition Installation and Reference 

Overview 
Volocity Acquisition is designed specifically for high performance acquisition of time-resolved, multi-
channel 3D sequences. It supports a range of hardware suitable for 3D imaging, including wide field 
microscopes, scientific grade digital cameras, fast focus drives and wavelength changers. 

It is very important to install and configure acquisition devices correctly before you start capturing 
images. This chapter describes how to: 

 Install and configure devices 

 Use device controls 

 Calibrate objective lenses 

 Measure device latencies 

 Configure the Light Path Manager 

 Use the Video Preview window 

 Carry out fast restoration 

 Set up and use the PerkinElmer UltraVIEW 

 Set up and use the OptiGrid. 

 Set up and use a motorized XY stage for multi-point acquisition. 

 

Please refer to “Volocity Acquisition Worked Examples” on page 148 for comprehensive instructions 
on carrying out single-point and multi-point acquisition and information about setting up specific 
acquisition protocols. 
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Installing and Configuring Devices  
1. Install your camera driver and camera (and frame grabber card, if applicable) according to the 

manufacturer’s instructions.    

2. Connect any further hardware (such as microscope, Piezo focus drive, OptiGrid, etc.) to your 
computer via the appropriate port. Serial devices can be connected directly to serial ports (COM 
ports) on your computer, if you have them, or via a Keyspan USB serial adaptor. 
Note: After installing a Keyspan USB serial adaptor or a major upgrade to the operating system, 
make sure the drivers for the adaptor are installed before connecting the serial devices. 

3. Ensure that all your hardware is switched on. 

Setting Preferences 
1. Start the application and select Preferences... from the Edit menu (Windows) or the Volocity menu 

(Macintosh). 

2. If you have connected serial devices to your computer, you must configure the serial ports. Click on 
the Serial Ports icon in the left-hand panel. If you have no serial devices connected, go to step 4.  

3. In the right-hand panel locate each device that is connected and select the appropriate port from the 
drop-down menu. Devices in the list that are not part of your imaging system may be ignored.  
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4. Click on the Devices icon in the left-hand panel.   

 
5. A list of devices that have been correctly connected to your computer will appear in the right hand 

panel. Each device has a subset of device controls that are listed beneath the device.  

To appear in the list: 

 Cameras and USB devices must be correctly connected to your computer and switched on 
before starting Volocity. 

 Serial devices must be correctly connected to your computer, switched on, and the appropriate 
serial port must be selected in the Preferences (see step 3).  

6. Carefully review all of the devices listed in the preferences; make sure that you scroll to the bottom of 
the list so that no devices are overlooked. If a device has an Options... button, you must click on the 
button to review the settings in the device’s setup dialog. If necessary, you should edit the device’s 
setup dialog. Failure to review and edit the dialog may result in difficulty using hardware. This may be 
due to incorrect labeling of devices, or because Volocity has not been given the information it 
requires to move the hardware accurately. See “Reviewing and Editing Setup Dialogs” below for 
some examples. 
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7. Select Show Video Preview from the Window menu. The devices and device controls that were 
selected in the Preferences are displayed on the right-hand side of the Video Preview window.  
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Reviewing and Editing Setup Dialogs  
Some devices may require only a single value to be entered into a text field. Some motorized stages, 
for example, will require that you enter the correct step size for the stage. 

 
Other devices may require more information to complete the Setup dialog, which should be 
completed in steps. For example, when completing the dialog for a filter wheel or fluo turret: 

1. Select the filter type for each filter position from the drop-down menus.  
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2. Enter details of the filters in the text fields. 

 
3. Name the filter in the description field. 

 
Provided that you carefully review and edit each of your device’s setup dialogs, each of your devices 
can be used easily and accurately with Volocity. Remember to select appropriate options from drop-
down menus and to carefully enter accurate information into text fields. 

Device Controls 
Using Device Controls  

Each device that you control with Volocity will have one or more controls with which you can interact. 
Volocity is compatible with several classes of devices from a number of manufacturers, so the 



VOLOCITY ACQUISITION INSTALLATION AND REFERENCE 

February 2008   131 

number and types of control present for each of your devices will vary. The list of controls below is 
general, different controls may be present on your system. 

To determine to which device a control belongs, move the cursor over the icon to the left of the 
control. The device name will be displayed in the tooltip.   

 
Many devices can be controlled from elsewhere, such as the microscope stand or the control box. In 
most cases, if you change the state or position of a device from elsewhere, the change will be 
displayed on the device’s control in Volocity. 

Double clicking a control’s icon is a shortcut to the control’s setup dialog. 

Button Arrays 

  
Each button in an array represents a different position for the device, for example different filter 
positions in a filter wheel. The button representing the current position of the device is shaded. Hold 
the cursor over a button to display a tooltip with a description of its position. Click on the button to 
move the device to that position. Filter wheels, fluo turrets, objective nosepieces and the light path 
manager are controlled by button arrays. 

Checkboxes 

 
Checkboxes allow you to control devices that only have two states, on and off. When checkboxes 
are selected the device is on, when deselected the device is off. Auto Contrast and Fast Restoration 
are examples of devices controlled with checkboxes. 
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Digital Displays 

 
Digital displays show the current value of a device as a number, usually representing the device’s 
current position. 

Exposure Controls 

 
The exposure control determines the length of time over which your camera will acquire an image. 
The hours, minutes, seconds and milliseconds components of the time are separated for clarity. To 
adjust the time click in one of the number fields and edit the number; you must click in another field 
or press the Return key for your change to take effect. You can also drag the exposure slider to 
make quick changes, the exposure time will automatically update. Use the drop-down menu to 
change the range. 

If you click the Auto exposure button, AE, exposure time will be automatically set.  

Focus Controls 

 
Focus controls display the current position of focus drives as a numeric value. As you change the 
position of the focus drive from the microscope stand the value will be updated. 
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Select the focus drive menu button to display the following options: 

Set Zero Sets the current position of the focus drive to 0µm. 

Set Top Sets the current position of the focus drive as the upper mark in 
the focus range. This range will be used during acquisition of 3D 
datasets. 

Set Bottom Sets the current position of the focus drive as the lower mark in 
the focus range. This range will be used during acquisition of 3D 
datasets. 

Reset Top/Bottom Resets the focus drive upper and lower marks to the default 
values of +50µm and –50µm respectively. 

Move to Zero Moves the focus drive from the current position to 0µm. 

Move to Top Moves the focus drive from the current position to the upper 
mark. 

Move to Bottom Moves the focus drive from the current position to the lower 
mark. 

Move to Hard Center Moves a piezo focus drive to the centre of its range of travel. This 
option is not available for non-piezo focus drives. 

Move To… Opens a dialog that allows you to enter the position to which the 
focus drive will move. 

Set Top To… Opens a dialog that allows you to enter the position to which the 
upper mark will be set. 

Set Bottom To… Opens a dialog that allows you to enter the position to which the 
lower mark will be set. 

Auto-Focus Initiates the Auto-Focus function of Volocity. Volocity will move 
the focus within the Auto-Focus limits to the position in which it 
detects the most in-focus information. 

Set Auto-Focus 
Limits… 

Opens a dialog in which you can set the Auto-Focus limits. 
Volocity will not move beyond the limits when executing the Auto-
Focus function. 
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Grid Controls 

 
There are three grid controls. From left to right: 

 Grid Off: Switches the grid off. There is a stationary grid pattern on the Video Preview and from 
the ocular lenses of the microscope. 

 Grid Confocal: Activates the grid. There is a confocal image on the Video Preview and a moving 
grid pattern from the ocular lenses of the microscope. 

 Grid Wide Field: Activates the grid. There is a wide field image (without grid lines) on the Video 
Preview and a moving grid pattern from the ocular lenses of the microscope. 

Numeric Spin Controls 

 
Numeric spin controls allow you to quickly increment or decrement the current value of the control by 
clicking on the arrows next to the number display. Camera binning is an example of a device 
controlled with a numeric spin control. 

Drop-down Menus 

  
Drop-down menus allow you to select from a number of options for a device. Click on the drop-down 
menu to see all of the options, and select the option you require. Camera depth and grid quality are 
examples of devices controlled with drop-down menus. 

Shutters 

 
Click directly on the shutter icon to change its state. Solid indicates shutter closed.  White indicates 
shutter open. 
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Sliders 

 
Sliders allow you to quickly set a device control anywhere between its maximum and minimum 
values. Hold the cursor directly over the slider to display a tooltip showing the current value of the 
control. Camera gain and offset are examples of devices controlled by sliders. 

Calibrating Objective Lenses 
In order to ensure that the data acquired with your Acquisition system is correctly calibrated in X and 
Y, each lens should be calibrated with a stage graticule.   

1. Place the graticule slide on the stage and focus on the scale divisions. 

2. Select the Calibration tool from the toolbar.  

 
3. Draw a line of known length on your Video Preview. Click and hold your mouse to start the line, drag 

the mouse to the endpoint of your line and release the mouse button.   
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4. Remember to draw from the left of your start division to the left of your end division, and make the 
line as long as possible to minimize the effect of drawing errors.  
 

 
5. Select Calibrate... from the Video menu or double click on the Calibration tool to open the calibrate 

window.              
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6. Enter line length in µm and click Calibrate. 

To confirm that your objective lens has been correctly calibrated, select Show Scale from the Video 
menu. You can then compare your scale bar to the calibration divisions. 

Repeat this process for every objective lens on your microscope. 

If you already know how many µm/pixel your camera has for your current objective lens, double click 
on the calibrate tool without first drawing a calibration line on the video preview. You will be able to 
enter the µm/pixel value directly into the Calibrate window. You should repeat this for each lens. 

Measuring Device Latencies 
You should use this option when you first install and configure Volocity and also whenever you attach 
new equipment or use different equipment. Volocity will measure the latencies of all computer-
controlled hardware on your system, which will allow Volocity to make intelligent decisions about 
closing shutters during acquisition. 

1. Select Measure Device Latencies from the Video menu to display the following prompt.    

 
2. Check that there are no samples and that your microscope is in a safe position (for example, check 

that your objectives will not collide with your stage if your objective turret is moved). Click Continue. 

When you have completed these steps your Acquisition system will be correctly configured and 
ready to use. 

Note: The latency measurements are noted in the Session Log. If you wish to know them, view the 
Session Log at the time of measurement.  
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Light Paths 
Configuring the Light Path Manager 

The Light Path Manager is above the device controls in the Video Preview window and allows you to 
configure up to nine different light paths and store them for future use.   

 
The Light Path Manager allows you to record the correct positions of all your automated hardware for 
each of your fluorescence filter combinations, as well as transmitted light paths. This greatly 
simplifies the use of your system and allows you to easily restore the correct light path manually 
(using the Video Preview window) or during acquisition. You can record the positions or settings of 
as many or as few devices as you require. For example, you may keep your light path simple and 
include the positions of only wavelength changing devices and shutters. Under some circumstances 
you may add other settings to the light path, such as your camera exposure or gain.  

1. Configure your hardware for a particular light path. For example, if you are setting a fluorescence 
light path and you are using an excitation filter wheel and a microscope fluo turret, ensure that they 
are in the correct positions for your fluorescence filter set of interest.   

2. Double click on an unused light path manager button. The Light Path Properties window opens. 
From the Devices list select those devices that you wish to include in the light path. Select the 
appropriate shutter positions for your light path from the drop-down menus in the Shutters list.  

3. Provide a Name for the light path and select a Color. The color will be used for the light path button, 
and to color channels acquired using the light path. If you are setting a transmitted light path, the 
color should be white. The Summary box provides a useful textual description of the settings that 
you have included in the light path.  

4. If the light path requires changes in the microscope setup that are not controlled by Volocity, for 
example moving a manual filter changer, check the box for Requires manual intervention. A 
message will be shown each time the light path is called prompting you to make the manual change.  
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In the following example we have set up the light path for a DAPI channel. We have saved the 
current positions of the Fluo Turret and Sutter DG4 Filter Changer in the light path. The Fluo Shutter 
and Sutter DG4 Shutter will be opened whenever the light path is restored. 

 
5. Click Save.  

6. Set up a separate light path for each fluorescence filter and transmitted light path that you will use on 
your system.  

Once you have configured your light paths, we strongly recommend that you hide the individual 
devices included in the light paths from the Video Preview. You should control these devices only 
with the Light Path Manager. This will make the system easier to use and make the Video Preview 
less cluttered.  
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In our example we have deselected the Fluo Turret, Fluo Shutter, Sutter DG4 Filter changer and the 
Sutter DG4 Shutter in the Devices preferences. The devices are still active, but we will use the Light 
Path Manager to control them. 

Note: We have also configured a light path that closes the shutters. 

 

Editing Light Path Settings 
You can easily edit a light path, for example if you want to use the same device settings but with a 
different camera exposure.  

1. Select the light path and change the camera settings on the Video Preview window. 
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2. Click and hold (Macintosh) or right-click (Windows) on the light path and select:  

 Overwrite to change the recorded settings to the current settings. 

 Edit… to open the Light Path Properties window. Select the additional devices from the Devices 
list and select Save, if you wish to add the positions or settings of additional devices to the light 
path.  

 

The Video Preview Window 
Open an existing library or create a new library and select Show Video Preview from the Window 
menu. 
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. 

Acquiring Images 
Create light paths to control the devices necessary to image in different channels and an acquisition 
protocol to manage an experiment. 

Contrast Enhancement 
Enhance contrast in the live video to reveal detail captured by the camera but not shown by the 
default display contrast.  Check Auto Contrast on the video controls to apply an automatic contrast 
setting which will adjust the black and white level of the display to the darkest and brightest captured 
intensity respectively. 

Alternatively manually set black and white levels of the video preview using the live enhancement 
tool. 

 
Select the live enhancement tool from the toolbar.  A histogram of the grey 
levels in the preview is displayed.  To adjust the white level click and drag the 
mouse to the left (to decrease) or to the right (to increase).  To adjust the black 
level, hold down Ctrl and click and drag the mouse down (to decrease) or up 
(to increase). Double click the icon in the tool bar to reset the contrast 
enhancement.  Select another tool from the tool bar to hide the display. 

When contrast enhancement is being applied an indication will be shown in the top left of the video 
preview image. 
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Zooming the Video Preview 
The Video Preview can be zoomed in or out. Select the Zoom tool and click on the Video Preview 
to zoom in. Click and hold the Ctrl key (Windows) or the  Alt key (Macintosh) to zoom out.  

A zoomed window can be scrolled from left to right or up and down using either the scroll bars or 
the window panning tool.  

Setting CCD Active Area 
Some combinations of optical components do not generate an image to fill the full CCD of the 
camera leaving margins around the images.  To avoid storing these set the CCD active area to 
exclude them. 

Select CCD Active Area... from the Video menu. 

 
Set margins to exclude or set the active area to the dimensions and position of an ROI which can be 
drawn on the video preview before selecting this dialog. 

Cropping the Video Preview  
The Video Preview can be cropped, so that smaller images will be acquired by Volocity. With 
some cameras cropping will provide a speed advantage.  This is also known as a sub array 
acquisition. 

 To crop the preview select the Crop tool, click and drag a crop boundary on the Video 
Preview.  Everything that you include within your crop boundary will continue to be updated on 
the Video Preview, everything outside the boundary is not updated. You can also crop the Video 
Preview to preset sizes by selecting Crop Video from the Video menu and selecting one of the 
options.  

 To restore the full resolution Video Preview, select the crop tool and click anywhere outside the 
crop boundary. 



The Video Preview Window 

 

144   Improvision 

Selecting an ROI on the Video Preview 
An ROI can be drawn on the Video Preview. With an ROI on the preview, only the area 
within the ROI will be used for the video feedback panel. 

 

To draw a region of interest on the Video Preview, select the ROI tool, click and drag your region of 
interest.  

Centering an XY Stage 
On a system that includes a motorized XY stage the centering tool will move the XY stage 
so that the point that the tool clicks on within the Video Preview is centered in the field of 
view.  

The stage and the objective must be calibrated for this tool to work correctly. 
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Video Feedback Panel 
Information on the gray levels in your Video Preview can be found in the Video Feedback panel, in 
the top right of the Video Preview window. The information can be displayed in four different modes, 
numbers, histogram, bar and Max Intensity graph mode.   

To toggle between the four modes, click on the Video Feedback panel. 

Numbers mode 

 

The Video Feedback panel displays the minimum and maximum 
gray level in the Video Preview, and the signal to noise ratio. 

Histogram mode 

 

The Video Feedback panel displays the distribution of gray levels 
in the Video Preview. The minimum gray level is displayed on the 
left of the histogram, the maximum gray level (which depends 
upon the bit depth of your camera) is displayed to the right of the 
histogram.  

Bar mode 

 

The Video Feedback panel shows the range of gray levels in the 
Video Preview. The length of the bar indicates how much of your 
camera’s dynamic range you are currently using. The longer the 
bar, the better your signal to noise ratio. 

Max Intensity graph mode 

 

The Video Feedback panel shows the maximum intensity of gray 
levels in the Video Preview or ROI over time. An update is made for 
each frame.  

 

If you have a color camera, you will see feedback for each of the three channels of your camera in 
addition to a luminance channel. 

Using Fast Restoration 
Volocity Acquisition supports Fast Restoration deconvolution. This option is available in the Video 
Preview window if you have purchased the Volocity Restoration extension product.  

Fast Restoration should only be used with single plane acquisition protocols. If you have multiple 
planes, you should capture them first and deconvolve them later using Volocity Restoration. 

Important: You must create or import a PSF for each channel that will be captured before you can 
set up the acquisition.  
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1. Make sure that Fast Restoration is selected in the Devices Preferences window.  

 
2. You can configure the settings from the Options… button or by double clicking on the Fast 

Restoration icon on the Video Preview window. 

3. Ensure that you have the correct PSFs for the channels that you wish to acquire in your Volocity 
library. 

4. Double click on the Fast Restoration icon.   
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The Fast Restoration dialog opens. 

 
5. Select a PSF for each channel that will be captured from the drop-down menus. 

6. Decide on the number of neighboring slices that will be included in the restoration algorithm and 
enter the value in Capture this many slices above and below field. The more neighboring slices 
you include, the longer the process will take. 

7. Select the appropriate focus drive from the Change focus using drop-down menu.   

8. Enter an appropriate value for Use this Z spacing. 

9. Select the appropriate option for Generate result using. 

  

Center Image displays only the deconvolved center image.   

Extended focus creates a single image by making a brightest-point merge of all the deconvolved Z-
slices of a volume. 

10. Click OK.  

11. Check the Fast Restoration box on the Video Preview window. The first time you do this after 
configuring the settings can take some time as Volocity applies the algorithm and generates the 
deconvolved image. 
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PerkinElmer UltraVIEW 
The UltraVIEW VoX is a complete system for live cell imaging using the CSU-X1 spinning disk head 
from Yokogawa. 

The system consists of:  

 CSU-X1 spinning disk 

 Emission filter wheel 

 Modular laser system 

 Piezo focus 

 CCD camera 

 Brightfield shutter 

 ProSync control box 

Optional accessories include the PhotoKinesis accessory and a motorized XY stage. 

How does the spinning disk illumination work? 
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UltraVIEW models 
All information refers to the use of Volocity with the UltraVIEW VoX only. 

Configuring the UltraVIEW in Preferences 
For the hardware of the spinning disk device to be correctly identified and controlled in Volocity it 
must be configured in the preferences. There are two devices which communicate with Volocity via 
serial ports: UltraVIEW Dichroic (within the CSU head) and the UltraVIEW Proscan II Controller. 

The following information assumes the hardware has been installed and aligned by a qualified 
PerkinElmer service engineer. These settings will also have been configured at installation but are 
provided here for reference. 

1. Select Preferences from the Edit menu (Windows) or the Volocity menu (Mac OS). Choose Serial 
Ports from the list. The serial ports detected on the system will be listed and to connect a device in 
Volocity its name must be selected against the port to which it is physically connected. 

 
2. Scroll to the Devices pane and select the controls to be displayed in the Video Controls panel. 

Devices unchecked in this list will not be seen in the Video Controls panel and therefore cannot be 
controlled from that view. 
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3. Next to the UltraVIEW item click Options... to configure the lasers present on the system. Select the 

UltraVIEW model from the list. Laser lines are not automatically detected. 

 
Check the box next to laser line(s) that are present on your system. The 488 nm laser is standard on 
all systems; therefore, this option will be checked and cannot be changed. 

4. Next to the UltraVIEW Focus Drive item click Options... to configure the range of travel for the piezo 
focus drive. 

 
For the objective piezo drive this distance is 100 micrometers. For the stage insert this distance will 
be 200 micrometers or 400 micrometers. Check the specification of your particular system. 

If the microscope focus is also controlled by Volocity it will have its own entry under the heading of 
the microscope. The piezo focus drive will be the fastest to use in experiments but the microscope 
focus might have a greater range of travel. Where both are available either may be chosen to acquire 
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stacks in the Acquisition Setup dialog, which is used to configure the experiment. See “Volocity 
Acquisition Worked Examples” on page 199 for examples of setting up this dialog. 

5. Next to the UltraVIEW Emission Wheel click Options... to configure the filters held in the wheel. This 
should be already configured correctly for a standard system. 

PhotoKinesis Accessory 
If the optional PhotoKinesis accessory is included in the system there will also be check boxes for 
the controls of that device. 

 
Click Options... to set laser power for bleaching. This dialog is also accessed from video controls 
while configuring an experiment. 
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Preparing to Use the UltraVIEW in Volocity 
In order to use the UltraVIEW with Volocity all hardware must be configured. 

 Components of the UltraVIEW which connect via the ProSync controller and serial ports must be 
connected, switched on and configured in the Volocity preferences. 

 Camera drivers must be installed, the camera connected and switched on. The camera will then 
be automatically recognized in the Devices list in the Volocity preferences.  

If using a motorized microscope that must be connected to a serial port on the computer, use the 
serial cable supplied by the manufacturer. If there are no spare serial ports, it may be necessary to 
use a serial adapter.  

Choose Show Video Preview... from the Window menu to see the image from the camera and the 
controls for the devices. 

To ensure images are correctly calibrated set calibrations for each lens position. Calibration is then 
applied to each image according to the lens in position when it is acquired. 

Light paths may be created for each of the laser lines to enable easy switching between excitation 
and emission wavelengths for different fluorochromes. It is advisable to create light paths using the 
Emission Discrimination mode of the UltraVIEW, and for each laser line set and store the laser line, 
filter wheel position and set the laser shutter to open.   
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These light paths will then work satisfactorily with both Emission Discrimination and Fast Sequential 
modes. Storing other settings with these light paths are a matter of personal preference and will vary 
depending on how the system is being used. See page 138 for information on configuring the light 
path manager. 

If the image generated by the confocal head does not fill the full field of view, adjust the CCD active 
area using CCD Active Area... dialog accessed from the Video menu. 

UltraVIEW Controls 
When the UltraVIEW is correctly configured in the preferences the following controls will be visible in 
the Video Controls.  Select Show Video Preview... from the Window menu to see these controls and 
the live video. 
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Discrimination Mode 

When experiments are carried out using multiple wavelengths two different methods of capture can 
be used: emission discrimination or fast sequential. 

Emission Discrimination mode will restore the emission filter wheel position associated with the light 
path. Changing the emission filter provides better discrimination between different dyes in one 
sample. The disadvantage of Emission Discrimination is a reduction in capture speed, due to the 
time taken for the emission filter wheel to turn from one position to another. 

In Fast Sequential mode the filter wheel is not moved during the experiment. Instead the wheel is 
automatically turned to the position containing the appropriate broadband barrier filter for the current 
dichroic to prevent laser breakthrough. Any emission filter wheel positions stored with light paths will 
be ignored in fast sequential mode. Fast sequential provides the highest capture speed,  as 
switching laser wavelengths is very quick. However, because the same broadband emission filter is 
used for all images, there is a increased risk of crosstalk between the emissions of different dyes.  

The emission filter wheel position must be stored in the light paths that are switched between by the 
acquisition protocol for emission discrimination mode to work correctly. 

Dichroic 

Switch between the dichroics installed in the CSU head using this pop-up. Some dichroics are only 
compatible with specific laser lines. This will be indicated in the interface as the lines that are not 
compatible with the current dichroic are grayed out. 

 

Laser Power 

One laser power slider will be shown for each line configured in the preferences. The higher the 
power used the more excitation light will be sent to the sample. This may increase the emission 
signal allowing shorter exposures to be used, however it will also lead to faster photobleaching and 
possible phototoxic effects. 
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PhotoKinesis Accessory 
Calibrating the PhotoKinesis Accessory 
1. Select FRAP Preview from the Window menu. 

 



PhotoKinesis Accessory 

 

156   Improvision 

2. Select Calibrate UltraVIEW PhotoKinesis Device… from the FRAP menu. 

The calibration wizard runs. 

 
3. Follow the instructions and the calibration will run automatically. A spot of laser light will be imaged 

and moved to all edges of the field to complete a coarse calibration.  The next step, fine calibration, 
requires a sample to image. This works best with a homogenous specimen such as ink from a 
highlighter pen, allowed to dry. Stick a coverslip over the dried ink to best reproduce the imaging 
conditions of the sample. 

 
4. When the specimen is in focus and the image is clear on the screen, click Next. 

 
5. To determine the laser power and number of cycles required to bleach the calibration sample it may 

be necessary to test bleach by drawing an ROI and using the Fire button to see whether the sample 
is bleached.   

 
6. Do not be concerned if the ROI and the resultant bleach area are not perfectly aligned, fine 

adjustment is performed in this step. Click Next. Volocity will bleach a specimen area and adjust 
accordingly. 
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7. Click Finish. The calibration is completed and you may wish to perform a test bleach. 

If the calibration is not able to run automatically you will be asked to adjust camera and laser settings 
to achieve a well-formed spot and to ensure that the spot is approximately centered in the field. The 
spot is formed by the laser light reflecting off the calibration mirror in the PhotoKinesis unit.   

Double click on the bleaching device icon  in the interface to access the dialog to insert attenuators 
and move the position of the spot in the X and Y axes.  

 
Click Finish. The calibration wizard will close and you may wish to test the calibration.   
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Testing Calibration 
1. Draw an ROI in the FRAP preview, using the ROI drawing tools from the toolbar. 

2. Click Fire and check the accuracy of the offset. If the region drawn is not matched by the bleached 
shape you may need to repeat the calibration process using different settings. 

  

 

OptiGrid 
The OptiGrid is an optical sectioning technology that, when combined with image analysis software, 
confers confocal capabilities to wide field microscopes. 

The OptiGrid consists of two pieces of additional hardware: 

 The OptiGrid paddle, which is inserted into the microscope’s fieldstop location and is connected 
to 

 The OptiGrid controller box 

The OptiGrid is based on a technique called “Structured Light” (Neil et al 97).   
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This technique modifies the illumination system of a microscope to project a grid pattern onto the 
specimen. The grid is moved into three different positions, and an image is acquired at each position. 
An algorithm is then used to produce a single, derivative, confocal image from which the grid pattern 
has been removed.  

The algorithm takes advantage of the fact that in-focus information changes as the grid moves, whilst 
out-of-focus information remains constant. Therefore, if information does not change between 
images, it is out of focus and can be removed from the final image. 

Please see the appendix on page 464 for more information about the algorithm and related 
publications. 

OptiGrid Models 
With some models of microscope, chromatic aberration problems have made it difficult or impossible 
to place the grid pattern in common focus for all excitation wavelengths in use. With earlier OptiGrid 
models, this restricted the range of excitation wavelengths that could be used together to acquire 
image sequences, and created a need for manual refocusing of the OptiGrid.   

The second-generation OptiGrid, sometimes referred to as the ‘Focusing OptiGrid’, incorporates a 
motor that enables it to be moved axially into different focal positions in the light path of the 
microscope. Once the correct focal position for an excitation wavelength is established it can be 
consistently and automatically restored. This extends the range of excitation wavelengths that can be 
sequentially acquired into a single image sequence. 

All OptiGrid models are supported in versions 4.1 or higher for Mac OS X and Windows.  

You need a free USB port in order to run an OptiGrid. 

Note: Manual focus models of the OptiGrid are connected via the Improvision Acquisition Hub.  

Connecting the OptiGrid 
Motorized Focus Model 

This section describes how to connect the OptiGrid model that includes motorized focus control. 

The following components are supplied with your OptiGrid and are required for installation: 

 OptiGrid paddle 

 OptiGrid controller box 

 USB cable 

 Focus motor cable 

 High voltage cable 
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1. The OptiGrid controller box has a high-voltage output. The OptiGrid controller box must be switched 
off before you connect the OptiGrid paddle using the power switch which is on the front of the 
controller box.  

2. Connect one end of the high voltage cable to the OptiGrid paddle and the other end to the Hi Voltage 
Output connector on the rear of the OptiGrid controller box.  

3. Connect one end of the focus motor cable to the OptiGrid paddle and the other end to the MOTOR 
connector on the rear of the OptiGrid controller box. 

4. Connect one end of the USB cable to the USB connector on the rear of the OptiGrid controller box 
and the other end to a spare USB port on your computer. 

 
5. If you have a field stop (field diaphragm) installed in you microscope, remove it from the field stop 

port.  

 

“Clickstop” 
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6. Install your OptiGrid in the field stop port. Your OptiGrid “In” position can be found by pushing the 
Optigrid into the field stop port until the “clickstop” engages. In this position the OptiGrid should be 
visible in the ocular lenses or with the camera when fluorescence images are observed. The “Out” 
position can be found by withdrawing the OptiGrid from the field stop port (disengaging the 
“clickstop”) until the grid is no longer in the light path, and no elements of the grid housing are in the 
light path. In this position the OptiGrid can be left in the field stop port.  

   
7. Switch on the OptiGrid controller box and start Volocity. The message “Connected to Volocity” will be 

displayed on the OptiGrid controller LCD display. 

8. You must now set up the OptiGrid for use with Volocity. This requires you to set up the Device 
Preferences in Volocity and calibrate the OptiGrid. See page 164. 

In Out 
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Manual Focus Model 
The manual focus model of the OptiGrid is connected via the Improvision Acquisition Hub to the 
computer system that is running Volocity.  

The following components are required for installation: 

 OptiGrid paddle 

 OptiGrid controller box 

 Improvision Acquisition Hub 

 Blue BNC-RF cable 

 
1. The OptiGrid controller box has a high-voltage output. The Acquisition Hub and the OptiGrid 

controller box must both be switched off before you connect the OptiGrid paddle using the power 
switch is on the front of the Acquisition Hub and the OptiGrid controller box.  

2. Connect the OptiGrid paddle to the OUT HI VOLT connector on the rear of the OptiGrid controller 
box. 

3. Connect the BNC-RF cable to the INPUT connector on the rear of the OptiGrid controller box and 
connect the other end of the BNC-RF cable to the OPTIGRID port on the rear of the Acquisition Hub.   

 
Note: this cable will fit if connected the wrong way around, but the OptiGrid will only work if the cable 
is connected in the orientation shown below. 

 

Acquisition hub  

connection 

Optigrid controller  

connection 
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4. If you have a field stop (field diaphragm) installed in you microscope, remove it from the field stop 
port.   

 
5. Install your OptiGrid in the field stop port. Your OptiGrid “In” position can be found by pushing the 

Optigrid into the field stop port until the “clickstop” engages. In this position the OptiGrid should be 
visible in the ocular lenses or with the camera when fluorescence images are observed. The “Out” 
position can be found by withdrawing the OptiGrid from the field stop port (disengaging the 
“clickstop”) until the grid is no longer in the light path, and no elements of the grid housing are in the 
light path. In this position the OptiGrid can be left in the field stop port.  

     
7. Switch on the Acquisition Hub and the OptiGrid controller box. The USB, PWR and RDY lights on the 

Acquisition Hub and the red light on the front of the OptiGrid controller should all be illuminated.  

NOTE: If the LEDs on the Acquisition Hub or OptiGrid controller fail to illuminate, check the cabling 
and make sure that none of the connecting pins are bent. For further information, see page 168. 

8. You must now set up the OptiGrid for use with Volocity. This requires you to set up the device 
preferences in Volocity and calibrate the OptiGrid. See page 11. 

In Out 

“Clickstop” 
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Setting Volocity Preferences 
1. Open the Volocity application.  

2. Select Preferences... from the Edit menu (Windows) or the Volocity menu (Macintosh). 

3. Click on the Devices icon in the left-hand panel. A list of devices that have been correctly connected 
to your computer will appear in the right-hand panel. Each device has a subset of device controls 
that are listed beneath the device.  

Motorized Focus OptiGrid Models 

Scroll through the list of devices until you find the Qioptiq Optigrid Controller.   

Check the box next to the Qioptiq Optigrid Controller, check the boxes for all of its associated 
devices. 
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Manual Focus OptiGrid Models  

Scroll through the list of devices until you find the Improvision Acquisition Hub.   

Check the box next to the Improvision Acquisition Hub, check the box next to the Grid Calibrator. 

 

Calibrating the OptiGrid 
It is important to focus the grid manually the first time that you calibrate. The information in this 
section applies to all OptiGrid models. 

In order to calibrate the OptiGrid you must have a uniformly fluorescent sample against which the 
grid can be imaged. Sealing a small amount of fluorescent ink between a slide and a cover slip can 
make an ideal calibration slide. Highlighter pens are an excellent source of such ink.  Alternatively, 
you can use the Qioptiq calibration slide. 

Calibration process 
1. Open Volocity and select Show Video Preview from the Window menu. 

2. Mount the calibration slide on the microscope and select an appropriate fluorescence filter. For 
example, blue excitation and green emission works well with yellow ink. 

3. Expose the calibration slide to the fluorescent light source. Calibration can be done with any lens but 
you will get better grid contrast with low power lenses.   

4. Use the microscope focus drive to focus on the fluorescent material. Air bubbles or the edge of the 
“inked” area make good reference points.  

5. Move to a field of view that is uniformly filled with fluorescent material. 

6. Move the OptiGrid to the “in” position in the microscope’s fieldstop location. 
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7. Adjust the aperture diaphragm on the microscope to improve the contrast if necessary. 

8. Direct all light to your camera and, if your camera supports it, select Auto-Exposure from the Video 
Preview controls (or the AE button). 
 

 
Note: If the exposure is low (<20ms), you may see grid lines in your grid confocal images due to 
lamp flicker. Avoid low exposures by reducing lamp intensity or using neutral density filters.  

9. Use the grid focus control to adjust the position of the OptiGrid until the image of the grid is 
maximally focused against the fluorescent material on the Video Preview.  

 
 

NOTE: With manual focus model of the OptiGrid you must use the “hex wrench” focusing tool to 
focus the grid. Insert the hex wrench in the middle of the three holes visible on the side of the 
Optigrid until it engages. Twisting the hex wrench tool changes the focal position of the Optigrid.  
Avoid using excessive force when focusing the OptiGrid as you can damage the grid focus 
mechanism when the grid has reached the limit of its movement. If significant resistance is met. you 
are likely to have reached the focus limit and should twist the hex wrench tool in the opposite 
direction. 
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10. It is important that the focus is consistent across the grid, see page 181. 

 
11. Select Calibrate Confocal Grid… from the Video menu. A progress bar is displayed as the OptiGrid 

is calibrated; this may take several minutes. 

 
12. The calibration of the grid is now complete and the calibration slide can be removed and replaced 

with the specimen that you wish to image.  
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OptiGrid Installation and Calibration Troubleshooting  
During calibration, you require an image where the focus is consistent across the grid. Here are 
examples of good and poor grid images. Note the high grid contrast in the good image: 

Good grid image Poor grid image 

If you are unable to focus your grid against your calibration slide, despite moving the grid through its 
full focus range, check the manufacturer of you fluorescence filter set. Filters manufactured by 
Semrock do not work with the Optigrid and should be avoided. 

Insufficient contrast warning or error 13901 during calibration (all models) 
These errors indicate that the grid is not consistently in focus or that the grid contrast is not high 
enough for imaging. To rectify this, follow these steps: 

1. Ensure that the grid paddle is in the light path. 

2. Turn off “Auto Contrast” if your camera supports this function. “Auto Contrast” can lead you to believe 
that grid contrast is better than it actually is. 

3. Use the microscope focus drive to focus on the calibration slide. 

4. Adjust the focus of the OptiGrid, using the Grid Focus Control (motorized focus OptGrid) or the hex 
wrench tool (manually focusing OptiGrid).  
It is important that the focus is consistent across the grid; use the focus adjustment to position the 
grid such that contrast is as consistent as possible. 

5. Repeat steps 2 and 3 to maximize the grid contrast. It can help to use the numerical readout of the 
minimum and maximum pixel values in the “Video Preview” window to do this. See page 141. 

6. Closing the aperture diaphragm will improve grid contrast. 

7. Reducing the excitation light intensity and increasing the camera exposure time may improve 
contrast. 
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8. Different objectives may give better contrast. Calibration is best performed with a good-quality Plan-
Apochromat air objective. 

Grid does not move during calibration (all models) 
During calibration the grid should move, first slowly in one direction, then more quickly in different 
directions.  If the grid does not move or the calibration fails with error 13902, follow these steps. 

Motorized Focus OptiGrid Models  

1. Switch off the OptiGrid controller. The OptiGrid controller must be switched off while connecting and 
disconnecting cables because it has a high-voltage output.   

2. Check that the cables are connected correctly. The OptiGrid paddle should be connected to the 
OptiGrid controller via two cables; one to the Hi Voltage Output connector and the other to the 
MOTOR connector on the OptiGrid controller. The host computer should be connected to the 
OptiGrid controller via a USB cable to the USB connector. 

3. Check both ends of the high-voltage cable and make sure that no pins are bent on the connectors. If 
a pin is bent, carefully bend it back into position with a small screwdriver. 

Manual Focus OptiGrid Models 

1. Switch off the OptiGrid controller and the Acquisition Hub. The OptiGrid controller must be switched 
off while connecting and disconnecting cables as it has a high-voltage output. 

2. Check cables are connected correctly. The OptiGrid paddle (or microscope connection) should be 
connected to the “hi volt” output of the black OptiGrid controller. The “input” on the OptiGrid controller 
should be connected to the “OptiGrid” port on the Acquisition Hub with the blue cable. Note that the 
blue cable is not a standard BNC-BNC cable; it is a BNC-RF cable. A standard BNC-BNC cable may 
physically fit, but will not work. 

3. Check that no pins are bent on the high-voltage output of the OptiGrid controller. There should be 
four pins, two in the OptiGrid controller socket and two in the grey paddle cable. If a pin is bent, 
carefully bend it back into position with a small screwdriver. 

   
There are four pins, two on each side of the connector 
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4. Check that no pins are bent on the low-voltage input of the OptiGrid controller. There should be two 
pins, one in the blue cable and one in the OptiGrid controller socket. If a pin is bent, carefully bend it 
back into position with a small screwdriver. 

  
There are pins on both sides of the connector – the ones in this picture are OK. 

5. Check that the pin is not bent at the Acquisition Hub end of the blue BNC-RF cable. 

 
6. Check that the “OptiGrid” socket on the Acquisition Hub is not damaged – it is possible for the central 

part of the socket to get distorted if the pin in the blue cable is not central. If the socket is damaged, it 
is normally possible to repair it using a pin to tease the metal parts of the socket back into place. 

 
This OptiGrid socket has been slightly damaged and the metal parts teased back into place.   

Compare with the Piezo Z socket on the left. 

7. Switch on both the Acquisition Hub and OptiGrid controller. The USB, PWR and RDY lights on the 
Acquisition Hub and the red light on the front of the OptiGrid controller should all be illuminated.  

8. Retry calibration. If calibration fails again, contact Improvision or the Improvision dealer that supplied 
your OptiGrid. 
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Using the OptiGrid 
Once you have calibrated the OptiGrid, you are ready to use it for acquisition.  If you intend to 
acquire multi-channel image sequences you may need to ensure that the grid is correctly focused for 
each of your excitation wavelengths. The worked examples in this chapter illustrate this process.   

Grid controls 

 
All versions of the OptiGrid have the grid mode controls. The focus and auto-focus controls are not 
available with manual focus models of the OptiGrid. 

Auto focus 
Click Grid AF to allow Volocity to auto focus the grid for you. Volocity will test a number of grid focus 
positions until it finds the position in which grid confocal images with the best contrast are generated. 
Auto focus will only work after your grid has been calibrated for the first time and provided you have 
a specimen mounted and in focus. 

Focus 
Use this control to adjust the focus position of the grid.  You can use this control as an alternative to 
Grid AF, or to fine tune the result of Grid AF.  

auto focus 

focus 

grid modes  
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Grid modes 
There are three grid mode controls. From left to right: 

 

 Grid Off: Switches the grid off. There is a stationary grid pattern on the Video Preview and from 
the ocular lenses of the microscope. 
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 Grid Confocal: Activates the grid. There is a confocal image on the Video Preview and a moving 
grid pattern from the ocular lenses of the microscope. 
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 Grid Wide Field: Activates the grid. There is a wide field image (without grid lines) on the Video 
Preview and a moving grid pattern from the ocular lenses of the microscope. 
 

 

Single-channel grid confocal images 
1. Open Volocity and select Show Video Preview from the Window menu. 

2. Mount your specimen slide on the microscope stage and select an appropriate fluorescence filter set. 

3. Expose the specimen slide to the light source and select a suitably powered lens.   

4. Move to the field of view that interests you. 

5. Ensure that the OptiGrid is in the “in” position in the microscope’s fieldstop location. 
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6. Direct all light to your camera and, if your camera supports it, select Auto-Exposure from the Video 
Preview controls (or the AE button). 
 

 
7. Set the Grid activation control in the Video Preview to Off. You should see clear horizontal lines 

superimposed on your specimen.  
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8. Click Grid AF to focus the OptiGrid automatically. Alternatively, use the grid Focus control to focus 
the OptiGrid.  

 
NOTE: With the manual focus model of the OptiGrid you must use the “hex wrench” focusing tool to 
focus the grid. Insert the hex wrench in the middle of the three holes visible on the side of the 
Optigrid until it engages. Twisting the hex wrench tool changes the focal position of the Optigrid. 
Avoid using excessive force when focusing the OptiGrid as you can damage the grid focus 
mechanism when the grid has reached the limit of its movement. If significant resistance is met, you 
are likely to have reached the focus limit and should twist the hex wrench tool in the opposite 
direction. 
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Note: You can also adjust the grid position whilst the grid is in “Grid Confocal” mode. As you move 
the grid, the signal-to-noise ratio of the grid confocal image will improve if the grid’s focus is improved.  

9. Set the Grid activation control to “Grid Confocal”. 

10. Change the slide or mount the slide in the first place. 

11. You are now ready to acquire grid confocal images or image sequences. 

After acquisition, remember to move the OptiGrid out of the microscope’s lightpath or ensure that the 
shutter is closed. If a light source is left on with the grid inserted but not moving, a grid image can be 
burnt into fixed samples which will cause gridlines. 
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Multi-channel grid confocal images (Motorized Focus OptiGrid) 
If you wish to acquire multi-channel grid confocal images, you must ensure that the grid is correctly 
focused for all of your lightpaths before acquisition.  See page 138 for more information about 
lightpaths. 

1. Open Volocity and select Show Video Preview from the Window menu. 

2. Mount the specimen slide on the microscope and select an appropriate light path.  

3. Expose the specimen slide to the light source and select a suitably powered lens.   

4. Move to the field of view that interests you. 

5. Ensure that the OptiGrid is in the “in” position in the microscope’s fieldstop location. 

6. Direct all light to your camera and, if your camera supports it, select Auto-Exposure from the Video 
Preview controls (or the AE button). 

 
7. Set the Grid mode control in the Video Preview to Off. You should see clear horizontal lines 

superimposed on your specimen. 

8. Click Grid AF to focus the OptiGrid automatically or use the grid focus control to focus the OptiGrid.  
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Note: You can also adjust the grid position whilst the grid is in “Grid Confocal” mode. As you move 
the grid, the signal-to-noise ratio of the grid confocal image will improve if the grid’s focus is improved.  

9. Double click on the current light path’s button. The Light Path Properties dialog opens. Scroll through 
the list of devices until you find Grid Focus.  



Using the OptiGrid 

 

180   Improvision 

Click on the Grid Focus check box to associate the current grid focus position with the light path. 

  
10. Repeat this process for each of the light paths that you wish to restore for your acquisition.  

11. Set the Grid activation control to “Grid Confocal”. 

12. You are now ready to acquire multi-channel grid confocal image sequences. 

After acquisition, remember to move the OptiGrid to the “out” position in the microscope’s fieldstop 
location or ensure that the shutter is closed. If a light source is left on with the grid inserted but not 
moving, a grid image can be burnt into fixed samples which will cause gridlines. 

Multi-channel grid confocal images (Manual Focus OptiGrid) 
With the manual focus OptiGrid it is not possible to associate different grid focus positions with each 
of your light paths. If your OptiGrid cannot be focused perfectly for each of your light paths, it may be 
necessary to find a compromise grid focus position in which an adequate image of the grid can be 
seen for all of your excitation wavelengths.  
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Adjusting the aperture diaphragm 
The position of the aperture diaphragm can have an important effect on the quality of your images; 
you should always carefully consider its position before and during any imaging sessions. Closing 
the aperture diaphragm tends to improve the contrast of the grid and, therefore, the contrast of the 
grid confocal images. Closing the aperture diaphragm also increases the exposure times of your 
images, so you should balance aperture position with acceptable exposure times.  

1. Select the grid confocal mode from the Video Preview controls. 
 

 
2. Adjust the aperture diaphragm on the microscope. 

3. Select Auto-Exposure from the Video Preview controls (you will see the grid lines while Volocity 
adjusts your exposure). 
 

 
4. Assess whether the quality of the image and the exposure time will meet your experimental needs. 

When you are happy with the position of the aperture diaphragm you can proceed with your 
acquisition of grid confocal images. Acquisition of image sequences can be done as normal, 
remember to select the grid confocal mode before starting acquisition.  

Troubleshooting Grid Imaging 
Once you become familiar with the way the grid is working, it becomes clear how artefacts may be 
generated.   

 Vibration may alter the grid movement and prevent it from moving to the correct position for each 
of the three raw images. 

 Inconsistent illumination or photobleaching can produce intensity differences between the raw 
images. The algorithm will extract artefactual data from these illumination differences and grid 
lines will appear in the final image. 

 A poorly focused (or out of focus) grid will produce little or no difference between the three raw 
images and a blank confocal image will be generated.  
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Little or no signal with the grid active 
The OptiGrid relies on the grid “marking” in-focus parts of the sample. If the grid contrast in the 
image is poor, no parts of the sample will be marked and little or no signal will be output. 

Recalibrating the grid will not improve the brightness of the grid image – calibration only removes 
gridlines. 

Note: Increasing the camera exposure time will not make the confocal signal brighter – the 
brightness of the confocal signal is determined purely by the contrast in the grid image. 

 

 

Good grid contrast 

 

 

Poor grid contrast 
  

To correct for this: 

1. Adjust the grid focus. First focus the sample with the grid off. Select “Grid Confocal” mode, then 
adjust the grid focus until the confocal signal is as bright as possible.   
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2. Adjust the imaging system to maximize grid contrast. Closing the aperture diaphragm to reduce stray 
light will help. 

3. It may be necessary to adjust the grid focus for different wavelengths (see page 171) and different 
objectives. 

4. Plan-Apochromat objectives will give better results with multiple wavelengths. 

Gridlines in image 
Gridlines in the image are caused by the three raw grid images not quite lining up with each other. 
There are several possible reasons for this: 

1. Poor calibration. If gridlines appear, try recalibrating the grid. The grid calibration can change as the 
grid and microscope heat up in use. Recalibration will correct for this. 

2. Vibration can cause grid lines. Isolate the microscope with an anti-vibration table if possible. 
Equipment containing fans (e.g. camera controllers and light sources) must be isolated from the 
microscope (e.g. by moving them onto a separate table or onto the floor). 

3. Uneven or unstable illumination will cause gridlines. Use a stable light source that offers even 
illumination. If flicker is a problem, attenuate the light using ND filters and increase exposure times. 

4. If the light source is left on with the grid inserted but not moving, a grid image can be burnt into fixed 
samples which will cause gridlines. Ensure that the fluorescence shutter is closed when possible or 
that the grid is left running. 

5. Fast bleaching samples may show gridlines more than slow bleaching samples. To solve this, reduce 
the light intensity and increase exposure times. 

6. Camera noise will be amplified by the OptiGrid process and will show as gridlines. Avoid using high 
camera gain with the OptiGrid. 

Once these factors are eliminated, recalibrate the grid. 

Installing and Configuring Photonics Instruments MicroPoint 
Volocity supports the Photonics Instruments MicroPoint Ablation Laser Unit as a bleaching device. 

http://www.photonic-instruments.com/ 

Before you use the MicroPoint high-intensity laser unit for the first time with Volocity it must be 
calibrated. You must calibrate the laser again should the laser unit be rotated relative to the 
microscope, if the camera is moved relative to the microscope, if the dye cell is changed, or if the 
microscope’s objective lens is changed. 

Connect the Ablation Laser Unit to the microscope, as instructed in the Photonics Instruments 
documentation.  

Connect the MicroPoint control box to the computer via a free USB port. 
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Although the MicroPoint control box connects to Volocity via a USB connection it will function as a 
“Virtual COM Port” (VCP).  In order for this to work you must download and install the driver 
appropriate for your operating system from http://ftdichip.com/Drivers/VCP.com 

1. Open Volocity and select Serial Ports from the preferences. 

2. Set the usbserial-ELCBXAV5 port to the MicroPoint. 

 
3. Select Devices from the preferences. 

4. Ensure that all of the MicroPoint devices are selected. 

 

Calibrating Photonics Instruments MicroPoint 
Make sure that the laser unit is horizontal (relative to the microscope) before you start, focus and 
align the laser as described in the Photonics Instruments documentation. 

Ensure that your “Laser Safety Filter Block” is always in the light path when using the MicroPoint 
laser. 

1. Mount your mirror slide on the microscope with the reflective surface nearest to the objective lens. 
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2. Select Show FRAP Preview from the Window menu. 

3. Switch on your transmitted light lamp. 

4. In order to focus on the mirror’s surface you should search for a scratch or pit on the surface and 
focus the microscope on that. 

5. Direct all light to the camera and adjust the camera exposure time if necessary. 

6. Ensure that any shutters in the laser’s light path are open. 

7. Select Calibrate MicroPoint… from the FRAP menu. 

8. The MicroPoint Calibration wizard is opened. 

9. Click Fire. 

  

10. The MicroPoint laser is fired. If the laser is correctly focused on the mirror a hole will be cut in the 
mirror’s reflective surface allowing transmission of light and creating a spot. If you are unhappy with 
the shape and size of the spot, adjust the focus or the intensity of the laser and click Fire again.  
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11. Once you are happy with the size and shape of the spots, click Next. A line of holes is fired onto the 
mirror. Adjust the rotational position of your camera so that the line is horizontal relative to the FRAP 
preview.  

Tip: You may find it easier to judge whether the line is horizontal, if you move it (using the stage) 
higher up or lower down the Preview window where you can align it with the top or bottom of the 
screen.  
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12. Click Next to calibrate the laser. A diagonal line of holes is fired across mirror. 

 
13. Click Finish. The calibration wizard will close. 

14. You should now check the result: use one of the ROI tools to draw a region of interest on the 
Preview and click the MicroPoint Fire control within the video controls. The cut area should 
correspond exactly to the ROI. If this is not the case repeat the calibration procedure. 

FRAP Acquisition 
Volocity provides full support for observing and analyzing the movement of intracellular materials 
after photobleaching of fluorescence. It supports both Fluorescence Recovery after Photobleaching 
(FRAP) and Fluorescence Loss in Photobleaching (FLIP) analysis. 

FRAP Acquisition and Analysis functionality are provided by the FRAP plugin. This is an additional 
module available for purchase which extends the functionality of Volocity Acquisition to add features 
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specifically for FRAP acquisition and extends the functionality of Volocity Quantitation for analysis of 
data acquired with the FRAP acquisition.   

The FRAP plugin requires both Volocity Acquisition and Volocity Quantitation to function. 

Preparing a FRAP Experiment 
Mount your specimen and expose it to your low intensity light source. 

1. With your specimen in focus ensure that the all light is directed to your camera. You should see your 
specimen in the Video Preview. Adjust the camera controls until you are happy with your image. 

2. You may wish to observe your specimen for a while to see whether you have an acceptable level of 
photobleaching from your low intensity light source, using the live intensity plot should help you make 
this judgment. If you make adjustments to your light intensity, remember to adjust your camera 
settings. 

3. If possible, adjust the intensity of your bleaching device to the correct level. You should aim for 
maximum photobleaching without damaging or excessively heating your specimen. 

4. When you are happy with the intensity of both your low intensity light source and bleaching device 
move to a new (unexposed) area of your specimen. 

 
Select the Freeze button. Any shutters associated with your currently selected light 
path will be closed. The last frame previewed before the shutter was closed will be 
retained in the FRAP Preview. 

5. With the FRAP Preview frozen you can set the bleaching area for your experiment without 
photobleaching your sample. ROIs are used to mark bleaching areas. Use any ROI tool to draw an 
ROI or restore an ROI by selecting ROI then Restore… from the Edit menu. To set an ROI of a 
particular size we recommend the use of the ROI stamp tool.  
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Preparing for FRAP Acquisition 
FRAP Acquisition is a plugin to Volocity Acquisition.  If you are not yet familiar with Volocity 
Acquisition we suggest that you consult that part of the guide first. 

Before you start your FRAP experiment: 

 Install and configure all devices that you wish to use for your FRAP acquisition. 

 Select Show FRAP Preview from the Window menu. 

1. Calibrate each objective lens, if they are not already calibrated. 
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2. Configure any light paths that you require for FRAP acquisition. You will need one light path for each 
of the channels that you're going to image during the experiment.  

 

The FRAP Preview 
This section describes features that are specific to the  FRAP Preview window or are of particular 
relevance to the FRAP Preview window. Details of more controls that are common to the FRAP 
Preview and the Video Preview are described on page 141. 

To display the FRAP preview select Show FRAP Preview from the Window menu. 
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 Laser unit controls. These may differ depending upon the type of bleaching device that you are 

using. 

 Live Intensity plot. This live plot shows the mean intensity of ROIs (or the mean intensity of the 
whole image if no ROIs have been selected).  Prior to acquisition the mean intensity of all ROIs 
are shown in a single plot, during acquisition the mean intensity of each ROI is plotted individually. 
The Intensity plot is useful for assessing the level of photobleaching from the low intensity light 
source before acquisition, for adjusting the intensity of the high intensity light source, and for 
monitoring the progress of your experiment during acquisition. 

 The Freeze button. This allows you to “freeze” the Preview when you find an area of interest. 
Any shutters associated with the current light path are closed to prevent photobleaching, but the 
last frame prior to closing the shutter is retained in the Preview. This allows you to select ROIs 
(bleaching areas) without illuminating your specimen, reducing photobleaching. 

The FRAP Preview also provides additional ROI drawing tools to those available in the Video 
Preview. In the FRAP preview ROIs are used to mark regions that will be bleached during FRAP 
experiments. The additional tools provide greater flexibility when setting a bleaching area. 
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Creating a FRAP Acquisition Protocol 
1. Select Acquisition Setup… from the FRAP menu. 

 
2. The FRAP Setup dialog opens. 

 
3. If you wish to restore one or more light paths for your pre-bleach and recovery phases, click on 

the  Change channels using light paths check box. If you wish to acquire more than one channel 
for these phases click on the “+” button to add more light paths. Select the appropriate light paths 
from the drop down menus. The same light paths will be used for both the pre-bleach and recovery 
phases of your acquisition.  
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4. If you want Volocity to set the exposure for each of your light paths check Use auto exposure for 

each channel.  

5. Select the bleaching device that you wish to use for the experiment from the Bleaching device to 
use drop down menu. 

 
6. Select the light path that you wish to use for the bleaching phase of the experiment from the 

Bleaching device light path drop down menu.  You may need to select a light path that is different 
to the light path you have selected for the pre-bleach/recovery phases of your experiment. Doing so 
is likely to increase the time taken to acquire your first frame following bleaching so we recommend 
that you try to avoid changing light paths between bleaching and recovery phases.   

 
7. Select a shutter management option from the Manage shutters for drop down menu. 

 
8. In, Acquire pre-bleach images for, specify the duration and the frame rate of the pre-bleach period. 
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9. In Acquire recovery images for, set the duration and frame rate of the recovery phase.   

You may wish to set a very high frame rate for initial recovery period, but slow down the acquisition 
as your recovery approaches plateau in order to reduce photobleaching of your specimen. This can 
be achieved by setting a number of recovery phases.  

 
To add an additional recovery phase click the “+” button. Set the duration and acquisition rate of the 
new phase. You may add up to six different recovery phases as to your protocol. To remove a 
recovery phase click on the “-“ button. 

In the example shown above an initial recovery period of ten seconds in which images are acquired 
at maximum speed is followed by a sixty second phase in which images are acquired every four 
seconds, which is followed by a final recovery period of sixty seconds in which images are acquired 
every 10 seconds. 

10. Set the Number of bleach/recovery cycles. This will usually be set to 1 for FRAP experiments. With 
the number of cycles set to 1 the protocol will finish after completing the recovery phases. You may 
wish to repeatedly bleach your specimen, for FLIP experiments for example. With the number of 
cycles set to greater than 1 the bleaching and all of the recovery phases will be repeated. Note: the 
pre-bleach phase is never repeated. 

11. When you are happy with your protocol click OK.  

12. Click on the “Capture” video control to apply the acquisition protocol that you have just set up. (A 
Volocity library must be open to store the image sequence that you acquire; you will be prompted to 
open one, if necessary.) 

Volocity will carry out the pre-bleach phase, fire the bleaching device according to its configuration 
and continue with acquisition of the recovery images. 
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When acquisition begins ROIs change to colored “Bleach areas”, the intensity within a “Bleach area” 
is plotted in a matching color on the live intensity plot.  

If you have set multiple ROIs on the Preview, which become multiple “Bleaching areas”, each is 
given its own color and plot when acquisition begins.  
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You can study the intensity of the bleached areas in the live intensity plot over the course of the 
recovery. When the protocol comes to an end the preview will be automatically frozen so that the 
final image of the recovery and the intensity plot can be reviewed. The plot and the FRAP preview 
will be overwritten when the preview is “unfrozen”.  

Your bleaching/recovery data is stored as an image sequence in your Volocity library, a channel is 
recorded for each of the light paths that you selected for the pre-bleach/recovery phases. Volocity 
also adds a template channel which records the positions of your bleach areas for analysis. Areas 
within the bleach area have a value of zero in the template channels, areas outside the bleach area 
have a value of 255. Volocity also records the time of the last frame before bleaching, and the first 
frame following bleaching as meta-data for analysis purposes. The experiment time is set to zero at 
the end of the bleaching phase, any frames acquired before this will have negative time stamps. 
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Data acquired with Volocity FRAP acquisition may be analyzed using the Volocity FRAP analysis. 

FLIP Acquisition 
FLIP is a technique that is also possible with the FRAP plugin.  An image sequence making up a 
FLIP experiment consists of three elements: 

 a bleached area 

 a bleached area that contains labeled molecules of interest that may be free to enter and leave 
the bleached area.  The experiment is to determine whether the molecules are moving between 
the two bleached areas and at what rate. 

 A control cell or region of interest from a compartment that is not connected to the bleached 
areas in any way 

1. Select Show FRAP Preview from the Window menu.  

2. Mount your specimen and expose it to your low intensity light source. 

3. With your specimen in focus ensure that the all light is directed to your camera. You should see your 
specimen in the Video Preview. Adjust the camera controls until you are happy with your image. 
You may wish to observe your specimen for a while to see whether you have an acceptable level of 
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photobleaching from your low intensity light source, using the live intensity plot should help you make 
this judgment. If you make adjustments to your light intensity, also adjust your camera settings. 

4. If possible, adjust the intensity of your bleaching device to the correct level.  You should aim for 
maximum photobleaching without damaging or excessively heating your specimen. 

5. When you are happy with the intensity of both your low intensity light source and bleaching device 
move to a new (unexposed) area of your specimen. 

6. Select the Freeze button. Any shutters associated with your currently selected light path will be 
closed. The last frame previewed before the shutter was closed will be retained in the FRAP preview. 

7. With the FRAP preview frozen you can set your bleaching area for your experiment without 
photobleaching your sample. ROIs are used to mark bleaching areas. Use any ROI tool to draw an 
ROI or restore an ROI by selecting ROI then Restore… from the Edit menu. To set an ROI of a 
particular size we  recommend the use of the ROI stamp tool.  

8. Select Acquisition Setup… from the FRAP menu and set up the acquisition protocol.  

 
In this example, the bleach and recovery phase is repeated 10 times. Two images are acquired 
during the recovery phase, one immediately following the bleach and a second a minute after the 
bleach. Click OK. 

9. The acquisition protocol is now stored and can be run by clicking the capture button on the FRAP 
preview. 

10. The pre-bleach images are acquired only once, but the bleach and recovery will be repeated, in this 
case 10 times. These images may then be measured using the standard measurement tools in 
Volocity. An example of this is described in “FLIP Analysis” on page 423.



VOLOCITY ACQUISITION WORKED EXAMPLES 

February 2008   199 

Volocity Acquisition Worked Examples 

Overview 
Volocity Acquisition allows you to acquire single or multi-channel, 2D, 3D or 4D image sequences at 
a single position or at multiple XY points. Before you start acquisition of your image sequences you 
must configure the Video Preview window and the Acquisition Setup window. Once these steps are 
complete you can repeatedly execute your acquisition protocol. 

This chapter describes how to set up Volocity to carry out single-point and multi-point acquisition and 
summarizes required settings for different acquisition protocols. 

It assumes that you have installed and configured your acquisition device(s) correctly, and set up any 
additional options, such as Fast Restoration, that you require for your experiment. 

For comprehensive installation, configuration and reference information about Volocity Acquisition 
see the separate chapter starting on page 120. In particular, you may like to review the two sections 
that describe the Video Preview window, page 141, and how to control devices, page 130. 
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Single-Point Acquisition Process  
The following steps describe all options available during single-point acquisitions. 

You only need to set up those steps that are appropriate for your acquisition protocol.  

1. On the Video Preview window, select the appropriate timelapse option. You can change the 
timelapse option at any time during an acquisition. If you wish to acquire only a single timepoint, you 
can ignore the timelapse options.  

For example, to acquire one timepoint every 10 seconds, select Seconds per Timepoint from the 
drop-down menu, and enter 10 into the text field.   

                

If you wish to acquire images at the fastest possible rate, select Maximum Speed, Volocity will then 
acquire the images at the fastest rate supported by your hardware. 

2. If you wish to capture a single plane only, ignore the focus drive options and go to step 3. If you wish 
to capture a number of Z sections within your specimen, you will need to set the range through which 
the focus drive will move in the focus interface in the Video Preview.   

 

First, move to the midpoint of your specimen using the focus 
control of your microscope. 

Select Set Zero from the focus drive drop-down menu on the 
Video Preview window. 

Move to the lower limit of your specimen using your 
microscope focus drive and select Set Bottom from the 
focus drive drop-down menu.  

Move to the upper limit of your specimen using your 
microscope focus drive and select Set Top from the focus 
drive drop-down menu. 
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3. Select Acquisition Setup… from the Video menu.   

Or double-click on the acquisition protocol feedback display on the Video Preview window.  

 

 
4. Enter a Title, User Name and Description. The Title will be used to name the images that you 

acquire; both the User Name and Description will be stored with the properties of the image.  

Complete the dialog by selecting the appropriate settings for your acquisition protocol. 

acquisition protocol feedback display 
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5. Change channels using light paths 

If you wish to acquire a multi-channel sequence check the Change channels using light paths box.  

 
Add or remove channels using the “+” and “-” buttons and select the correct light path for each 
channel by clicking on the drop-down menus. 

If you wish to acquire a channel at a rate different to other channels (for example, you may wish to 
acquire a fluorescence or brightfield reference image periodically), click on the timing icon. The 
Channel Timing dialog opens. Select the Acquire a new frame for this channel every: option, and 
enter the new frame rate.   

 
A warning symbol is displayed on the Acquisition Setup dialog next to the channels that will not be 
captured at the normal rate. 

During timepoints in which a channel is not acquired the last timepoint that was acquired will be 
duplicated. 

click to set timing 

click to add channel 

click to remove channel 

click to select light path 
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Auto-Exposure 

If you wish Volocity to perform an Auto-Exposure for each channel, check the Use Auto-Exposure 
for each channel box. With this option selected, Volocity will perform an Auto-Exposure at the 
midpoint of your specimen for each of your channels before starting the acquisition.   

Changing the exposure between channels reduces the speed of the acquisition protocol and should 
be avoided for speed-critical acquisition. Often a compromise exposure that is adequate for all 
channels can be found. 

6. Change focus using 

If you are acquiring multiple Z sections, select the appropriate device from the Change focus using 
drop-down menu and enter either the Z spacing that you require or the number of slices that you 
require.    

 
Using the Z spacing option Volocity will calculate the number of slices required to move through the 
range between the top and bottom positions as configured in the Video Preview. If the Z spacing is 
not a factor of the range, an additional slice will be captured. 

Using the number of slices option Volocity will calculate the spacing between slices required to 
capture that number of slices within the range between top and bottom. 

The scan direction option allows you to select between: 

 Up: This is the recommended option; it moves the focus device against gravity for the most 
accurate positioning. 

 Down: This option moves the focus device with gravity. 

 Bi-Directional: This option alternates the up and down direction of focus movement. This may 
minimize disturbance of the system by avoiding the relatively large movement otherwise required 
to return the focus to its starting position. 

7. Auto-focus using 

Select a focus device to use for auto-focus during the experiment. 
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Auto-focus operates by seeking the highest contrast image when sampling within a range in the z-
axis. This range is set in the focus drive settings on the Video Preview window. 

 
Using auto-focus will reduce the speed of acquisition by the time taken to determine the best plane to 
image. 

Choose the frequency to apply auto-focus by configuring the timing options. 

 
If you are using auto-focus and planning to acquire a Z stack around the position determined by the 
auto-focus, the setting of top and bottom positions in the focus drive settings become vitally 
important. Each of your acquisition points will be treated as zero, regardless of its actual Z value.  So 
the distance between zero and your top and bottom position will be the same as the distances 
between each of your points and their top and bottom positions (see the tables below for 
examples). You can quickly check what values are set for top and bottom by inspecting the focus 
drive tool tip. 
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Top and Bottom marks with top set to 5 and bottom set to -5 

Position (Z) of 
acquisition point 
(µm) 

Bottom mark 
for acquisition 
(µm) 

Top mark for 
acquisition 
(µm) 

0 -5 5 

10 5 15 

20 15 25 

30 25 35 

 

Top and Bottom marks with top set to 10 and bottom set to –10. 

Position (Z) of 
acquisition point 
(µm) 

Bottom mark 
for acquisition 
(µm) 

Top mark for 
acquisition (µm)

0 -10 10 

10 0 20 

20 10 30 

30 20 40 

 
If you wish to change the top and bottom positions, use the commands in the focus drive drop-down 
menu, as described in step 2 of this section. 

Note: You should avoid re-setting the zero value of your focus drive after setting your acquisition 
points. If you do so, you will invalidate the Z coordinates stored with each point. 

8. Change XY using 

Set to None for single-point acquisition.  
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9. Duration 

 
If you wish to acquire multiple timepoints, select either Until stop is clicked (Volocity will acquire 
data until it is manually stopped) or select For, enter a number into the text field and select either 
“timepoints”, “ms”, “seconds”, “minutes” or “hours” from the drop-down menu. 

If you wish to acquire a single timepoint, select For, enter “1” into the text field, and select 
“timepoints” from the drop-down menu. 

10. Order channels and Z sections by 

If you are acquiring both multiple channels and multiple Z sections you must decide in which order 
Volocity will acquire your images.   

 
There are two options in the Order channels and Z sections by drop-down menu.   

The Channels first then Z option acquires all channels at each Z section before the Z section is 
changed. This option has the advantage of acquiring all channels at precisely the same Z section, 
but may be slow with a slow wavelength changing device. 

The Z first then Channels option acquires all Z sections for each channel before the channel is 
changed. This option has the disadvantage of introducing potential inaccuracies in Z positions 
(depending upon the reproducibility of your focus drive), but it does allow acquisition protocols to be 
conducted at high speed, even with relatively slow wavelength changing devices. 

11. Manage shutters for  

 
These options determine how Volocity will manage the shutters between channels and timepoints. 
Volocity uses the latency threshold measurements for each device in the light path to determine how 
it will control the shutter. You must have measured your device latencies for this option to work 
effectively, see page 137.  

12. When you have set up the necessary acquisition parameters, click OK.  
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13. With your specimen in focus ensure that the light path is directed to your camera. You should see 
your specimen in the Video Preview. Adjust the camera controls until you are happy with your image.  

A good starting point is to select the Auto-Exposure (AE) button (if this feature is supported by your 
camera); Volocity will automatically adjust the exposure of your camera. Fine adjustments of both the 
exposure and other camera controls can then be made. 

 
14. Click the appropriate Capture button on the Video Preview window.  

 
The image is given the name that you entered in the acquisition Setup window followed by a number. 
All images and image sequences acquired by Volocity are automatically saved to your hard disk.  
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Saving Acquisition Protocol Settings  
1. Click Save…on the Acquisition Setup dialog 

 
2. Enter a descriptive name for your acquisition protocol and click Save. 

 
Note: You can also use this dialog to export settings, for example, if you wish to share those settings 
with a colleague. 
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Restoring Acquisition Protocol Settings 
1. Click on Restore… on the Acquisition Setup window to display a list of saved acquisition protocols.  

 
2. Select the protocol that you wish to restore and click Restore. 
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XY Stage, Multi-Point Acquisition Process  
This section describes how to use Volocity to carry out multi-point acquisition using a motorized XY 
stage.  

There are several steps to this process: 

 Set up and calibrate the XY stage.  

 Create overlays and scans. 

 Find specimens of interest and record their positions as “Acquisition Points”. 

 Set up the acquisition protocol and capture the image sequences. 

Set Up and Calibrate the XY Stage 
The XY stage must first be configured as a device in the preferences. See page 126. 

Note:  Each time you start Volocity or turn the stage controller on, and are planning to use the two 
together, calibrate the stage.  

1. Select Stage Setup… from the Stage menu.  

 
2. Select the appropriate XY Stage Device and correct Focus Device from the drop-down menus. The 

focus drive that you select here will be used to store the positions of your acquisition points; you may 
use a different focus drive for your acquisitions. 

3. Use the checkboxes to set the X and Y axes correctly and click Save. 

4. Clear the stage area and select Calibrate Stage… from the Stage menu.  
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5. At the warning prompt, check the stage area is clear. When you are satisfied that neither your 
specimens nor your microscope (in particular your lenses) will be damaged by large stage 
movements, click Continue. Volocity moves the stage to the bottom right and top left positions to 
establish the full range of travel and current position of the stage relative to the range of travel. 

 

XY Stage View 
Once the stage is calibrated, Volocity provides a choice of views: the XY Stage view and the live 
Video Preview (described on page 141). In the XY Stage view the green area represents the full 
working area of the stage. The gray crosshairs represent your current position on the stage.   

If you move the stage manually you will see the position of the crosshair change to reflect the 
movement; the X and Y coordinates of the stage will also be updated. You can quickly move the 
stage by selecting the ROI tool (Shortcut key, R) and double clicking on the point on the XY Stage 
work area to which you want the stage to move.   

Note: The shortcut key R selects the ROI tool. 

A small Video Preview is displayed in the bottom left hand corner of the XY Stage view. This allows 
you to navigate around the stage whilst seeing the current Video Preview. The Video Preview can be 
moved to any corner of the XY Stage view. To move the Video Preview to another corner of the XY 
Stage view, click and drag the video preview to its new location. 
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You can toggle between the views by selecting the required view from the Video menu or by using 
the shortcut keys. 

 On a Mac:  
Shift+Apple+L for live video  
Shift+ Apple+X for XY stage 

 On a PC:  
Ctrl+Shift+L for live video  
Ctrl+Shift+X for XY stage 

 

Stage working area 

Video Preview 

stage X and Y 
coordinates 

You may click and drag the 
preview to another corner 
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Adding Overlays 
You can add overlays to your XY Stage view that will allow you to easily and quickly navigate around 
your culture vessels or slides.  

1. Select Make Well Overlay… from the Stage menu. 

   

2. Select the type of slide or culture vessel from the drop-down menu and click Create… Volocity now 
provides a wizard which guides you through the steps for setting the position of the XY stage. 

In our example, we are making an overlay for a multi-well plate. 

3. At each step of the wizard, move the stage to the requested position and click Next. 
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After the last requested setting has been entered, the wizard closes and an overlay is shown on the 
XY Stage view. Again, the cursor shows the current position of the stage. 

  

Once you have set up the overlay you can: 

 Move to a specific well. Select the ROI tool and double click within a well to move quickly to that 
well. 

 Select individual wells or groups of wells to work with. Use the ROI tool to select the required 
well(s) and select Disable Selected Wells/Enable Selected Wells from the Stage menu, as 
appropriate. 

current 
position of 
XY stage 
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The following example shows three wells disabled. 

 

Saving and Restoring Overlays 
To save overlays select Save Overlay… from the Stage menu. Enter a descriptive name for the 
overlay in the dialog that opens and select Save. 
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To restore a previously saved overlay select Restore Overlay… from the Stage menu. Select the 
overlay that you wish to restore from the list and select Restore. The overlay will be displayed in the 
XY Stage view. 

 

Adding Points 
Before adding acquisition points, we recommend that you focus on your specimen and select Set 
Zero from your focus drive drop-down menu (if you have more than one focus drive in your imaging 
system ensure that you reset the focus drive that you will use for your acquisition protocol).  

 
 You can add points manually or ask Volocity to create random points for you. 

Manually Adding Points 

1. Move the stage to the area of interest and focus on your specimen. You can do this by screening 
your specimen using your microscope’s ocular lenses, or by using the Video Preview in Volocity to 
scan your specimen.  
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2. Select Add point from the stage menu or use the shortcut key: 
On Mac: Shift+Apple+A 
On PC: Ctrl+Shift+A 

3. Move the stage and continue to add points manually, as required. 

4. The point is shown as a cross on the XY Stage view. The X, Y and Z co-ordinates are recorded with 
the point and displayed next to the point (you may have to zoom in to see the coordinates).  

 
Creating Random Points 

1. Select Create Points from Well Overlay from the Stage menu. 

 
2. Select Multiple Random Points from the drop-down menu to add single acquisition points to 

random positions within each enabled well. Select Multiple Tiled Points from the drop-down menu 
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to add a matrix of multiple points at the centre of each well. Specify the required number of Points 
per well. 

3. Click Create… 

 

Inspecting and Editing Points 

1. Use the ROI tool to double click on a point. This moves the stage and focus drive to the X, Y, and Z 
position of the point. You can use the Go to Next Point or Go to Previous Point commands or their 
shortcuts from the Stage menu to cycle through your points. 

2. If you change the focal position of a point, select Update Point from the Stage menu.  

3. If you have created a lot of points, use the Review Points… command on the Stage menu. The 
Review Points Wizard opens and takes you to each stored point.  

 
4. At each point you can review and edit the focal position. The current focal position when you select 

Next in the wizard will be stored with each point.   
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Saving and Restoring Points 

To save a set of acquisition points, select Save Points… from the Stage menu. Enter a descriptive 
name for your points in the dialog that opens and select Save. 

 
To restore previously saved acquisition points select Restore Points… from the Stage menu. Select 
your points from the list and select Restore. 

 

Scanning 
Note: Always make sure that the lenses are calibrated accurately and that the camera head is 
positioned squarely on the microscope before scanning. We also recommend that you enable 
binning on your camera prior to scanning; this will allow Volocity to scan fields of view more quickly.  

You can set up scanning areas in three ways. You can scan regions of interest, whole wells from 
overlays, or you can scan acquisition points.  

Scanning Regions of Interest 

Set a region of interest by selecting the ROI tool, clicking and holding the mouse, and dragging out a 
region of interest on the XY Stage view. 

You can also set an ROI in several steps by moving the stage to opposite corners of your ROI. 

 Move the stage to the top left hand corner of you region of interest and select  Set ROI Top-Left 
from the Stage menu. 

 Move the stage to the bottom right-hand corner and select Set ROI Bottom-Right from the Stage 
menu. 

Once you have set a region of interest, select Scan Selected Area from the Stage menu. 
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Scanning Enabled Wells 

After making an overlay and ensuring that only the relevant wells are enabled, select Scan Enabled 
Wells from the Stage menu. Volocity will scan all fields of view within the enabled wells. 

  

Use the zoom tool to zoom on scanned areas. This will help you to find areas of interest in your 
specimen.   

Note: The shortcut key Z selects the zoom tool. 
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Scanning Acquisition Points 

After you have added your acquisition points (see page 216) select Scan Points from the Stage 
menu. Volocity will scan your specimen and acquire a field of view for each of your acquisition points. 

 
Capture snapshots of scanned areas by selecting Capture Snapshot from the Stage menu. Each 
well that you have scanned will be captured as a separate snapshot. 

Note: The shortcut key F5 captures a snapshot. 
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Set Up and Run the Acquisition Protocol  
 After storing points in the stage area an acquisition protocol is used to image the points as required.  

1. Select Acquisition Setup… from the Video menu or double-click on the acquisition protocol 
feedback display on the Video Preview window.   

 You must select the appropriate focus drive and XY stage from the drop-down menus. 

 The focus drive that you select for acquisition may be different from the focus drive that you 
selected to store the positions of acquisition points (see page 216). This will allow you to move 
between acquisition points with a microscope focus drive, and to capture Z series with a piezo 
drive. 

 Make other choices for change channels, duration, image order and shutter management as 
appropriate. 

 

Focus drive 
drop-down  

XY Stage  
drop-down  

Auto-focus 
drop-down 
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2. Auto-Focus  

If you want Volocity to auto-focus on your points during the acquisition, select the light path that you 
wish to use for auto-focusing from the drop-down menu. 

If you choose to auto-focus during the acquisition, you can also set timing options by 
selecting the “timing” icon. 

 

You may choose to auto-focus at each point, or at each well. If you choose to auto-focus at each 
point, each point will have its own focus point. If you choose to auto-focus for each well, all the points 
within a well will share a common focus point. 

 
You may also choose to auto-focus for every timepoint, to only auto-focus for the first timepoint, or to 
auto-focus periodically. 

3. If you have chosen to acquire multiple Z planes during your experiment, you now need to ensure that 
the top and bottom focus limits are set correctly. 

Each of your acquisition points will be treated as zero, regardless of its actual Z value.  So the 
distance between zero and your top and bottom position will be the same as the distances between 
each of your points and their top and bottom positions (see the tables below for examples). You can 
quickly check what values are set for top and bottom by inspecting the focus drive tool tip. 
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Top and Bottom marks with top set to 5 and bottom set to -5 

Position (Z) of 
acquisition point 
(µm) 

Bottom mark 
for acquisition 
(µm) 

Top mark for 
acquisition 
(µm) 

0 -5 5 

10 5 15 

20 15 25 

30 25 35 

 

Top and Bottom marks with top set to 10 and bottom set to –10. 

Position (Z) of 
acquisition point 
(µm) 

Bottom mark 
for acquisition 
(µm) 

Top mark for 
acquisition (µm)

0 -10 10 

10 0 20 

20 10 30 

30 20 40 

 
If you wish to change the top and bottom positions, use the commands in the focus drive drop-down 
menu. 

Note: You should avoid re-setting the zero value of your focus drive after setting your acquisition 
points. If you do so, you will invalidate the Z coordinates stored with each point. 

4. Make sure a Volocity library is open and run the acquisition. If you have not set the top and bottom 
positions either side of zero, you may get the following warning.  
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We recommend that when this warning is generated you stop the acquisition and check your top and 
bottom positions. In situations where the top and bottom are a long way from zero there is a danger 
that the focus drive may move long distances during the acquisition. This may result in damage to 
your microscope or specimen. 

Volocity visits each acquisition point and conducts your acquisition protocol. The number of times 
Volocity visits each point is determined by the duration option that you set with the protocol, the 
frequency is determined by the time lapse option that was set on the Video Preview window. 

Each acquisition point has its own image sequence. All the image sequences from a single multi-
point acquisition are organized within a folder in your library. 

 

Capturing Image Sequences 
Click the capture button to acquire an image sequence using the current acquisition protocol.  

Once capture has started a red dot is shown on the Video Preview and the capture button changes 
to a stop button.  

 
Click the capture button to acquire an image sequence using the current acquisition 
protocol. 

 
Once capture has started a red dot is shown on the Video Preview and the capture 
button changes to a stop button. 

Note: The shortcut key F6 starts/stops the acquisition. 



Capturing Image Sequences 

 

226   Improvision 

 

If you have configured your acquisition protocol to acquire a fixed number of timepoints, the protocol 
will stop when the correct number of timepoints has been acquired. If you wish to stop the protocol 
before the end is reached, or if you have chosen the Capture until stop is pressed option, you 
must click the Stop icon on the Video Preview window.  

You may re-run your acquisition protocol by selecting the Capture icon as many times as you wish. 

Pause Acquisition while Capturing  

 
You may pause acquisition by selecting the pause button during acquisition of an image 
sequence. 

Any timepoints that have been partially acquired when you select pause will be completed before the 
acquisition is paused. Once partially acquired timepoints are completed no further acquisition will 
take place until the acquisition is resumed. 

While acquisition is paused the pause button is highlighted and the red record icon in the top left 
corner of the Video Preview window changes to a gray pause icon. 

 To resume acquisition click on the highlighted pause button.  

 To stop acquisition whilst paused click on the capture/stop button. 

If a timepoint is overdue when you resume acquisition, it will be acquired immediately and at the time 
intervals that you have specified in the time-lapse options thereafter.  

Freeze the Video Preview 

 Freeze the image being shown in the Video Preview.  This has two effects: 

 When viewing a live image, an acquisition protocol is not running. Freezing the preview will leave 
the last captured frame visible on the screen but will close any shutters associated with the 
current light path. This allows an image to be viewed and evaluated without exposing the sample 
to further illumination light. 

 When an acquisition protocol is running, freezing the preview will not affect any of the settings 
controlled by the protocol but the preview will not update with each captured frame. This 
maximizes the resources available to the acquisition and can improve performance. 

While the Video Preview is frozen, the snowflake icon and the text “Preview frozen” will be shown in 
the top left-hand corner. 
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Acquisition Feedback  
The acquisition protocol feedback panel provides a graphical summary of the current acquisition 
protocol.  Double clicking on the acquisition protocol feedback panel opens the acquisition setup 
dialog.  

 
Multiple timepoints 

 
Multiple timepoints and multiple Z sections 

 
Multiple timepoints, multiple Z sections, and multiple channels 

 

A more detailed summary is displayed in the acquisition feedback panel tooltip (move the cursor over 
the LCD display to see the tooltip). 

 

Click on the number in the timing feedback panel to toggle between the feedback modes. The 
display changes to show: 

 

the elapsed time 

 

the number of elapsed timepoints 

 

the remaining time 



Events and Logs 

 

228   Improvision 

 

the number of remaining timepoints 

 

the time until the next timepoint 

Note: If Capture until stop is clicked was selected in the Acquisition Setup window, the 
Remaining option will display the approximate time or timepoints remaining until your hard disk is full. 

Events and Logs  
If something happens while observing acquisition that you wish to record, click on the Event flag.  

 

 

 

Note: The shortcut key F7 creates an event. 

Enter the appropriate text to identify the event and click Create.  

 
The text will be stored in the Experiment Log of the image sequence.  

click to record event during acquisition 
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All of the image sequences that you acquire with Volocity Acquisition will have an Experiment Log 
View, which can be displayed by selecting the Experiment Log tab.   

The settings that were used for acquisition and any events that you recorded during acquisition are 
recorded in the Experiment Log.  
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Example Acquisition Protocols 
Acquiring a Single Frame 
1. On the Video Preview controls no timelapse options are required.  

2. Adjust the camera settings until you are happy with the image.  

3. On the Acquisition Setup window enter information fields only and click OK. 

 

4. Click the capture single image icon on the Video Preview window. 
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Acquiring a Single Channel over Time 
1. On the Video Preview controls set up timelapse options.  

2. Adjust the camera settings until you are happy with the image. 

3. On the Acquisition Setup window, enter information fields and: 

 Ensure that Change channels using light paths is not 
selected.  

 Set Change focus using to None.  

 Choose the Duration for the experiment. 

 Set the Shutters. 

  

4. Click the capture image sequence icon on the Video Preview window. 



Example Acquisition Protocols 

 

232   Improvision 

Acquiring Multiple Channels over Time 
1. On the Video Preview controls set up the timelapse options.  

2. If you wish to use the same exposure for each channel, ensure that the 
Auto Contrast option has been selected in the Video Preview window. 

3. If you wish to manually set exposures for each channel ensure that they are included in your light 
paths. 

4. On the Acquisition Setup window, enter information fields and: 

 Ensure that Change channels using light paths is selected. Add the correct number of 
channels. 

 Set Change focus using to None. 

 Enter a number in the Duration section and set the units. 

 Set the Shutters. 

 

5. Click the capture image sequence icon on the Video Preview window. 
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Acquiring a Single Channel at Multiple Z-Planes and Single Timepoint  
1. On the Video Preview controls no time lapse options are required.  

2. At the midpoint of your specimen adjust the camera settings until you are happy with the image.  

3. Set up the Top and Bottom values for the focus drive. 

4. On the Acquisition Setup window enter information fields and: 

 Ensure that Change channels using light paths is not selected 

 Select the appropriate device from the Change focus using drop-down menu and set an 
appropriate Z spacing 

 Set the Duration = 1 timepoint 

 Set the management of Shutters. 

 

5. Click the capture image sequence icon on the Video Preview window. 
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Acquiring Multiple Channels at Multiple Z-Planes and Single Timepoint 
1. On the Video Preview controls no timelapse options are required.  

2. If you wish to use the same exposure for each channel, ensure that the Auto Contrast option has 
been selected in the Video Preview window. This will ensure the optimum contrast settings to assist 
setting one exposure for all channels. 

 
3. If you wish to manually set exposures for each channel ensure that they are included in your light 

paths. 

4. Set up the Top and Bottom values for the focus drive. 

5. On the Acquisition Setup window enter information fields and: 

 Ensure that Change channels using light paths is selected.  Add the correct number channels. 

 Select the appropriate device from the Change focus using drop-down menu and set an 
appropriate Z spacing. 

 Set the Duration = 1 timepoint. 

 Select the appropriate option from the Use this ordering for channels and Z sections drop-
down menu. 

 Set the Shutters. 
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6. Click the capture image sequence icon on the Video Preview window. 
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Acquiring a Single Channel at Multiple Z-Planes Over Time 
1. On the Video Preview controls set up the timelapse options.  

2. At the midpoint of your specimen adjust the camera settings until you are happy with the image. 

3. Set the Top and Bottom values for the focus drive.  

4. On the Acquisition Setup window enter information fields and: 

 ensure that Change channels using light paths is not selected 

 select the appropriate device from the Change focus using drop-down menu and set an 
appropriate Z spacing 

 enter a number in the Duration section and set the units 

 set the Shutters. 

 

5. Click the capture image sequence icon on the Video Preview window. 
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Acquiring Multiple Channels at Multiple Z-Planes Over Time 
1. On the Video Preview controls set up the timelapse options.  

 
2. If you wish to use the same exposure for each channel, ensure that the Auto Contrast option has 

been selected in the Video Preview window. 

 
3. If you wish to manually set exposures for each channel ensure that they are included in your light 

paths. 

4. Set the Top and Bottom values for the microscope.  

5. On the Acquisition Setup window enter information fields and: 

 Ensure that Change channels using light paths is selected. Add the correct number of 
channels. 

 Select the appropriate device from the Change focus using drop-down menu and set an 
appropriate Z spacing. 

 Enter a number in the Duration section and set the units 

 Select the appropriate option from the Use this ordering for channels and Z sections drop-
down menu. 

 Set the Shutters. 
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6. Click the capture image sequence icon on the Video Preview window. 
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Spectral Separation 

Overview 
Spectral separation is a technology that allows the separation of images containing data from more 
than one fluorophore into channels that contain data from only a single fluorophore. In order to 
achieve this separation or “un-mixing”, sample images must be acquired at a minimum of two 
different wavelengths. Color cameras lend themselves naturally to this multiple wavelength sampling 
because they simultaneously sample at three different wavelengths (red, green and blue). However, 
multiple wavelengths can just as effectively be acquired using monochrome cameras and 
wavelength changing devices such as filter wheels. 

Why Separate Color Images? 
Acquiring a single color channel instead of separate blue, green and red channels is an effective 
means of reducing acquisition time. You may still wish to analyse each of the fluorophores in your 
experiment in a single monochrome channel. Spectral separation will allow you to acquire the data 
for up to three fluorophores into a single color channel and separate each fluorophore into its own 
monochrome channel post-acquisition. 

Why Separate Monochrome Images? 
Spectral separation can be used to un-mix the contribution of spectrally overlapping fluorophores 
from a series of grayscale images sampled at different wavelengths (lambda stacks). You can 
therefore improve the separation of dyes that you have found difficult to separate adequately by 
more conventional means using filter sets. 

Lambda stacks can be composed of a series of images in which the excitation wavelength is 
constant and the emission wavelength is changed, reflecting the shape of the emission wavelengths 
of fluorophores. Alternatively, the emission wavelength can be constant and the excitation 
wavelength changed, reflecting the shape of the excitation wavelengths of fluorophores. It may also 
be possible to successfully un-mix fluorophores from Lambda stacks in which both excitation and 
emission wavelengths are varied. 

There should be a minimum of two channels in a Lambda stack. The maximum number of 
fluorophores that can be separated from a lambda stack is equal to the number of images in the 
lambda stack. 



Creating Spectral Signatures from Color Images 

 

240   Improvision 

Creating Spectral Signatures from Color Images 
In order to accurately separate your fluorophores into individual channels you must first create 
accurate spectral signatures. A spectral signature allows Volocity to calculate how a sample of only a 
single fluorophore contributes to the red, green and blue elements of color images. 

To generate a spectral signature: 

 First prepare a sample that contains only a single fluorophore.  

 Acquire an image or image sequence of the sample.  

 Open your image or image sequence in the Image View and select a region brightly stained with 
your fluorophore with a region of interest tool, such as the magic wand tool. You should ensure 
that no pixels in this region are saturated. 

 
1. Select Create New from the Actions menu. 
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2. Select Spectral Signature… 

 
3. The Create Spectral Signature dialog opens. 

 
4. Volocity will assign a sample color and perceived peak wavelength to your new spectral 

signature. Give the spectral signature a meaningful name and click OK to create the signature. 

5. Spectral signatures are added to your library. 

 
6. You may inspect a spectral signature by double clicking on its library item. 

 
You should make a spectral signature for each of the fluorophores that you wish to include in your 
experiments. You can un-mix up to three fluorophores in each experiment. 
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Creating Spectral Signatures from Monochrome Images 
Successful spectral separation is dependent on the creation of accurate spectral signatures. A 
spectral signature allows Volocity to calculate how a single fluorophore contributes to each point of a 
lambda stack.    

To generate a spectral signature: 

 First prepare a sample that contains only a single fluorophore.  

 Acquire a lambda stack of the specimen into an image sequence.  

 Open your image or image sequence in the Image View and select a region brightly stained with 
your fluorophore with a region of interest tool, such as the magic wand tool. You should ensure 
that no pixels in this region are saturated. 

 
1. Select Create New from the Actions menu. 
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2. Select Spectral Signature… 

 
3. The Create Spectral Signature dialog opens. 

 
4. Enter a name for your spectral signature and click OK. 

5. Spectral signatures are added to your library.  

 
6. You may inspect a spectral signature by double clicking on the library item. 

You should make a spectral signature for each of the fluorophores that you wish to include in your 
experiments. 
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Separating Color Images 
In order to accurately separate each of the channels from your color image, Volocity will need to 
calculate the contribution made by background. This can be done automatically or you can select a 
region of interest that contains only background. Volocity can calculate the background directly from 
this region of interest or you can create a background spectral signature, which you may re-use if 
your background is consistent between multiple image sequences. To make a background spectral 
signature: 

 With your region of interest selected, select Create New then Spectral Signature… from the 
Actions menu.  

 Give the background spectral signature a name and click OK. 

1. Select an image or image sequence of a multiply (two or three fluorophores) labeled color specimen.  

2. Select Separate Spectra… from the Tools menu. 

 
3. In the Separate Spectra dialog select the spectral signatures of the fluorophores in your color image 

from the drop-down menus. Each of the spectral signatures in your library will be listed in the drop-
down menus. 
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4. Select one of the Calculate background from radio buttons. 

 If you want Volocity to automatically calculate the background, select the Default background 
radio button. 

 If you have made a background spectral signature, select the This spectrum radio button and 
select your spectral signature from the drop-down menu. 

 If you have specified a region of interest containing only background, choose the Current 
Selection radio button. If your image sequence is time resolved, the background will be 
calculated from the first timepoint only unless you select the Recalculate for each timepoint 
checkbox. 

 
When you select Recalculate for each timepoint the background is recalculated for every timepoint 
from the same region of interest. You must be certain that your region of interest always contains 
only background (and that no objects of interest stray into your region during the course of the time 
series). 

5. Click Separate. 

New channels based on your selected spectral signatures will be added to your image 
sequence. The new channels are monochrome and are colored based on the color of the spectral 
signature from which they were derived. 
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If you un-mix a color image, new monochrome images will be added to a folder of images beneath 
your original image. 

Separating Monochrome Images (Lambda Stacks) 
Acquire lambda stacks of specimens labelled with the combination of fluorophores that you wish to 
separate. You must acquire your experimental specimens at exactly the same wavelengths and 
relative exposures as your spectral signatures. 

In order to accurately separate each fluorophore into its own channel from your lambda stacks, 
Volocity will need to calculate the contribution made by background. This can be done automatically 
or you can select a region of interest that contains only background. Volocity can calculate the 
background directly from this region of interest or you can create a background spectral signature, 
which you may re-use if your background is consistent between image sequences. To make a 
background spectral signature: 

 With your region of interest selected, select Create New then Spectral Signature… from the 
Actions menu.  

 Give the background spectral signature a name and select OK. 

1. Open an image sequence in the image view. 

2. Select Separate Spectra… from the Tools menu. 

3. In the Separate Spectra dialog select the spectral signatures from the drop-down menus of the 
fluorophores that you wish to un-mix from your lambda stacks.  
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 The number of drop-down menus will be equal to the number of images in your lambda stacks.  

 Each menu contains a list of all the spectral signatures in your library that were derived from 
lambda stacks containing the same number of images as the image sequence that you wish to 
un-mix. 

 If you have over-sampled (i.e. the number of images in each lambda stack is greater than the 
number of fluorophores in your experiment) then you may leave some of the drop-down menus 
as the default (No spectrum).  

 
4. Select one of the Calculate background from radio buttons. 

 If you want Volocity to automatically calculate the background, select the Default background 
radio button. 

 If you have made a background spectral signature select the This spectrum radio button and 
select your spectral signature from the drop-down menu. 

 
 If you have a region of interest containing only background selected (in the image view) choose 

the Current Selection radio button. If your image sequence is time resolved the background will 
be calculated from the first timepoint only unless you select the Recalculate for each timepoint 
checkbox. 

 
 When you select the Recalculate for each timepoint, the background will be recalculated for 

every timepoint from the same region of interest. You must be certain that your region of interest 
always contains only background (and that no objects of interest stray into your region during the 
course of the time series). 
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5. Click Separate. 

New channels, based on your selected spectral signatures, will be added to your image 
sequence. The new channels will contain only information from a single fluorophore.   
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Volocity Visualization 

Overview 
Volocity Visualization includes a renderer that provides a versatile range of rendering modes for 
different sample types, allowing interactive rendering of 3D and 4D data, and a Slice View that allows 
reslicing of image data in any orientation. Once you have activated this set of features you will have 
an additional view of image data, the 3D View. These views, like all other Volocity views, have their 
own specific menu and tools. 

Note: Volocity Visualization is an additional product that must be purchased separately. See page 35 
for more information about activating additional products purchased to expand your system. 

Specific recommendations are made for the graphics cards. These are detailed in the System 
Requirements technical note 263. This technical note will be updated as new graphics cards become 
available and are tested.  

If the installed graphics card does not meet this specification, or the required modules (called HR 
Rendering and IP Rendering, which performs HR Intensity Rendering) are absent from the Volocity 
modules folder, the Classic 3D Renderer will load.  

When you select a 3D View, Volocity calculates a projection—a screen image of how the volume 
appears from a specific viewpoint—using direct rendering from the 2-dimensional data. The speed of 
the rendering engine allows you to interact with the volume on screen to view it from different angles 
and/or use different rendering methods. The intense computation required is carried out as you 
interact with the rendered view and the Renderer Controls in the Navigation palette.  

Types of Renderer 
There are different renderers within Volocity, their availability depends on the license purchased for 
the system and the hardware configuration. There is a section on each Renderer in this chapter. The 
Renderers differ in the features supported and the style of rendering that is used. 

 Purchasers of Volocity Visualization Lite will have the HR Intensity Renderer. 

 Purchasers of the full Volocity Visualization license will have both the HR Opacity and HR 
Intensity Renderers. 

HR Rendering is a perspective rendering, whereas 3D Rendering is orthographic. In HR Rendering 
zooming into a volume allows movement into that volume rather than continuing to magnify the 
voxels. The HR Renderer can also display feedback from rows selected in a Measurements session 
(you will need both the Volocity Visualization and the Volocity Quantitation modules).  

Some systems support a choice of renderers and have an additional choice of Ray Tracer, which is 
a software renderer. 
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Movie Sequencer 
Volocity Visualization also includes the Movie Sequencer, which allows you to create and store a 
volume animation template that can be applied to any Rendering View to create a series of pictures 
for export as an AVI or QuickTime movie file. 

Bookmarks and Movies 
Bookmark and Movie panes of the 3D View allow you to store volume positions and then animate 
transitions between bookmarks. 

Slice View 
The Slice View allows 3D or 4D data to be viewed at a different orientation of slicing and, if required, 
that data may be re-sliced to create another version of the data at the new orientation. 

The Slice View is available with the full Volocity Visualization licence only. 

3D View  
Select the item that you wish to view in 3D, or render and double click to open it. 

1. Click on the 3D tab. If the item is part of an image sequence, Volocity will render all the channels for 
the timepoint at once.  

2. Creating the rendered view for the first time may be a lengthy process, depending upon the volume 
and complexity of the data. A progress bar is displayed as Volocity renders the volume.  

 
3. A 3D View will be opened. There is more detail on the individual Renderers used to produce the 

image shown on the screen in the relevant sections. 
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The following example shows a view generated by the HR Intensity Renderer. 

 
 

Once you have created the rendered 3D View you can use the tools in the toolbar to work with the 
image and the Navigation palette to adjust Renderer settings and play through the channels. When 
using HR Renderers Volocity displays a progress bar in the top left-hand corner of the view as it 
applies any changes that you make. Select Reset View from the Renderer menu to reset any values 
applied to the Renderer Controls from the Navigation palette. 

Note: When Volocity renders a volume, it stores sufficient information in its cache memory so that it 
can display the rendered volume quickly when you switch between different types of view. The cache 
is saved with the library. If you are moving the data or sending it to another user, you may like to use 
the Compact Library command, with the option to remove cached data enabled, to delete this 
information and reduce file size. See page 60. 

Using Contrast Enhancement with 3D Views  
Changes made using the Contrast Enhancement dialog (Tools menu) are carried through into the 3D 
View. Remember that it is possible to alter the black point, white point and gamma of a dataset using 
the Contrast Enhancement and this will affect the appearance in the rendered view. 

a progress bar will 
be displayed here 
as you work with 
rendered data 



3D Menu 

 

252   Improvision 

3D Menu 
Whenever a 3D View is active, the view specific menu will be called 3D and it contains controls that 
allow you to show/hide elements of the view and apply special effects.  

 

Renderer 
If available, this option allows selection of the rendering style. This choice is only available if using 
Volocity Visualization. 

Stereo 
This option allows selection of a stereo mode of viewing which will generate the image so that it is 
viewed with specialized glasses to emphasize the 3D appearance.  

Show/Hide Floor 
A floor is shown below the object in the 3D View to emphasize the orientation of the object. Hide 
Floor becomes Show Floor when the floor is not visible. Use the View Options to change the 
position and appearance of the floor. 

Reset View 
This option resets the orientation of the object to the default position applied when the data is first 
seen in the 3D View. 

Always Show Ball 
This option always displays the graphical ball which is used to move the object around in the view. 
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Show/Hide Scale 
Scale is shown using a grid behind the object. The grid moves to stay behind the object as it is 
rotated. The distance represented by each square in the grid, the calibration information, is shown in 
the bottom right corner of the screen. 

Use the 3D Scale tab in the View Options… dialog to change the color of the scale grid and switch 
calibration information on or off. 

Show/Hide Orientation 
Orientation is a marker to identify x, y, and z axes. This multicolored pointer is shown in the bottom 
left hand corner of the view 

Capture Snapshot 
This option creates a 2D image of the view as it currently appears. This image may then be exported. 

Create QTVR Movie... 
This option creates a specialized movie which can be viewed using a QuickTime player. Rather than 
playing back frames through time, different orientations of the view are captured and viewers of a 
QTVR movie may manipulate the object themselves within the limits of range of movement set when 
making the movie. QuickTime must be installed on the system for this option to be available. 

Show/Hide Time 
Select Show Time from the 3D menu to display the volume timestamp. Change the color of the 
timestamp or frame time in the View Options. 

View Options 
Use the View Options… command to change the setup of the 3D View. The dialog is tabbed for 
different settings. 

In the General tab change the background and/or floor color. Using different colors for these can 
improve the visibility of details in the data being rendered. Floor position and also pattern can be 
changed. The 3D Scale tab changes how the scale grid is drawn. 

Show/Hide Bookmarks 
This option shows or hides the interface area for storing bookmarks. Other menu items are for 
creation, editing and navigation between bookmarks. 

Show/Hide Movie 
This option shows or hides the interface area for designing movies. Other menu items are for editing 
and saving movies. 
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3D Toolbar 

 

 
Use the three library navigation tools at the bottom of the toolbar to navigate through 
items in the library without making the Library view active.  

 
 

Shortcut key R  

Use this tool to rotate the object. A ball outlines the object and the pointer changes to 
a hand when you position it on the object. When you let go, the object spins around 
the pivotal point (see next page for example). Use Alt-click (Mac) or Ctrl-click (PC) 
and drag to zoom. 

 
Shortcut key F  

Click once on this tool to fly around the object.  

 
Shortcut key Z  

Click with this tool and drag to zoom in and out.  

 
 

Shortcut key H  

Use this tool to move the rendered object within the sphere. For example, this allows 
you to set the pivotal point for rotation, as described in the next section. 

Setting the Pivotal Point of Rotation 
1. Click and drag on the sphere with the hand tool to center the object on the first axis. 
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2. Change to the rotate tool to check the effect.  

3. Then continue to adjust for each axis using the hand tool until you have set the pivotal point of 
rotation, as required.  

Note: Select Reset View from the 3D menu to return the object to its original position. 

Free Flight Camera Control 
It is possible to control the viewing point or camera position for free flight around and through the 
volume. This is achieved using a USB joypad/gamepad with two analog joysticks and front face 
buttons. 

Joypad Preferences 
It is important to enable the joypad and calibrate the sticks before using the joypad for the first time. 

1. Select Preferences... from the Edit menu (Windows) or the Volocity menu (Mac). 

2. Click on the Joypad icon. 

3. Check to Enable Joypad Control, select the Device and Calibrate both sticks. 
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Controlling the Joypad 
The gamepad controls the camera or viewer position allowing completely free movement around and 
through the volume. The gamepad is, therefore, not moving the object at all. 

 
 

Left Analog Stick 

Move Left, Right, Forwards and Backwards 

Right Analog Stick 

Turn Left, Right, Up and Down 

Top Left Shoulder Button 

Modifies action of left analog stick 

Move Up and Down 

Top Right Shoulder Button 

Modifies action of right analog stick 

Roll Left and Right 

Numeric Buttons 

1 Point at center of volume 

2 Add bookmark 
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3D Preferences  
The 3D Preferences allow you to make adjustments in order to optimize rendering performance for 
the hardware system. 

1. Select Preferences… from the Volocity menu (Mac OS X) or the Edit menu (Windows).  

2. Click on the 3D icon to display the settings for 3D Views.  

 
3. The Resolution Limit sets the maximum number of voxels that will be rendered. Any data set 

exceeding the limit for a particular setting will be filtered allowing the user to achieve a balance 
between quality and interactivity. Reducing the resolution will increase interactivity and increase the 
size of data set that a particular system is able to render. 

4. The HR Renderers support fragment/pixel/hardware shaders, if these are supported by the graphics 
card. The terms used to describe hardware shaders vary depending on the graphics card chipset 
manufacturer.   

Hardware shaders offer better independent rendering of multiple channels reducing artefacts that 
can be introduced when channels interfere with each other. Hardware shaders are enabled in the 
renderer by checking Use Hardware Shaders. 

Use of hardware shaders requires a powerful graphics card that supports the OpenGL extension 
‘GL_ARB_fragment_program’. Recommended cards are described in the system requirements 
technical note.  

5. Settings that are grayed out indicate that they are not supported by the system. Make the required 
changes and click on Save (Mac) or OK (Windows). The settings will be applied the next time you 
open a 3D window. Open views will have to be closed and reopened for changes to take effect. 
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Which Renderer? 
You will have a choice of renderers, if you have the full version of Volocity Visualization and your 
hardware supports HR Renderers.   

 Users of Volocity Visualization Lite will only be able to use the HR Intensity Renderer. 

 Users with hardware that does not support the HR Renderers will only be able to use the Classic 
3D Renderer. 

Selecting the Renderer (Volocity Visualization only) 
Volocity Visualization users with hardware which supports the HR Renderers will be able to select 
between the HR Opacity and HR Intensity Renderers.  

From the 3D menu select Renderer and choose the required type of renderer. 
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HR Intensity Renderer (Volocity Visualization and Visualization Lite) 
Choose Show Palette from the Window menu, if the Navigation palette is not already visible on the 
screen.  

 
 The digital display gives the timestamp of the image and the timepoint number in the sequence. 

 
 Select the required mode of play by clicking on the appropriate button, and adjust the speed, if 

required, by using the slider. 

 

speed 

brightness control  

mode of play: once 
through, loop or 
shuttle 

play controls 

speed of playback 
control

timepoint 
timestamp of volume 

show/hide channel 
and reset to default 
buttons 

color LUT 
associated with 
channel 
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 Use the play controls to play through the volumes in the sequence.  

 
 Use the Brightness slider control to control the brightness of the rendered voxels. The HR 

Intensity Renderer uses the maximum intensity voxel from the path through the volume as the 
screen image and the brightness slider allows a multiplication factor to be applied to the voxel 
intensities. Moving the slider to the left reduces the brightness, moving it to the right increases 
brightness. 

 
 The show/hide button cloaks and uncloaks the channel in the 3D View so you can choose to work 

with a channel or not. The arrow button resets the slider for that channel to default (the values it 
had when first opened). The colored square reflects the color lookup table associated with the 
channel.  

 
 When you change controls or zoom in on the 3D View, while you play the sequence, you can use 

the channel Renderer Controls to adjust the rendering mode and settings and tailor the data set 
for optimum visualization, as required. As you do this, you may see a blue progress bar in the top 
left-hand corner as the Renderer rebuilds part of the model.  

Note: If you set a light background color in the View options (see page 253), this will be interpreted 
as maximum intensity and you might not get the result you expect. 
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HR Intensity Renderer Examples 
The following sequence shows the effect of applying the brightness control to an image.   

HR intensity 
default 

the brightness 
slider is in its 
default position 
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HR intensity 
brighter 

the brightness 
slider has been 
moved to the 
right 

 

 

  
HR intensity 
dimmer 

the brightness 
slider has been 
moved to the 
left 
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HR Opacity Renderer (Volocity Visualization only) 
Choose Show Palette from the Window menu, if the Navigation palette is not already visible on the 
screen.  

 
 The digital display gives the timestamp of the image and the timepoint number in the sequence.  

 
 Select the required mode of play by clicking on the appropriate button, and adjust the speed, if 

required, by using the slider. 

 

speed 

brightness, density 
and black level 
controls for each 
channel 

mode of play: once 
through, loop or 
shuttle 

play controls 

speed of playback 
control 

timepoint timestamp of volume 

drop-down list of  
renderer modes 

show/hide channel 
and reset to default 
buttons 

color LUT 
associated with 
channel 
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 Use the play controls to play through the volumes in the sequence. 

 
 Select the required rendering mode from the Mode drop-down menu.  

 Fluorescence applies direct opacity rendering, which is designed for use on data from 
fluorescence microscopy. 

 Brightfield applies direct opacity rendering, which is designed for use on data generated by 
transmitted light microscopy. 

 Isosurface applies indirect surface rendering, which identifies a surface around objects where 
all voxel intensity values are the same. This intensity is determined by the black level setting. 
The surface is made up of complex polygons. This generates apparently solid objects which 
cannot be seen through. No signal from objects behind can pass through an isosurface.  

 Use the slider controls to control the brightness, density and black level of the rendered image.  

 
 Brightness alters the brightness of the rendered voxels. A multiplication factor is applied to 

the intensity values of the voxels. Moving the slider to the left reduces the brightness, moving 
it to the right increases brightness. 

 Density alters the density of the rendered voxels. This affects how much can be seen through 
the structure. Denser voxels do not allow signal from the objects behind to pass through to the 
screen image. Moving the slider to the right increases voxel density, moving it to the left 
decreases density. 

 Black Level sets a value at which voxels of that intensity or lower will not be rendered. The 
remaining data is rescaled across the full display range of the screen. When choosing an 
appropriate black level, it may help to change the background color of the rendering view. 
Choose View Options from the 3D menu and choose a different color for the background (a 
lighter color usually helps the process). When the background color has been changed a dark 
area may be visible around the rendered object. Adjust the black level until this darkness is 
removed. 

Leaving the cursor over any of the Renderer Controls momentarily brings up a tip showing their 
current values. 

 The show/hide button cloaks and uncloaks the channel in the 3D View so you can choose to work 
with a channel or not. The arrow button resets the slider button for that channel to default (the 
values it had when first opened). The colored square reflects the color lookup table associated 
with the channel.  
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 When you change controls or zoom in on the 3D view while you play the sequence, you can use 
the channel Renderer Controls to adjust the rendering mode and settings and tailor the data set 
for optimum visualization, as required. As you do this, you may see a blue progress bar in the top 
left-hand corner as the Renderer rebuilds part of the model.  

 QTVR movies or movie sequences can be made from the HR Opacity view. 

HR Opacity Renderer Examples 

Example: effect of black level, density and brightness on a single channel 

In the first three examples, we have adjusted the black level to stop low intensity voxels causing 
noise when rendered and obscuring the object of interest.  

We can then use the brightness and density sliders to adjust the transparency of the object. 

The following sequence shows the effect of applying the brightness control to an image.   

 

Black level is 
0% 

When 
rendered, the 
low intensity 
voxels cause 
noise and 
obscure the 
object of 
interest. 
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Black level is 
increased 

Unwanted, low 
intensity voxels 
are not 
rendered. 

 

  
Keeping the 
same black 
level  

By raising the 
brightness and 
lowering the 
density we can 
produce a 
semi-
transparent 
object. 

 

 

Example: using different rendering modes on a 2-channel data set 

In the following example (on the next page) on a two channel data set, one channel is set to 
Isosurface rendering and the other is set to Fluorescence mode. 
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While the 
isosurface is 
being 
generated a 
simple wire 
box appears to 
show its 
approximate 
location. This 
is replaced by 
the isosurface 
when it is 
ready. 

 

 

The black level 
of the 
Isosurface 
channel is 
adjusted to 
change the 
intensities 
included in the 
isosurface. 

The controls 
for the channel 
in fluorescence 
mode can also 
be adjusted. 
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Ray Tracer 
If your system supports a choice of renderers, choose Ray Tracer from the Renderer sub-menu in 
the 3D menu. 

Unlike HR renderers which are real time and update the view quickly, the Ray Tracer is not an 
interactive renderer. The screen image is built up in tiles over multiple passes. A progress bar in the 
top left-hand corner of the image shows progress to completion of the screen image. 

The Ray Tracer is a software renderer, using the computer CPU to generate the results rather than 
graphics hardware. 

 
Using the tools in the toolbar to change the position or the orientation of the view will not update the 
view immediately; the view will switch to a wireframe representation of the volume that can be moved 
as required.   
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When the cursor is within the view a Render button is shown in the top right-hand corner. Click on 
this button to prompt the building of the screen image in tiles over multiple passes. 

 
There is no need to wait for the image to build if you wish to make further changes; it is possible to 
interact with the menus, toolbar and palettes while the image is being built. Click on the Render 
button to update the image with your changes. 
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Choose Show Palette from the Window menu to show the Navigation palette containing the controls 
for the appearance of the channels.  

 
Changes to the settings in the Navigation palette do not update the view immediately; the wireframe 
representation is shown and you must click the Render button to update. 

 The digital display gives the timestamp of the image and the time point number in the sequence.  

 Select the required mode of play by clicking on the appropriate button, and adjust the speed, if 
required, by using the slider. 

 Use the play controls to play through the volumes in the sequence. 

 Select the required rendering mode from the drop-down menu.  

 Fluorescence: applies direct opacity rendering, which is designed for use on data from 
fluorescence microscopy. 

 Isosurface: applies indirect surface rendering, which identifies a surface around objects 
where all voxel intensity values are the same. This intensity is determined by the black level 
setting. The surface is made up of complex polygons. This generates apparently solid objects 
which cannot be seen through. No signal from objects behind can pass through an isosurface.  
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Fluorescence and Isosurface rendering modes in the Ray Tracer ensure compatibility for data 
which is also viewed using other renderers. The Ray Tracer offers further isosurface modes: 

 Matte: for a non-reflective surface.  

 Metal: gives the surface properties similar to that of metal, surfaces are shiny and may reflect 
properties of the surrounding scene, for example the color of the floor. 

 Glass: generates a surface which mimics the properties of glass. Objects can be given a high 
degree of transparency and there may be some reflection. Surfaces will be shiny. 

 Use the slider controls to control the brightness, density and black level of the rendered image.  

 Brightness alters the brightness of the rendered voxels. A multiplication factor is applied to 
the intensity values of the voxels. Moving the slider to the left reduces the brightness, moving 
it to the right increases brightness. 

 Density alters the density of the rendered voxels. This affects how much can be seen through 
the structure. Denser voxels do not allow signal from the objects behind to pass through to the 
screen image. Moving the slider to the right increases voxel density, moving it to the left 
decreases density. 

 Black Level sets a value at which voxels of that intensity or lower will not be rendered. The 
remaining data is rescaled across the full display range of the screen. When choosing an 
appropriate black level, it may help to change the background color of the Rendering view. 
Choose View Options from the 3D menu and choose a different color for the background (a 
lighter color usually helps the process). When the background color has been changed a dark 
area may be visible around the rendered object. Adjust the black level until this darkness is 
removed. 

 Leaving the cursor over any of the Renderer Controls momentarily brings up a tip showing their 
current values. 

 An additional tool is available to you, the light source position. Select this tool and click in the 
view, move the light position control. Ray tracing has the ability to cast shadows within the data 
and on the floor of the scene. It may be necessary to change the floor color to best show 
shadows on the floor. Do this using the View options in the 3D menu. 

Switching views during tracing will cause the image to be lost and it will have to be traced again. 

Note: The Ray Tracer does not currently support measurements feedback display or drawing of the 
scale grid in the view. 
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Classic 3D Renderer 
This renderer will only load if the HR Opacity and HR Intensity Renderers are not available in the full 
Volocity Visualization license. 

Choose Show Palette from the Window menu if the Navigation palette is not already visible on the 
screen.  

 
 The digital display gives the timestamp of the image and the timepoint number in the sequence.  

 Select the required mode of play by clicking on the appropriate button, and adjust the speed, if 
required, by using the slider. 

 

speed 

renderer and 
brightness controls 
for each channel 

mode of play: once 
through, loop or 
shuttle 

play controls 

speed of playback 
control

timepoint timestamp of volume 

drop-down list of all 
timepoints in 
sequence 

brightness slider 
control 

show/hide channel 
renderer method 
controls  

opacity level 
control 
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 Use the slider in the play controls to play through the volumes in the sequence. 

  

 The show/hide button cloaks and uncloaks the channel in the Image View so you can choose to 
work with a channel or not.  

 
 While you play the sequence, you can use the channel Renderer controls to adjust the rendering 

method and tailor the data set for optimum visualization, as required. Volocity's Classic 3D 
Renderer offers three rendering methods: Maximum Intensity Projection (MIP), Opacity 
Rendering and a combination of MIP and Opacity. If you are using the Image Sequencer, each 
channel will have its own Renderer Controls on the Navigation palette. Leaving the cursor over 
any of the Renderer Controls momentarily brings up a tip showing their current values. 

 
The simplest way to choose between the three available rendering methods is to click the 
respective button on the palette. 

 
Note: Select Reset View from the View menu to reset any values applied to the Renderer 
Controls from the Navigation palette 

 MIP: This method uses the intensity value of the brightest voxel along the ray path in the 
screen representation. 

The slider bar controls a multiplication factor that is applied to the intensity values of the 
voxels before the screen image is calculated. This slider ranges from 0 to 200. The center 
point is normal. The far left reduces the brightness level to 0. The far right increases it to 
200%. 

 
 Opacity Rendering: Using an opacity lookup table (LUT) each voxel in the volume is given 

an opacity value related to its intensity. The opacity value determines whether a voxel is solid 
or transparent. Opacity values are then computed along the ray path to create the screen 
representation. 
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The opacity LUT controls determine how intensities are mapped to opacities and, therefore, 
the appearance of the opacity rendering. Objects that are 100% opaque are solid; those that 
are 0% opaque are completely transparent.  

 
 Combination MIP/Opacity Rendering: The unique facility to combine the two methods 

produces different results from those using either method in isolation. It offers more realism by 
allowing bright objects to be seen through others or opaque objects in one channel to obscure 
objects behind them. 

 Movie sequences and QTVR movies can be made from the 3D Rendering view. 

Classic 3D Renderer Example 

Example: uses the MIP slider only 

In the first two examples, we have applied brightness rendering and have used the slider control to 
change the value of the brightest point in the object.  

The opacity is off in both examples. Look at the graph in the Renderer Controls; all intensity values 
are mapped to 0, completely transparent. 

The following sequence shows the effect of applying the brightness control to an image.   

MIP 
contribution 
set to 25% 

Note how dark 
the image is.  

 

click and drag on top and bottom squares 
to adjust opacity level, click and drag 
middle square to shift line left or right 
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MIP 
contribution 
set to 94% 

The image is 
brighter and 
you can see 
any structures 
behind it.  

 
 

Example: uses the opacity controls only 

In the next three examples, we have applied opacity rendering and have used the opacity controls to 
vary the solidity of each voxel. This can have the effect of peeling away layers to reveal structures 
within structures.   

The MIP/brightness control is off in all three examples. Look at the slider in the Renderer Controls; it 
is set at 0. 



Classic 3D Renderer Example 

 

276   Improvision 

Opacity values 
set to display 
data at all gray 
levels. 
Underlying 
structures are 
only partially 
visible. 

 

 
 

Displays data 
at gray levels 
between 50 
and 152. This 
allows us to 
make parts of 
the structure 
transparent 
and produces 
the effect of 
peeling away 
layers to reveal 
underlying 
structures.  
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Displays data 
at gray levels 
between 50 
and 80. The 
image is solid. 
Underlying 
structures are 
not visible. 

 

Example: combines MIP and opacity controls 

In the final two examples we illustrate the power of the combination rendering method. You will 
notice that there are two sets of Renderer Controls. This is because the examples are from a multi-
channel data set; each channel has its own Renderer Controls in the Navigation palette.    

The following examples show how two or more separate channels can be rendered in different ways 
to better show structures and relationships between those structures. 
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MIP only, used 
identically for 
both red 
(nuclei) and 
green 
(membrane) 
channels. 
Nuclei visible 
but partially 
obscured by 
the membrane. 

 
 

Opacity 
rendering used 
for the red 
channel, 
mapping 0 to 
100% opacity 
across 
intensities from 
52 to 255. 

Nuclei are now 
solid and the 
membrane is 
transparent. 
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3D View Bookmarks 
Bookmarks allow you to store information about the position of the volume and the rendering settings 
being applied to it.   

Bookmarks can be used to remember these settings so that they may be retrieved later.  For 
example, to return to a previous position and appearance after making changes or to use the position 
and appearance of one data set to view another data set with exactly the same settings applied. 

To Create a Bookmark 
Bookmarks are kept in a Bookmark pane to the right of the 3D View. If this pane is not visible, select 
Show Bookmarks from the 3D menu.   

 Position the volume as required and set the Renderer Controls in the Navigation palette to 
produce the desired appearance. 

 Select Add Bookmark from the 3D menu. 

A thumbnail of the volume will be added to the bookmarks pane. 
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To Use a Bookmark 
Double click on the thumbnail of a bookmark in the bookmark pane to use the settings of that 
bookmark to change the position and rendering settings of the current 3D View to those stored by the 
bookmark. 

Alternatively use Next Bookmark or Previous Bookmark in the 3D menu to step through 
bookmarks in the order in which they were created.  

To Edit a Bookmark 
1. Select the bookmark in the bookmark pane, the borders of the bookmark will become highlighted. 

2. Select Edit Bookmark... from the 3D menu. 

3. A dialog is opened showing the states of the view that are being stored. 

 
4. Uncheck a state and that part of the bookmark setting will not be applied to the 3D View when the 

bookmark is used. 

Check the state again and the setting(s) stored when the bookmark was created will be applied again 
when the bookmark is used. 

To Move a Bookmark. 
To use the settings of one 3D View with another data set so that both data sets may be compared 
move the bookmark from the first 3D View to the second. 

With both data sets open drag the bookmark from one bookmark pane to the other. 

The bookmark thumbnail will update the first time it is used with the new dataset. 

To Delete a Bookmark 
Select the bookmark in the bookmark pane, the borders of the bookmark will become highlighted. 
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Use the Delete (Windows) or Backspace (Mac OS) keys to delete the bookmark. 

Overlays turned on or off by items in the 3D menu, i.e. the ball control, scale, orientation and time, 
are not stored by bookmarks. 

3D View Movie Interface 
You can animate a 3D View by scripting a series of movements and changes to the appearance of 
the volume using the Movie Sequencer. See page 288. 

Alternatively, to create a more freely-flowing movie, use bookmarks and the movie interface in the 3D 
View. Bookmarks are the starting point for making movies in this way. The movie will be an 
animation of the transition between the appearance of the volume in one bookmark and its 
appearance in the next bookmark. Each transition takes place over a number of frames determined 
by you. Select Show Bookmarks from the 3D menu to view the bookmarks pane. 

1. Choose Show Movie from the 3D menu. 

 
2. Drag a bookmark thumbnail from the bookmark pane to the movie pane to create a keyframe in the 

movie. By default this keyframe will be 10 frames long. Keyframe length may be changed by clicking 
and dragging the end of the keyframe. 
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3. Drag a second bookmark into the movie pane. When the movie plays, the volume will be gradually 

changed in appearance from the first bookmark to the second, this transition taking as long as the 
number of frames over which the first keyframe extends. 
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4. Continue dragging bookmarks in to make a series of keyframes/transitions. 

 
5. To include switching between timepoints in a movie made for a time resolved sequence select Add 

Timepoint Sequence... from the 3D menu. This will add a time bar to the movie which can be 
configured to last any number of frames, switching between timepoints backwards or forwards and 
even switching between a subset of timepoints. 

 



3D View Movie Interface 

 

284   Improvision 

6. Delete a keyframe from the movie by clicking on it once to select it then using the Delete key 
(Windows) or the Backspace key (Macintosh) 

7. Preview the movie on the current 3D View using the controls at the top of the movie pane. 

Edit Keyframe 
Double click on a keyframe or select Edit Keyframe... from the 3D menu to access the Edit 
Keyframe dialog.  

 
This dialog allows configuration of the length of the keyframe or transition and also selection of the 
bookmark properties which are used in that transition. It is, therefore, possible to use only the 
positional information and not the rendering settings stored with a keyframe. 
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Edit Timepoint Sequence 
Double click on a timepoint sequence or select Edit Timepoint Sequence... from the 3D menu to 
access the Edit Timepoint Sequence dialog. 

  

Adjust the number of frames over which the timepoints will be played through, switch between 
timepoints backwards or forwards.  

You can also use this dialog to configure a timepoint sequence to switch between a subset (or range) 
of timepoints. Additional timepoint sequences may be added to the movie to switch through 
remaining timepoints. 
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Resize Movie 
Select Resize Movie... from the 3D menu to easily change the length of the movie. Movie length 
may be changed to a percentage of its existing frame number, to a fixed number of frames or to last 
a known length of time when played at a known frame rate. 

 

Clear Movie 
Select Clear Movie from the 3D menu to delete all the keyframes and timepoint sequences of a 
movie. 

Once a movie is created you may wish to generate the frames of the movie for the current 3D View 
to then be able to export them. Also, it may be relevant to save this movie for future use and for use 
with different data sets. 

Make Movie 
Select Make Movie from the 3D menu to create the movie frames and add them to the library. A new 
folder will be added to the library. The name is the same as the source data with Movie appended. 
Double click on this folder to view the contents. 

This folder may be exported as a movie by selecting it and choosing Export... from the File menu. 
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Save and Restore Movie 
Save the movie keyframes by selecting Save Movie... from the 3D menu. Give the movie a name 
and click Save. This will store the movie as a preference within the system.   
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Use existing movies with a data set by viewing the 3D View and selecting Restore Movie... from the 
3D menu. 

 

Creating Movie Sequences 
A Movie Sequence is a volume animation template that can be applied to any 3D View.  

An alternative method for animating a 3D View is to use bookmarks to build keyframes in the movie 
pane of the 3D View itself. See page 281. 

A simple way of animating a rendered view over time is to use the Export view as movie command 
in the Export dialog, see page 124. 
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Creating a Movie Sequence Item 
1. While displaying the 3D View of the item that you wish to animate, select Create New from the 

Actions menu and select Movie Sequence to create a new, untitled movie sequence item in the 
library. 

2. The Movie Sequence window opens automatically.  

 
3. Use the Movie Sequence window to set up any number of actions for the movie.  

4. Drag the required task(s) across to the main window.  

5. Then stretch the task box to define the frames during which the task will be carried out. Tasks may 
be sequential or concurrent, as shown in the following example.  
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6. Double click on a task and enter setup parameters in the Task dialog, as appropriate. (Not all tasks 
require setup parameters.) 

7. Once you have set up the sequence, use the play controls to preview the animation of the open view. 
The red bar shows you the current frame in the movie sequence.  

 
  

8. Once created, the movie sequence can be used with any open Rendering view.  

You may wish to create a folder containing the individual frames of this movie as a separate item in 
the library. A folder of frames can be opened within Volocity as a Gallery View and played from the 
Movie tab. The whole folder can also be exported as a QuickTime or AVI file. Select Make Movie 
from the Sequence menu. 

3D Zoom Task 
Double click on this icon to set the zoom factor for 3D Views during the movie. 

Enter the required percentage and click on Save. 
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3D Rotate Object Task 
Double click on this icon to set the rotation for 3D Views during the movie. 

Enter the required rotation angle, specify the axes for rotation and click on Save. Note how the 
position of the red pole changes to reflect your settings. 

 

3D Rotate World Task 
Double click on this task to set the rotation for the world (stage floor) during the movie. 

Enter the required rotation angle and click on Save. 
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Brightness Task 
Double click on the task to set the brightness level for a channel. Enter the number for the channel, 
use the slider controls to set the initial value and the required value (or type in the values directly) 
and click Save. 

 

Density Task 
This task is only applicable to HR Opacity rendering. Double click on the task to set the density for a 
channel. Enter the number for the channel, use the slider controls to set the initial value and the 
required value (or type in the values directly). Click Save. 
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Black Level Task 
This task is only applicable to HR opacity rendering. Double click on the task to set the black level for 
a channel. Enter the number for the channel, use the slider controls to set the initial value and the 
required value (or type in the values directly). Click Save. 

 

Opacity Task 
This task is only applicable to Classic 3D Rendering. Double click on the task to set the opacity for a 
channel. Enter the number for the channel, use the graph window to set the original opacity limits 
and the required opacity limits (or type in the values directly) and click Save. 
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Switch Items Task 
Use this task to move through all the contents of a folder in order over the length of the task. There is 
no setup dialog. 

Switch Items (Backwards) Task 
Use this task to move through the contents of a folder in reverse order. There is no setup dialog. 

Switch Timepoints Task 
Use this task to move through the timepoints in an image sequence over the length of the task. 
There is no setup dialog. 

Switch Timepoints (Backwards) Task 
Use this task to move through the timepoints in an image sequence in reverse order. There is no 
setup dialog.  

 

Creating QuickTime VR Movies  
A QTVR file is an interactive movie that can be viewed in QuickTime player. If you have QuickTime 
installed on your machine, you can render a volume and then create a QTVR movie of the rendered 
view.  

Note: A QuickTime VR movie is not a real movie, as such, rather an animation that is created by 
displaying the object according to a map of user-defined co-ordinates.  
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1. Select Create QTVR Movie… from the 3D menu  

 
2. Amend the settings as appropriate.  

3. The panning and tilting values define the rotation that can be applied to the QuickTime object. These 
values are used to build a map of all the co-ordinates that will be used to display the object on the 
screen. In our example, you will be able to rotate the object 360 degrees in 36 steps and tilt it 
through 60 degrees in 18 steps (this means the object will rotate 10 degrees for each step).  

4. Select a compression format from the drop-down list and use the slider control to set the 
compression factor. 

5. The available compression options vary according to the version of QuickTime that is installed 

6. Click on Create…  

7. Select a folder and enter a name for the movie.  

8. Click on Save. 
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Aligning Volumes 
The Volocity alignment tool is designed to compensate for rotational and translational shifts only 
between the 2-dimensional planes that make up a volume.  

When performing rotational correction the Alignment tool will search for correlation +/- 30 degrees 
from the origin. The Alignment tool searches for correlation between slices in the data to match 
features and establish where each slice should be in relation to the next. For alignment to be 
successful features must be represented in neighboring slices. This means that the slices must be 
similar. 

The Alignment tool will not be able to perform on structures that are, or approximate to, spheres 
since they show rotational symmetry which makes feature matching impossible. 

During rotation of images anti-aliasing is applied which has a smoothing effect on the data. The 
original data is not overwritten, a new volume or volume sequence is created with the suffix (aligned). 
The XY dimensions of an aligned volume will be the same as the original volume, areas of image 
that have been shifted outside the original boundary to allow alignment will be cropped from the 
result. 

There is no benefit to be gained by repeatedly aligning the same data. 

1. Select Align Volumes... from the Tools menu. 

2. If you are aligning a single image there are no further prompts. If you are aligning images in an 
image sequence, a prompt will be shown offering options to align volumes individually or using a 
selected channel in the sequence as a reference..  
 

 
3. If no channel has been selected or you have selected more than one channel, only Individually is 

available. If a channel has been selected, you can click on either button. Click Align.   
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Slice View (Volocity Visualization only) 
The XY plane in which the images from a sample have been acquired may not always provide the 
best presentation of the structures being examined. It may be desirable to re-slice the image data in 
a different orientation in order to get the required view. The Slice View and associated tools allow the 
reslicing of data sets in any chosen rotation of X, Y and Z. 

Before reslicing data ensure that the X, Y, and Z calibrations are correct in the item properties, see 
page 54. 

 
 

 

Enter Values to Set Slicing Orientation 
You may either enter values for the X, Y, and Z values or use the buttons to step up and down. In 
order to achieve all possible orientations of the slice, the rotation should be considered to be first 
around the X axis, then around the new Y axis and finally around the new Z axis. 
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Use Preset Slicing Orientation 
Click the Preset buttons to immediately set an XY, XZ or YZ slicing orientation. 

When a slice orientation has been chosen, use the depth slider to the right of the view to see the 
slice moved through the volume. A tooltip for the slider will show the depth through the volume in 
microns. This value requires accurate calibration of the volume in the Properties dialog, see page 54. 

   
 Slice moved to XZ orientation    Slice moved to YZ orientation 

 

Tools to Set Slicing Orientation 
The toolbar is similar to the 3D toolbar, with two additional tools. These two tools are only 
subtly different; users will find one more intuitive to use than the other.  

Rotate Slice, shortcut key, S. 

The volume remains stationary and the slice is moved. The data shown in the slice will, 
therefore, be updated to show the changes in the slice. 
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preview 

The slice may be rotated through 360 degrees about all axes. A preview of the slice may be 
displayed in the top right-hand corner select Show Preview from the Slice menu. The slice may be 
rotated through 360 degrees about all axes. A preview of the slice may be displayed in the top right-
hand corner, as shown in the second image below (see also page 302). 
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Rotate Volume, shortcut key, V. 

Use this tool to rotate about the current slice (it is the volume that is rotated). 

 
The slice remains stationary and the volume is moved. The data shown on the slice will update as 
the volume is moved through it. This tool can be used to allow constant viewing of the slice face 
while still changing the slice orientation. 
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When a slice orientation has been chosen, use the depth slider to the right of the view to see the 
slice moved through the volume. A tooltip for the slider will show the depth through the volume in 
microns. This value requires accurate calibration of the volume in the Properties dialog, see page 54. 

 
 

Navigation Palette  
The Navigation palette can be used with the Slice View in a very similar way to its use with the Image 
View. If the Navigation palette is not already visible on the screen, select Show Palette from the 
Window menu.  
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Show Preview 
Choose Show Preview to preview new slices that would be created, if the volume were to be sliced 
according to current settings. The slice preview is updated with the current slice when the depth 
slider is moved. Choose Hide Preview to remove the preview pane from the top right-hand corner of 
the Slice View. 

To Create Data with New Slicing Orientation 
Slice Image or Slice Sequence from the Slice menu creates a new volume or image sequence with 
each slice at the new orientation. The volume will typically be larger than the original. Any offset 
slices will be drawn around to avoid cutting off data. 

 Resliced volumes are interpolated using tri-cosine interpolation so that each axis has the same 
calibration as the highest resolution axis in the original data. Calibration will be changed 
accordingly. The overall dimensions of the data set will not change and calibrated measurements, 
such as the volume in square microns, will be the same. Non-calibrated measurements, such as 
voxel counts, will not be the same as the original data. 

 Calibrate data before slicing; corrections on sliced data will not be easy to calculate. 

 Rendered views of sliced and unsliced data will look identical. 

 The mean intensity of objects will not be changed. Individual voxels may have altered intensity 
values because of interpolation. 

Capture Snapshot  
This option adds a new 2D image to the library showing the view as it appears when the snapshot is 
captured.  

Show/Hide Floor, Scale, Orientation  
These options change the display of the Slice View. It is possible to show a scale grid and orientation 
tool as in the Rendering View, see page 253. 

Scale and Slice View Options  
These options change the color of the scale grid and Slice View background to clearly display data. 
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Volocity Quantitation Worked Examples 

Overview 
Volocity Quantitation is designed to identify biological structures automatically. These can then be 
measured and tracked in 2D, 3D and 4D, analyzed and charted. Volocity Quantitation is an individual 
product and must be purchased separately. See page 35 for more information about activating 
extension products.  

Volocity Quantitation provides a powerful, easy-to-use interface that allows the user to build up 
protocols of measurement tasks and then view the feedback as an overlay on the original image and 
view a table of measurements – all from the same Measurements View. 

The Measurements View provides all the tools required to identify objects and make a variety of 
measurements from those objects. Measurements made in the Measurements View can also be 
stored as a new item in the library by using Make Measurement Item in the Measurements menu. 

To assist users wishing to start working immediately, this chapter provides five worked examples 
describing common applications using Volocity Quantitation: 

 Measure the mean volume of structures in a 2-channel data set at a single timepoint. 

 Measure multiple timepoints. 

 Measure multiple image sequences. 

 Measure and track multiple timepoints. 

 Colocalization. 
 

For more detailed information please see the separate reference chapter, starting on page 339. 
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Measuring a Single Timepoint 
The process has three stages: 

 Create a protocol to locate objects of interest in your data set. A protocol is used to threshold 
data to select areas of interest and, from that selection, include or exclude objects based on a 
range of criteria. 

 Create a Measurement Item to store the measurements. 

 Review the results. 

To obtain correct values for calibrated spatial measurements, it is important to ensure that the data is 
calibrated correctly by setting the X, Y and Z pixel dimensions in the Properties dialog, see page 54. 

Creating the Measurement Protocol 
1. Open the required data set and view the Measurements tab. The Measurements View contains all 

the tools and information needed for selecting objects. 
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2. Start the protocol by using a “Find Objects” task such as Find Objects by Intensity. There are other 
“Find Objects” tasks which may be appropriate for different types of data. See page 363  for a 
description of these. If the dataset contains more than one channel, as in this example, make sure 
that the correct channel is selected in the task. 

 

 
3. The task shows a histogram of the intensity values present within the data set and selected values 

are shown as a shaded red area on the histogram. Drag the vertical, red lines to adjust the intensity 
range selected. 

4. The selected objects will be shown as a colored overlay in the image preview and standard 
morphological and intensity measurements will be displayed in the measurements table. To change 
the color of objects found use the Color Objects task, see page 359 and to change the 
measurements made use the Measure Objects task, see page 373.  

5. If the selected objects are not automatically shown, select Update Feedback from the 
Measurements menu. To update feedback automatically after any change to the protocol turn on 
Automatically Update Feedback in the Measurements menu. 

click cog to view secondary dialog 
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6. If too many or too few objects have been selected you may need to make adjustments to the 
protocol. 

 Find Objects. The protocol will only select voxels if they are between the minimum and 
maximum intensity set in the task. Drag the red bars to include more or fewer voxels. Click on the 
cog icon to access the secondary dialog for the task. 

  
This dialog shows a larger histogram and value entry fields for more precise setting of threshold 
values. It is also possible to set the thresholds to the maximum and minimum intensity values 
found within a region of interest drawn on the image. The ROI must be drawn before this dialog is 
opened. Choose Get From ROI. 

 Modify the Selection. It may be necessary to remove noise from the selection to avoid selecting 
voxels that are not relevant to the objects required. Add a Remove Noise From Objects task to 
the protocol and select the size of filter to be applied. 
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 Exclude Objects. It is also possible to exclude objects based on certain characteristics such as 
their size, shape or position relative to the edge of the image or an ROI. To exclude by size use 
the table of measurements to view the sizes of the objects found by the current protocol. Click on 
a column heading to sort the table by the contents of that column. Add an Exclude Objects by 
Size task to the protocol to exclude objects larger or smaller than the size entered. 

  
6. Adjust the protocol, as required, until the preview shows the required selection.  

7. If the table does not show the measurements required, or shows too many, add Measure task(s) to 
the protocol. Click on the cog icon in a Measure task to set up the measurements required. For 
example the Measure Objects task dialog will look like this: 

 
8. If you wish to save the protocol for future use, select Save Protocol… from the Measurements 

menu. 
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Storing Measurements in a Measurement Item 
1. The measurements visible in the Measurements View are present because a protocol is active in the 

Measurements View. As soon as the protocol is changed the measurements will change. To store 
measurements and work with them further, you must create a Measurement item. 

2. Select Make Measurement Item… from the Measurements menu. 

 
3. Select to make a new measurement item and enter a name for it, or add these measurements to an 

existing table, which may be made from the same data or from different data. Measurement items 
may combine measurements from different sources. 

4. Click on OK.   

A progress bar may be shown on screen while the measurements are being made. A new item will 
be added to the library. 

 

Viewing the results 
1. Double click the Measurement item to open the Raw View showing the table of numbers. 

This table may be sorted, re-organized and filtered.  See page 383 for more information on working 
with the Raw View. 

If required, the measurements may be exported as tab or comma-delimited text. To do this, display 
the Raw View and select Export… from the File menu. 
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Measuring Multiple Timepoints  
The process has three stages: 

 Create a protocol to locate objects of interest in your data set. A protocol is used to threshold 
data to select areas of interest and, from that selection, include or exclude objects based on a 
range of criteria. 

 Create a Measurement Item to store the measurements. 

 Review the results. 

To obtain correct values for calibrated spatial measurements, it is important to ensure that the data is 
calibrated correctly by setting the X, Y and Z pixel dimensions in the Properties dialog, see page 54. 

Creating the Measurement Protocol 
1. Open the required data set and view the Measurements tab. The Measurements View contains all 

the tools and information needed for selecting objects. 
 

 
2. Start the protocol by using a “Find Objects” task such as Find Objects by Intensity. There are other 

“Find Objects” tasks which may be more appropriate for time resolved data (for example, Find 
Objects by % Intensity and Find Objects by SD Intensity). These tasks do not use absolute 
intensity values and are, therefore, better suited to data where the range of intensity values does not 
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remain constant. See page 363 for a description of these tasks. If the dataset contains more than 
one channel, make sure the channel containing the objects required is selected in the task. 

 

3. The task shows a histogram of the intensity values present within the data set; selected values are 
shown as a shaded red area on the histogram. Drag the vertical, red lines to adjust the intensity 
range selected. 

4. The selected objects will be shown as a colored overlay in the image preview and standard 
morphological and intensity measurements will be displayed in the Measurements table. To change 
the color of objects found use the Color Objects task, see page 359, and to change the 
Measurements made use the Measure Objects task, see page 373.  

5. If the selected objects are not automatically shown, select Update Feedback from the 
Measurements menu. To update feedback automatically after any change to the protocol, turn on 
Automatically Update Feedback in the Measurements menu. 

6. If too many or too few objects have been selected, you may need to make adjustments to the 
protocol. 

 Find Objects. The protocol will only select voxels if they are between the minimum and 
maximum intensity set in the task. Drag the red bars to include more or fewer voxels. Click on the 
cog icon to access the secondary dialog for the task. 
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This dialog shows a larger histogram and value entry fields for more precise setting of threshold 
values. It is also possible to set the thresholds to the maximum and minimum intensity values 
found within a region of interest drawn on the image. The ROI must be drawn before this dialog is 
opened. Choose Get From ROI. 

 Modify the Selection. It may be necessary to remove noise from the selection to avoid selecting 
voxels that are not relevant to the objects required. Add a Remove Noise From Objects task to 
the protocol and select the size of filter to be applied. 

 
 Exclude Objects. It is also possible to exclude objects based on certain characteristics such as 

their size, shape or position relative to the edge of the image or an ROI. To exclude by size use 
the table of measurements to view the sizes of the objects found by the current protocol. Click on 
a column heading to sort the table by the contents of that column. Use Exclude Objects by Size 
in the protocol to exclude objects larger or smaller than the size entered. 

 
 Adjust the protocol, as required, until the preview shows the required selection. 

7. You should check the protocol on a number of different timepoints before storing the measurements. 
This saves time and avoids making unnecessary measurements. 

To do this: 

 Display the Measurements View and the Navigation palette on the screen at the same time. 
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 Set up the protocol, then use the Navigation palette (as described on page 82 ) to move between 
timepoints. Stop at intervals and Automatically Update Feedback will apply the protocol to the 
new timepoint. If the protocol is not applied when the timepoint changes, select Update Feedback 
from the Measurements menu. 

You can then see the effect on the Image View and adjust the protocol for a number of timepoints to 
obtain the best fit. 

8. Once you are happy that the protocol is optimized you may wish to save it. Select Save Protocol… 
from the Measurements menu. 

Storing Measurements in a Measurement Item 
1. The measurements visible in the Measurements View are present because a protocol is active in the 

Measurements View. As soon as the protocol is changed, the measurements will change. To store 
measurements and work with them further, you must create a Measurement item. 

2. Select Make Measurement Item… from the Measurements menu. 

 
3. Select to make a new Measurement item and enter a name for it, or add these measurements to an 

existing table, which may be made from the same data or from different data. Measurement items 
may combine measurements from different sources. 

4. Choose to measure All timepoints and Click on OK.   

A progress bar may be shown on screen while the measurements are being made. A new item will 
be added to the library. 
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Viewing the Results 
1. Double click the Measurement item to open the Raw View showing the table of numbers. 

This table may be sorted, re-organized and filtered. See page 383 for more information on working 
with the Raw View. 

If required, the measurements may be exported as tab or comma-delimited text. To do this, display 
the Raw View and select Export… from the File menu. 

2. The Analysis View may be used to show relationships of data over time. For example the mean 
intensity of all the measured objects for each timepoint. Click on the Analysis tab and select 
Analyze… from the Analysis menu. 

 
The data of interest is the mean intensity for each object.  
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There are several objects per timepoint, so these can all be summarized by finding the mean, then 
organizing the data by timepoint to show the relationship between mean intensity and timepoint. 

 
The top area of the Analysis View now shows a table with the mean of the mean intensities arranged 
in rows according to timepoint. 
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This can easily be plotted as a chart by clicking on the Chart tab. 

 



Measuring Multiple Timepoints 

 

316   Improvision 

There are many different chart types and options to configure the appearance of the chart, accessed 
by clicking on the Chart Setup button or selecting Edit Chart… from the Chart menu. 
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Measuring Multiple Image Sequences 
Volocity supports batch processing of image sequences. One Measurements protocol is applied to 
multiple selected sequences and the results are collected in a single Measurements item. 

The process has four stages: 

 Create a protocol to locate objects of interest in your data set. A protocol is used to threshold 
data to select areas of interest and, from that selection, include or exclude objects based on a 
range of criteria. 

 Save the protocol. 

 Apply the saved protocol to selected image sequences in the library. 

 Review the results. 
If you have a saved measurements protocol that you would like to apply to multiple image sequences, 
start at “Apply the Protocol to Selected Sequences” on page 321. Otherwise, you must first create a 
protocol by opening one of the image sequences that you will measure and viewing the 
Measurements tab. 

To obtain correct values for calibrated spatial measurements, it is important to ensure that the data is 
calibrated correctly by setting the X, Y and Z pixel dimensions in the Properties dialog, see page 54. 
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Creating the Measurement Protocol 
1. Open the required data set and view the Measurements tab. The Measurements View contains all 

the tools and information needed for selecting objects.  

 
2. Start the protocol by using a “Find Objects” task such as Find Objects by Intensity. There are other 

“Find Objects” tasks that may be more appropriate when working with multiple data sets containing 
images that have widely-varying intensity values (for example, Find Objects by % Intensity and 
Find Objects by SD Intensity). These tasks do not use absolute intensity values and are, therefore, 
better suited to data where the range of intensity values does not remain constant. See page 363  for 
a description of these tasks.  
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If the dataset contains more than one channel, make sure the channel containing the objects 
required is selected in the task. 

 
3. The task shows a histogram of the intensity values present within the data set and selected values 

are shown as a shaded red area on the histogram. Drag the vertical, red lines to adjust the intensity 
range selected. 

4. The selected objects are shown as a colored overlay in the image preview and standard 
morphological and intensity measurements are displayed in the Measurements table. To change the 
color of objects found use the Color Objects task, see page 359, and to change the measurements 
made use the Measure Objects task, see page 373.  

5. If the selected objects are not automatically shown, select Update Feedback from the 
Measurements menu. To update feedback automatically after any change to the protocol, turn on 
Automatically Update Feedback in the Measurements menu. 

6. If too many or too few objects have been selected you may need to make adjustments to the 
protocol. 

 Find Objects. The protocol will only select voxels if they are between the minimum and 
maximum intensity set in the task. Drag the red bars to include more or fewer voxels. Click on the 
cog icon to access the secondary dialog for the task. 

 

This dialog shows a larger histogram and value entry fields for more precise setting of threshold 
values. It is also possible to set the thresholds to the maximum and minimum intensity values 
found within a region of interest drawn on the image. The ROI must be drawn before this dialog is 
opened. Choose Get From ROI. 
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 Modify the Selection. It may be necessary to remove noise from the selection to avoid selecting 
voxels that are not relevant to the objects required. Add a Remove Noise From Objects task to 
the protocol and select the size of filter to be applied. 

  
 Exclude Objects. It is also possible to exclude objects based on certain characteristics such as 

their size, shape or position relative to the edge of the image or an ROI. To exclude by size use 
the table of measurements to view the sizes of the objects found by the current protocol. Click on 
a column heading to sort the table by the contents of that column. Add an Exclude Objects by 
Size task to the protocol to exclude objects larger or smaller than the size entered. 

  
Adjust the protocol, as required, until the preview shows the required selection. 

7. It is possible to review the protocol applied to other image sequences to check that it is appropriate. 
This saves time and avoids making unnecessary measurements. 
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To do this: 

 Set up the protocol in the Measurements View of one of the items. 

 Use the library navigation tools in the toolbar to move up or down through items in the library or 
jump straight to one item. 

You can then see the effect and adjust the protocol if necessary without having to leave the 
Measurements View. 

 
8. Select Save Protocol… from the Measurements menu. 

 

Apply the Protocol to Selected Sequences 
1. In the Library View select the items to be batch processed by measuring with the protocol. 
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2. Select Measure… from the Tools menu. 

 
Select the protocol to be applied to the selected items from the drop-down menu, which lists all 
saved protocols by name. 

Either, select Store the measurements in a new measurement item called: and enter a name for 
the Measurement item that will contain all the measurements made by the selected protocol on the 
selected items. Or, select Add the measurements to this existing measurement item: and 
choose from the measurement items that already exist in the library. In this case, all the 
measurements from all the selected items will be added to the measurements already in the table. 

For each task in the protocol that operates on a specific channel (i.e. the Protocol dialog contains a 
drop-down for channel selection when the task is configured), there will be an entry under Apply the 
protocol’s tasks to these channels: The drop-down lists the unique channel names found within 
the selected items. Channels with the same name will all be processed. 

3. Select the correct channel for each task in the list and click OK. 

4. A progress bar is shown as each of the selected items is measured with the protocol and the 
Measurement item is created. 

5. Double-click the Measurement item to view the Raw View of all the measured objects. 



VOLOCITY QUANTITATION WORKED EXAMPLES 

February 2008   323 

6. To perform further analysis of this large amount of data, go to the Analysis tab and select Edit 
Analysis… from the Analysis menu. 

7. To show the changing mean intensity over time, the Analysis dialog could be configured as shown 
below: 

 
Time may be represented as absolute or relative. 

Item Name will organize the data according to the name of the image sequence. Since Item Name is 
selected for Column in the table, these will become individual series in a chart allowing us to visually 
compare the data sets. 
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Click on the Chart tab to view the chart. The default chart type is a bar chart. Select Edit Chart… 
from the Chart menu to change the chart type. The following example shows a line chart. 
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Measuring and Tracking Multiple Timepoints 
Volocity’s unique time-based measurement architecture allows you to measure and track biological 
objects as they move in time in both 2D and 3D.  

Tracking uses the centroid measurement for each object to identify whether objects have moved 
between timepoints. It does not use any of the other measurements. 

The process has three stages: 

 Create a protocol to locate objects of interest in your data set. This protocol must locate objects 
as accurately as possible in each timepoint. 

 Measure the objects found by the protocol and generate tracks based on the centroid position of 
each object. 

 Review the results. 

Creating the Measurement Protocol 
1. Open the required data set and view the Measurements tab. The Measurements View contains all 

the tools and information needed for selecting objects. 
 

 

measurements are 
shown here as a 
table or histogram

measurement 
protocol tasks 

drag tasks to 
this pane to 
make 
measurements 

image preview will 
show feedback as 
measurements are 
made 
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2. Start the protocol by using a “Find Objects” task such as Find Objects by Intensity. There are other 
“Find Objects” tasks that may be more appropriate for time resolved data, for example Find Objects 
by % Intensity and Find Objects by SD Intensity. These tasks do not use absolute intensity values 
and are, therefore, better suited to data where the range of intensity values does not remain 
constant. See page 363 and page 369 for description of these. If the dataset contains more than one 
channel make sure the channel containing the objects required is selected in the task. 

 
3. The task shows a histogram of the intensity values present within the data set and selected values 

are shown as a shaded red area on the histogram. Drag the vertical, red lines to adjust the intensity 
range selected. 

4. The selected objects are shown as a colored overlay in the image preview and standard 
morphological and intensity measurements are displayed in the Measurements table. To change the 
color of objects found use the Color Objects task, see page 359, and to change the measurements 
made use the Measure Objects task, see page 373.  

5. If the selected objects are not automatically shown, select Update Feedback from the 
Measurements menu. To update feedback automatically after any change to the protocol, turn on 
Automatically Update Feedback in the Measurements menu. 
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6. If too many or too few objects have been selected, you may need to make adjustments to the 
protocol. 

 Find Objects. The protocol will only select voxels if they are between the minimum and 
maximum intensity set in the task. Drag the red bars to include more or fewer voxels. Click on the 
cog icon to access the secondary dialog for the task. 

 

This dialog shows a larger histogram and value entry fields for more precise setting of threshold 
values. It is also possible to set the thresholds to the maximum and minimum intensity values 
found within a region of interest drawn on the image. The ROI must be drawn before this dialog is 
opened. Choose Get From ROI. 

 Modify the Selection. It may be necessary to remove noise from the selection to avoid selecting 
voxels that are not relevant to the objects required. Add a Remove Noise From Objects task to 
the protocol and select the size of filter to be applied. 

  
 Exclude Objects. It is also possible to exclude objects based on certain characteristics such as 

their size, shape or position relative to the edge of the image or an ROI. To exclude by size use 
the table of measurements to view the sizes of the objects found by the current protocol. Click on 
a column heading to sort the table by the contents of that column. Add an Exclude Objects by 
Size task to the protocol to exclude objects larger or smaller than the size entered. 
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 Adjust the protocol, as required, until the preview shows the required selection. 

7. You should check the protocol on a number of different timepoints before storing the measurements. 
This saves time and avoids making unnecessary measurements. 

To do this: 

 Display the Measurements View and the Navigation palette on the screen at the same time. 

 Set up the protocol, then use the Navigation palette (as described on page 82) to move between 
timepoints. Stop at intervals and Automatically Update Feedback will apply the protocol to the 
new timepoint. If the protocol is not applied when the timepoint changes, select Update Feedback 
from the Measurements menu. 

You can then see the effect on the Image View and adjust the protocol for a number of timepoints to 
obtain the best fit. 

Adding a Tracking Task to the Protocol 
1. To make the protocol track centroid position when objects are made in more than one timepoint, add 

the Track Objects task to the protocol.   
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The Track Objects task will always go to the bottom of the list of tasks in the protocol. It is not 
possible to add it between other tasks or to add other tasks after it. 

2. Click on the cog icon to access the secondary dialog for the Track Objects task.  

 
3. Select the appropriate options. These are described fully on page 377. For this example, we will 

select the Shortest Path and allow Volocity to calculate the Maximum distance between objects 
automatically. 

4. Click OK to close the dialog. 

5. Tracking will only be carried out if all timepoints are being measured. Either turn on Measure All 
Timepoints in the Measurements menu to see tracking in the Measurements View, or select Make a 
Measurements Item in the Measurements menu and ensure Measure: All timepoints is selected; 
this makes a Measurements item that contains tracks. 
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Note: Turning on Measure: All Timepoints in the Measurements View increases the amount of time 
taken to apply the protocol each time a change is made.  

6. When Measure: All Timepoints is turned on Volocity will apply the protocol to all the timepoints and 
track the centroid positions of the objects found. The Measurements table will show all the objects 
found in each timepoint and the tracks made from them. Select individual tracks to check and adjust 
the Track Objects task, if necessary. 
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Viewing the Results 
1. Open the Measurement item created above. 

The Raw table shows objects found in each timepoint and the tracks made from them with 
measurements relevant to each. 
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2. Choose Tracks from the Filter: drop-down to quickly view just the tracks. 
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3. Click directly on the Chart tab to show the tracks as plots of centroid position. 
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Select Edit Chart… from the Chart menu to change the type of chart and customize many features 
of its appearance. 
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Colocalization 
Colocalization is part of the Volocity Quantitation product designed specifically for Colocalization 
analysis as described by Manders et al (1993). See also page 412.  

Using the Colocalization View 
1. Open the image sequence containing the two channels to be analyzed. The two channels must be 

the same color depth. It is much easier to visualize colocalization if each channel has a different 
color. Colocalization does not operate on single volumes.  

2. Select the Colocalization tab. Set Channel X and Channel Y using the drop-downs. 

 
The preview image shows an extended focus merge of the two channels. Volocity calculates 
statistics, displayed under the preview, on the intensity information in the whole image. While 
Volocity is generating the scatter plot and calculating statistics a progress indicator is shown in the 
top right-hand corner of the view. 
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3. Working with the scatter plot on the right, set thresholds for each axis so that the lower threshold is 
above background. It may not be necessary to change the upper threshold.  

There are three ways of setting thresholds. 

 Use the ROI tool to draw a region of interest on the Preview. Select Set Thresholds from ROI 
from the Colocalization menu.  

 Enter the required values manually into the Threshold Maximum and Minimum boxes for each 
channel or drag the slider controls on the scatter plot.  

 Select Automatic Thresholding from the Colocalization menu to generate thresholds 
automatically. 

Any voxels of intensity outside threshold will be removed from the preview image for that channel. 
Any point on the scatter plot that is outside threshold for either channel will be removed from the 
scatter plot leaving only points that are positive for both x and y, that is, colocalized. 

If thresholds are not set, voxels where both images show background intensity levels may be 
interpreted as colocalized.  

4. Select voxels on the scatter plot to be analyzed.   

Select All and Select None in the Edit menu operate on the scatter plot. Use the shortcuts Apple-A 
on Mac OS and Ctrl-A on Windows to select all. 
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5. Colocalized voxels are shown in an overlay on the preview. 

If required, select sub-regions of the scatter plot for analysis. Use the ROI tools to draw a region of 
interest on the scatter plot. The preview will update so the overlay shows the location of just the 
selected, colocalized voxels. The statistics will also update to reflect the selected voxels. 

6. Create the colocalization output. 

Select Generate Colocalization from the Colocalization menu and choose to make the following 
output for the current timepoint or all timepoints in the image sequence.  

 
 Field statistics are measurements representing the whole volume rather than objects within it. 

One timepoint in an image sequence will give rise to one measurement row in the Measurements 
table. Colocalization statistics (Mx and My) are generated for regions of interest selected on the 
scatter plot as described at step 3.  

 

 The scatter plots are saved to a folder in the current library. Each scatter plot is stored as a 2D 
image and may be exported. 
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 A Colocalization channel is made from the selected colocalized voxels. These voxels are marked 
in the Colocalization View preview with the colored overlay. The channel is produced from a 
brightest point merge honoring the color and intensity of those voxels in the original channels. 
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Volocity Quantitation Reference 

Overview 
This is the reference chapter for Volocity Quantitation. For worked, step-by-step examples on 
measuring and analyzing data at a single timepoint and at multiple timepoints, please see page 148.  

This chapter describes: 

 The Measurements View  

 How to draw points, lines and ROIs to create objects manually 

 How to create measurement protocols and use them to select objects 

 Raw Data, Analysis and Chart Views 

 How to visualize and quantify colocalization between pairs of images 

 FRAP and FLIP analysis 

 Ratioing 

 FRET analysis 
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Measurements View 
To measure objects, they must first be identified. The Measurements View provides all the tools 
required to identify objects and make a variety of measurements from those objects. Use the Region 
of Interest drawing tools to manually draw around objects (see page 341), or create a measurement 
protocol using the Measurement Protocol tasks (see page 357). 

 

Image View 
This is an image view within the Measurements View. Options, such as Extended Focus, XYZ planes, 
Show/Hide time and Show/Hide color reference, in the Measurements menu allow you to configure 
this view in the same way as you would configure the Image View, see page 66. 

Measurements and Histogram 
The Measurements table provides numerical information about the objects found in the image 
directly above it. This numerical information is only shown while objects are selected either by a 
user-drawn ROI or a measurements protocol. 

Click on the Histogram tab to display the numerical information as a simple histogram, one column 
from the table at a time. Use the histogram to find patterns in a selected item property. 

Choose the data to be shown from the drop-down list of those available. 

measurement  
protocol tasks 

measurements are 
shown here as a 
table or histogram

build a  
measurement  
protocol in this 
pane 

image view will 
show object 
feedback  
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Measurements Protocol 
The most powerful tool for selecting and measuring objects is the Measurements protocol. You build 
a protocol by selecting measurements tasks in the lower half of the Measurements View and 
dragging them into the top left-hand pane. Descriptions of individual measurement tasks start on 
page 358. 

As tasks are added to the protocol, feedback updates to show the objects found as an overlay in the 
image and as rows of measurements in the table below. 

Drawing Objects to be Measured in the Measurements View 
Select objects to be measured in the Measurements View using tools for drawing regions, lines and 
points. 

Alternatively find objects by creating a Measurement protocol, see page 357. 

Using the Drawing Tools 
Drawing Lines with the Line Tool 

 
 

Use the Line tool to add lines in the Image View. Connect points by holding down the 
Shift key and clicking with the cursor. Release the Shift key to end a line. 

shortcut key = L 

You can also move between planes when specifying points in the line. This makes it easier to 
accurately identify the points between which a measurement is required. For example, the line will 
still be connected even if one end starts in the XY part of the view and the other end is marked in the 
YZ part.   

The total length of the line is shown as the line is drawn. Turn off this display in the View Options... 
dialog found in the Measurements menu. 

Line measurements are also shown in the table below the Image View. Export this table as a text file 
by selecting Export... from the File menu. Save this table by selecting Make Measurement Item... 
from the Measurements menu. 

Once drawn, you can move control points of lines by passing the cursor over a line. To do this the 
line tool must be selected. The cursor changes shape over a control point indicating that you can 
grab and move it. Again, this can be done in the most convenient part of the view including the 3D 
cross-section part. 
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As lines are drawn automatic feedback updates the table below the image to show the measured 
lengths. For each line a row is shown in the table below the image preview. The length of the line is 
shown uncalibrated and as calibrated units. Export this table as a text file by selecting Export... from 
the File menu. Save this table as an item in the library by selecting Make Measurement Item... from 
the Measurements menu. 
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Setting Up the Line Tool 
Volocity will assign a different color for each successive line automatically or 
you can specify a color. Click and hold on the Line tool to display the color 
picker dialog. Click on Automatic or click on either one of the displayed colors 
or use the Custom… dialog to specify a particular color. Note how the line tool 
reflects the color selected.  

To delete part of a line double click on a control point to highlight that section 
of the line and use the Backspace (Mac) or Delete (PC) key. To delete all the 
lines active on the view, use the Select None command in the Edit menu. 

 

 

Point Counting with the Point Tool 
Use the Point tool to count objects in the image. Select the Point tool and, for each click on the 
image area, a point count increments by one. 
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Change the color of the point tool by clicking on the menu next to the tool. A 
new color will start a new count at one. 

 

To delete a point, click on it to highlight it and use the Backspace (Mac) or Delete (Windows) keys. 
Other points of the same color will be renumbered. 

For each point, a row is shown in the table below the image preview. The position of the point as X, 
Y and Z coordinates is stored. All points of the same color are assigned the same population ID.  

 Export this table as a text file by selecting Export... from the File menu.  

 Save this table as an item in the library by selecting Make Measurement Item... from the 
Measurements menu. 

Drawing Regions Using ROI Tools 
Use these tools to draw a region of interest. The selected area will be outlined with "marching ants", 
a moving outline. Each object (i.e. contiguous block of voxels) within the ROI will be assigned a 
different color. Regions of interest are shown in the Image View using a colored overlay. Select View 
Options… from the Image menu to change this. 

For each object a row is shown in the table below the image preview. Some default morpholocigal 
and intensity information for each object is stored.  

 Export this table as a text file by selecting Export... from the File menu.  

 Save this table as an item in the library by selecting Make Measurement Item... from the 
Measurements menu. 

 
shortcut key = R 

The Rectangular ROI selection tool allows you to draw rectangles or squares, as 
illustrated in the following example. 
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shortcut key = F 

The Freehand tool allows you to make a freehand selection of an area on the image. 

 
shortcut key = S  

The Lasso tool allows you to trace the outline of a selection. It selects regions based 
upon the color similarities of adjacent pixels. The initial point clicked sets the color to 
compare and the tool has the effect of shrinking around the pixels that fall outside of 
the tolerance value. 

 
shortcut key = W  

The Magic Wand tool has the effect of expanding the selection outwards from the 
original pixel clicked on until the threshold set by the Setup Magic Wand is reached. 

 
The ROI stamp tool makes a selection by placing an ROI of a predetermined shape 
and size on the image, centered on the cursor position. This is useful for making ROIs 
of a known size and/or repeating a selection of a known size. 
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Setting Up the Magic Wand  
Double click on the Magic Wand tool to display the Setup dialog.  

 
Note: If you are trying to isolate regions of interest from background data, it may be easier to use the 
Wand tool to select the background, use the All objects criterion and then apply the Reverse 
Selection command in the Actions menu. 

Filter out noise in the selection will apply a 3x3x3 median filter. This will remove very small objects 
that are often described as noise and can add significantly to the time taken to make the 
measurement. 

Setting Up the Lasso Tool 
Double-click on the Lasso Tool in the tool bar to display a dialog in which you may adjust the 
Tolerance of the selection. 

 

if required, check to enable filter 

click to select one of the threshold 
criteria 

click to select only contiguous voxels, 
or all groups that meet criteria 
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Setting up the ROI Stamp Tool 
Double click on the ROI Stamp Tool to display the Setup dialog. 

 
The size of the ROI may be set in pixels or micrometers. An ROI size set by micrometers will vary in 
the number of pixels depending on the calibration of the item. 

Target Channel 
The Magic Wand and Lasso tools work on voxel intensity. So, within multi-channel data sets in an 
image sequence, the size and shape of the selection made by the tool can be very different 
according to which channel is targeted when the selection is drawn. Use the target channel button in 
the Navigation palette to choose the channel on which the selections will be made. See page 82 for 
more information about working with the Navigation palette.  

 

target channel 
button
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The following example shows the selection made if the magic wand is clicked when the red channel 
is targeted. 
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In the following example the magic wand is clicked at the same location, but the selection is different 
because the green channel is now targeted. 
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Working with Regions 
Once you have selected an ROI, you can also use the Copy, Cut, Paste and Clear commands from 
the Edit menu. The Crop to Selection command in the Actions menu will reduce the data set to 
what is contained within the ROI. When cropping, the selection is always simplified to the smallest 
straight-sided shape that will contain the selection made, even if you have used the Freehand or 
Magic Wand tool. 

ROI menu  

The sub-menu ROI under the Edit menu contains commands for working with ROIs once they have 
been drawn. 

 Undo to undo the last change made to an ROI 

 Redo to redo the last change made to an ROI 

 Save to store the currently active ROI as a settings file in the preferences 

 Restore to recall a previous stored ROI and apply it to the current view 

 Grow to expand the ROI by one voxel in all directions 

 Shrink to reduce the ROI by one voxel in all directions 

Key combinations 

The following key combinations also apply: 

Mac OS key combinations 

 Control-drag on a selection centers the selection on the image.  
 Command-drag locks the dimensions, to make a square or circular selection rather than 

rectangular or oval. 
 Shift allows you to add to the ROI or draw multiple ROIs. 
 Shift + alt (option) allows you to subtract from the ROI or subtract the whole of the existing ROI 

by drawing around it.  
 Alt (option) carries out an AND operation leaving only the intersection of the two ROIs. This 

allows you to select in one part of the XYZ view and refine the selection based on what can be 
seen in another part.   

Windows key combinations 

 Shift allows you to add to the ROI or draw multiple ROIs. 
 Shift + ctrl allows you to subtract from the ROI or subtract the whole of the existing ROI by 

drawing around it.  

 Ctrl carries out an AND operation leaving only the intersection of the two ROIs. This allows you to 
select in one part of the XYZ view and refine the selection based on what can be seen in another 
part.   
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Object Feedback 
As objects are selected in the image, feedback is shown both in the image and in the table. You can 
relate measurement rows to objects shown in the image.   

 To show which object in the image is represented by a row in the table, select the row. Visual 
feedback for all other objects will be hidden, leaving just the selected object shown. Deselect the 
row in the table to return to showing all objects again. 
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 To find measurements for objects use the Select object tool from the tool bar. The cursor 
changes to a pointing hand when it is over voxels which have been measured as part of an object, 
click to select the object, scroll to the relevant row in the measurements table and select the 
measurement row. 
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Measurements Menu 
Many of the options in the Measurements menu are identical to those in the Image View. These 
allow you to configure the image to assist in object selection. You can change how the image is 
displayed and, for 3D data, switch between XYZ and Extended Focus. 

 
The rest of this section describes those menu options that are specific to measurement. 

Measurements Feedback Options 
In the Measurements View the location of objects selected in the image is shown using feedback. 
The updating of feedback is set by the Automatically Update Feedback option in the 
Measurements menu. The visual appearance of the feedback is controlled by the Feedback 
Options... in the same Measurements menu. 
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Change the feedback options to show feedback and images more clearly together and to illustrate 
specific points. 

The Feedback Options dialog is divided into tabs, one for each type of measured item that could be 
shown and the changes that can be made to their display. 

You may choose to show each type of feedback or not, and there are sub options within each tab. 

 
 Show in current timepoint only is an option for viewing feedback within time resolved data. 

When this option is checked only feedback that relates to measurements made from the current 
timepoint will be shown. Changing the timepoint using the Navigation palette will change the 
feedback so that only objects in the new timepoint are shown. 

 Show measurement will allow any of the measured parameters to be shown alongside the 
colored shape which represents the measurement. 

To change the appearance of an ROI drawn on a view use the ROI tab in the View Options dialog for 
that view. 
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Measurement View Options 
Change aspects of the view display using the View Options dialog. 

The dialog is divided into tabs for the different features on the view that are to be displayed. 

 
Line length and ROI options refer to objects selected in the Measurements View. 

To change how objects selected by a measurements protocol are displayed in the view, use the 
Feedback Options dialog also available from the Measurements menu. 

Make Measurement Item 
Use Make Measurement Item… to create a new table item in the library containing the 
measurements as previewed in the Measurements View. 

 
A new measurement item may be created and named or the measurements may be added to an 
existing measurement item to build up a table of data. 

For time-resolved data you may select measure all timepoints in the Make Measurement Item dialog, 
even if the measurements have only been previewed on one timepoint. 
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Measure All Timepoints 
When this option is checked ROI or selections active in the view will be applied to all timepoints in 
the dataset and the measurements previewed in the table will be from all timepoints. This can take 
time to apply; therefore, this option may be checked or unchecked. Measurement operations that rely 
on the time component of the data will not be previewed in the Measurements View unless this 
option is checked.  

Hide Measurements 
Allow the image to be displayed in a larger window by hiding the Measurements table, if not required.  
Hide measurements changes to Show measurements to allow the table to be revealed again. 

Measurements and Histogram 
The Measurements table provides numerical information about the objects found in the image above. 
This numerical information can also be displayed as a simple histogram by clicking on the Histogram 
tab. 

This numerical information is only shown while objects are selected either by a user drawn ROI or a 
Measurements protocol.   

 Store measurement information by creating a measurement item; select Make Measurement 
Item... from the Measurements menu. 

 Choose to Hide or Show Measurements from the Measurements menu to hide this table. 

 Show only the measurements of a particular type, objects, lines or points by selecting from the 
drop-down at the top of the table. 

 Sort the table by the contents of one column by clicking on the column heading, click again to 
reverse the sort. An arrow in the column header indicates that this column is sorting the data. 

 Modify the columns shown by checking or unchecking column headings in the Columns dialog. 

 Rearrange columns by clicking on the column heading and dragging that heading to another 
position, a red insertion line shows where the column will be placed. 

 Fit the column widths to the data enclosed by selecting Autosize Columns from the 
Measurements menu. 

Histogram Tab 
Click on the histogram tab to switch to a histogram that displays one column from the table at a time. 
Use the histogram to find patterns in a selected item property. 

Choose the data to be shown from the drop-down list of those available. 
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Creating Measurement Protocols 
Measurements protocols are the most powerful tools for selecting and measuring objects. Protocols 
are made up of tasks and are built by dragging tasks from the list into the protocol area. Feedback 
into the view shows where objects have been found and lists numerical information about those 
objects. Measurements protocols start with ‘Find Objects’ tasks, after which the selection is refined 
by the addition of further tasks.  

The order of tasks affects the result. Tasks lower down in the list work only on the results of tasks 
higher up in the protocol. The task flow is indicated by an arrow. 

 



Measurement Protocol Tasks 

 

358   Improvision 

A set of tasks starting with a “Find Objects” task is known as a series. It is possible to have more 
than one series in a single protocol. 

 

Measurement Protocol Tasks 
Protocol tasks are listed alphabetically in the task list.  

 Drag and drop the task name from the list to add to the protocol. The insertion point shows where 
the task will go.  

 Double click on a task name in the list to add it straight to the bottom of the list.  

 Move tasks around by dragging and dropping, the insertion point is shown. 

 Remove a task from the list by clicking the cross. 
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Some information is in the primary task area and always displayed. There may be additional 
information; this is accessed by clicking on the cog icon to show a secondary dialog. 

 

 

Clip Objects to ROI 
Objects must have been found earlier in the protocol. 

 
Drawing a region of interest in the image and using this task will clip the result to the bounds of the 
ROI. This may mean some objects are cropped. 

Use with Exclude Objects not Touching ROI to ensure that any objects that intersect with the ROI 
are included. 

Color Objects 
When objects are found they are shown in the image area of the view using a colored overlay. By 
default each separate object identified is given a different color. It may be useful when working with 
objects to color them in a different way.  

 
Use Color Objects in a series to apply a specific way of coloring a set of objects. Use anywhere 
below a find object task but above any measure task. 

Combine Objects 
This task merges the objects found by one series of measurements task with the objects found by 
another series. 

Primary task 
dialog 

Click cog to view 
secondary dialog 
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The first series of objects must include a Retain Objects task that names the first set of objects so 
that they can be specified in this task. 

 

Exclude Non-Touching Objects 
This task keeps only those objects in a second series that touch objects in a first series. 

The first series of objects must include a Retain Objects task that names the first set of objects so 
that they can be specified in this task. 

 

Exclude Objects by Shape 
Objects found earlier in the protocol can be removed if they do not meet criteria for shape. This task 
would be used later than a Find objects task in a measurements protocol. 

Select the required shape from the drop-down list: either one of the predefined shapes or the Custom 
Shape.   

 
Custom shape: Custom shape allows you to create bespoke shapes using the XY, XZ and YZ cross 
sections through an ellipse, rectangle or triangle. The custom shape is saved when the protocol is 
saved. 

To create a custom shape, select Custom shape from the drop-down menu and click on the button 
to launch the Shape Preview window. Select the axes and use the slider controls to adjust values 
manually. 
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Ellipse and Rectangle: When the XY slider is set to the central point the ratio between the X and Y 
axis (or X and Z) is 50-50. As the slider is moved towards X, the length of the X axis will reduce and 
increase in Y and vice-versa. The same rules apply for the XZ sliders. The YZ ratio is taken from the 
XY and XZ controls. 

Triangle: It is possible to skew the angles of the triangle to achieve all possible dimensions from an 
equilateral triangle (the slider is set at the central point) to a right-angled isosceles triangle (the slider 
is set to the extreme right or extreme left). 

Exclude Objects by Size 
Objects found earlier in the protocol can be removed if they do not meet criteria for size. This task 
would be used later than a Find objects task in a measurements protocol. 

The task excludes objects greater than or smaller than a defined size. 

 

Exclude Objects not Touching ROI 
Objects must have been found earlier in the protocol. 

Drawing a region of interest in the image and using this task will show only objects that intersect with 
the ROI. 
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Exclude Objects Touching Edge of Image 
Objects must already have been found by the protocol. This task will remove any of those objects 
touching the edge of the sample in the X,Y or Z planes. On datasets with small Z dimensions, this 
may remove too much from the selection. 

When working with 2D data the Z dimension is not considered as the edge of the image because this 
would mean every object would be excluded. 

 

Exclusively Combine Objects 
The first series of objects must include a Retain Objects task that names the first set of objects so 
that they can be specified in this task. 

The result shows just those areas where the objects from one series are found, not both. 

 

Fill Holes in Objects 
Objects must have been found using any of the Find Objects tasks earlier in the protocol. 

If any of the objects identified have holes in them, this task will fill those holes provided that they are 
surrounded in all dimensions by a contiguous wall of voxels. For example, a hardboiled egg has a 
white that completely surrounds the yolk. So, the yolk is completely surrounded on all sides. 
Therefore, if you select the white and fill holes, the whole volume of the boiled egg will be selected 
including the yolk. 

 

Filter Measurements 
Objects that have been found by the protocol are listed in the table below the image. If this table is 
not visible choose Show Measurements from the Measurements menu. 

The list of objects found may be further refined by filtering on any of the measured parameters. 
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Find Objects by % Intensity 
Find Objects tasks select voxels according to intensity or color information. This task selects voxels 
according to % intensity.  

Intensities within the current volume are represented as a percentage considering the highest 
intensity value in the volume as 100%. This removes the need to select by absolute intensity values 
and may work better for time resolved data sets. 

The primary task shows text entry boxes to set the lower and upper limit of the selection. 

 
Click on the cog icon to show the secondary dialog. This shows a histogram of the current volume. 
Number of voxels is along the Y-axis; color or intensity values are along the X-axis.  

 
Click on the vertical red lines in the histograms and drag them to change the selected range of 
values. 

Change the Y-axis of the histogram to see detail more clearly, cycling through four possible 
resolutions; linear, log, base 10 and base 100. To do this: 

PC: Ctrl-click in the histogram area 
Mac: Alt-click in the histogram area 
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Select all Values. Select this tool to display the maximum range of values for the threshold 
mode that you have selected. 

Invert Region of Selection. Select this tool to reverse the area of selection on the histogram. 

Get From ROI will set the minimum and maximum thresholds to the minimum and maximum 
intensity value found within an ROI active on the Image 

Find Objects by Intensity 
This task selects voxels according to specified intensity threshold values.  

The primary task shows a histogram of the current volume. Number of voxels is along the Y-axis; 
intensity values are along the X-axis.  

 
Click on the vertical red lines in the histogram and drag them to change the selected range of values. 
Tooltips show the intensity values. 

  
The secondary dialog shows a larger histogram of the current volume. Text boxes allow direct entry 
of intensity values for the thresholds. 
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Click on the  vertical red lines in the histograms and drag them to change the selected range 
of  values. 

Change the Y-axis of the histogram to see detail more clearly, cycling through four possible 
resolutions; linear, log, base 10 and base 100. To do this: 

PC: Ctrl-click in the histogram area 
Mac: Alt-click in the histogram area 

Select all Values. Select this tool to display the maximum range of values for the threshold 
mode that you have selected. 

Invert Region of Selection. Select this tool to reverse the area of selection on the histogram. 

Get From ROI will set the minimum and maximum thresholds to the minimum and maximum 
intensity value found within an ROI active on the Image 

Find Objects in ROI 
This task will incorporate the objects within an ROI into the protocol. This allows those objects to be 
included in later processing. 
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Find Objects Using HSI 
This task selects voxels according to HSI color information.  

The primary task shows three histograms of the current volume. Number of voxels is represented 
along the Y-axis; hue, saturation and intensity values are along the X-axis in each histogram. 

  
Click on the red vertical lines in the histograms and drag them to change the selected range 
of  values. Tooltips show values. 

The secondary dialog shows a larger histogram of the current volume.  

Text boxes allow entry of values as an alternative means of setting thresholds. 
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Click on the red vertical lines in the histograms and drag them to change the selected range 
of  values. 

Select all Values. Select this tool to display the maximum range of values for the threshold 
mode that you have selected. 

Invert Region of Selection. Select this tool to reverse the area of selection on the histogram. 

Get From ROI will set the minimum and maximum thresholds to the minimum and maximum 
values found within an ROI active on the image. 
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Find Objects Using RGB 
This task selects voxels according to RGB color information.  

The primary task shows three histograms of the current volume. Number of voxels is represented 
along the Y-axis; red, green and blue intensity values are along the X-axis in each histogram  

Click on the red vertical lines in the histograms and drag them to change the selected range of 
values. Tooltips show values. 

 
 

 

A secondary dialog shows larger histograms, which 
because of the increased scale may be easier to use for 
fine adjustments.  

 

Number of voxels is shown along the Y-axis; color or 
intensity values along the X-axis.  

 

Text boxes allow entry of values as an alternative means of 
setting thresholds. 
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Click on the vertical red lines in the histograms and drag them to change the selected range of 
values. 

Select all Values. Select this tool to display the maximum range of values for the threshold 
mode that you have selected. 

Invert Region of Selection. Select this tool to reverse the area of selection on the histogram. 

Get From ROI will set the minimum and maximum thresholds to the minimum and maximum 
values found within an ROI active on the image. 

Find Objects Using SD Intensity 
This task selects voxels according to intensity information.  

Intensities within the current volume are represented as standard deviations above or below the 
mean intensity. This removes the need to select by absolute intensity values and may work better for 
time resolved data sets. 

The primary task shows text entry boxes to set the lower and upper limit of the selection in numbers 
of standard deviations. Positive values are above the mean, negative values are below the mean. 
Uncheck the upper or lower limit boxes to allow everything above or below a set point to be selected. 

 
Click on the cog icon to open the secondary dialog for this task. The secondary dialog shows a 
histogram of the current volume; number of voxels is along the Y-axis, color or intensity values are 
along the X-axis. Superimposed over the histogram is a curve (in green) showing the normalized 
intensity. Vertical green lines are shown at the mean intensity and at each standard deviation above 
and below the mean. Data may, therefore, be thresholded based on a set number of standard 
deviations around the mean.  
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Set lower and upper limits by entering the value of standard deviation at which the limit is to be set. 
The mean intensity is at 0 standard deviations and standard deviations below the mean intensity 
have negative values. 

 
Click on the red vertical lines in the histograms and drag them to change the selected range of 
values . 

Select all Values. Select this tool to display the maximum range of values for the threshold 
mode that you have selected. 

Invert Region of Selection. Select this tool to reverse the area of selection on the histogram. 

Get From ROI will set the minimum and maximum thresholds to the minimum and maximum 
values found within an ROI active on the image. 

Group Measurements 
This task identifies a set of measured objects, points or lines with text in an additional column in 
measurement tables. This column can be used to identify the measurements as a group, even after 
tables have been exported as text. 
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Internalize Measured Objects 
Objects found by one series will be related to the objects found by another series according to one 
set of objects being inside or outside the other. 

 
Objects from the second series that are within the same object from the first series will be given the 
same parent ID. 

The first series of objects must include a Retain Objects task which will name the first set of objects 
to enable them to be specified in this task. 

Intersect Objects 
Objects are found by one series, a second series finds a different population. Intersect objects will 
find just the areas where both sets of objects overlap. 

 
A Retain Objects task must be used in the first series to name the first set of objects to enable them 
to be specified in this task. 

Invert Objects 
This task will invert the selection made by the series so far. This may be useful in situations when it 
is easier to select background or unwanted objects and reversing the selection serves to select the 
required objects. 

 

Measure Lines 
This task ensures that line measurements are recorded. 

Draw lines using the line tool available from the tool bar. As lines are drawn the line length is 
displayed in the Measurements table below the image. This is the default display. 

The default display may change as other objects are found and the line measurements will no longer 
be displayed. If they are no longer displayed in the table below the image, they will not be recorded 
in any measurement item created unless you include a Measure Lines task in your protocol. 
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The secondary dialog of the Measure Lines task shows checkboxes to select the measurements to 
be made. Currently, line length is the only measurement available for lines. 

 

Measure Object Colocalization 
Colocalization in the context of digital fluorescence imaging can be described as the detection of 
signal at the same voxel location in each of two channels. The two channels are made up of images 
of two different fluorochromes taken from the same sample area.  

 
Measure Object Colocalization will calculate the colocalization coefficients Mx and My for each 
object found by the series. Click on the cog icon to access the secondary dialog and configure the 
task. 

 
In the secondary dialog select the channels to be colocalized. 

Thresholds are essential. Enter the intensity values for each channel. Voxels with intensity values 
below the minimum threshold and voxels with intensity values above the maximum threshold will be 
excluded from the calculations. Use minimum thresholds to remove intensities in each channel that 
are not significant in a determination of colocalization. 
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To measure morphological and intensity information from objects include a Measure Objects task as 
well as the Measure Object Colocalization task. Configure the secondary dialog of the Measure 
Objects task to record the required measurements. 

 
Alternatively, configure the colocalization view for the data set before working with the 
Measurements View and click Get settings from view to use these settings in the task. 

See also the section on Colocalization starting on page 412. 

Measure Objects 
Objects are selected either by using the ROI tools available from the tool bar or by using Find 
Objects task in a measurement protocol. 

As objects are selected, measurements are displayed in the Measurements table below the image. 
This is the default display. For each object found the table will display: 

 Voxel/Pixel count 

 Volume (µm3)/Area (µm2) 

 Min, Max, Mean and Sum intensity values. Each channel in the data set will have a set of 
intensity columns. 

 Centroid position in pixels and micrometers 

 Surface Area (µm3)/Perimeter (µm2) 
The default display may change as other objects are found and the object measurements will no 
longer be displayed. If they are no longer displayed in the table below the image, they will not be 
recorded in any measurement item created. 
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Ensure the measurements required are recorded or change the measurements to record by using a 
Measure Objects task. 

 
Intensity measurements ignoring zero are useful when working with data where background values 
are always zero. This occurs after certain processing steps, for example ratio and FRET calculations. 

A Measure Objects task may also be used partway through a protocol to record measurements at 
that point and again later to measure a new set of measurements. 

Once the Measure Objects task is included, default measurements will not be generated. 

The centroid of an object is the unweighted centre. It is calculated by taking the average position of 
the voxels making up the object. Thus, the average x coordinate of the voxels determines the x 
coordinate of the centroid and the average y coordinate of the voxels determines the y coordinate of 
the centroid. 

Surface area of objects is measured by fitting a “skin” to the surface of the mask layer identifying the 
object at the voxel level. Triangles are then fitted to each cluster of voxels on the surface of the 
object. The area of each triangle is measured; the sum of triangle areas for each object gives the 
surface area. There is no surface simplification for measurement. It is important, when using any 
measurement. to ensure that results are statistically significant compared to any measurement error 
or noise. This is especially important with surface area measurements where noise and surface 
features can have a considerable impact on the measurement. 

Measure Points 
Mark points using the point tool available from the tool bar. 

As points are marked, the point location is displayed as a coordinate in the Measurements table 
below the image. This is the default display. 

The default display may change as other objects are found and the point positions will no longer be 
displayed. If they are no longer displayed in the table below the image, they will not be recorded in 
any measurement item created. 
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Ensure the point locations are recorded by using a Measure Points task in the protocol. 

 
The secondary dialog of the Measure Points task shows checkboxes to select the measurements to 
be made. Currently, Position is the only measurement available for points. 

 

Measure Skeletal Length 
This is an additional measurement that may be made from objects. 

 
Skeletal length is calculated by first thinning or skeletonising the object from all sides until a single 
voxel line is left. This measurement is best suited to elongated shapes. The direction of the line is 
elongated to meet the edges of the object and the length of this line is the skeletal length. For objects 
where the skeleton branches, the skeletal length is measured as the longest traverse across the 
object without crossing a point more than once. 

Skeletal diameter is the diameter of a cylinder if it had a length equal to the skeletal length of the 
object determined as above and a volume equal to the object’s measured volume. 

It is derived using the equation for the volume of a cylinder.  

V = Pi r2 *l 

Remove Noise from Objects 
Use this task to apply a median filter to the selection already made. The selection is made by a Find 
Objects task earlier in the series. 

 
The size of the filter applied is selected in the drop-down on the task. 
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From the smallest fine filter to the largest very coarse, the median filter matrix is increased in size. 
The time taken to apply the filter and the degree of filtering also increase. 

 

Retain Objects 
This task retains the objects found by that point in the protocol in a temporary way solely during the 
running of the protocol. 

 
Filling in the name field allows the set of objects to be used later, by for example Intersect and 
Combine Objects tasks that process the output of one series of measurements tasks with the output 
of a previous series that has been retained. 

Restore Objects 
This task updates the selection to show any objects that have been retained as a set previously. 

 

Separate Touching Objects 
This function can assist in the separation of two or more objects that a Find Objects task has 
identified as one. The distance of each voxel from the surface of the selection is examined and, if the 
distribution of the voxels indicates that two or more objects are present, a one-pixel thick row of 
voxels is removed between them to create separate objects.  

 
The minimum size guide may be optionally set to the typical size of a single object. This refines the 
task by preventing separation if the distance between two new objects would be too small. 

Subtract Objects 
Subtract the area masked by the retained objects from one series from the objects found in the 
current series. 
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Track Objects 
This task is particular to time resolved data. The Track Objects task will place itself at the bottom of 
any protocol since objects must be found before they can be tracked. 

 
The Measurements View shows only the protocol as applied to the current timepoint by default. It 
may be useful to turn on Measure All Timepoints in the Measurements menu to preview all the 
measurements over time and the tracks. 

The Volocity tracking algorithms operate on centroid positions. A track is generated by connecting 
centroids to trace the path of a moving object. Different models are used to identify the most likely 
position for each object being followed in each timepoint. 

 
The Shortest Path model attempts to create tracks based on the criterion that the chosen matches 
between the populations of object centroids in any pair of timepoints have the minimum physical 
distance between them. 

The Trajectory Variation model uses the Shortest Path model to first establish a likely track for an 
object between centroids in timepoint 1 and timepoint 2. The next centroid position of that object is 
determined by that which is consistent in both direction and speed. This model should be effective for 
objects that cross paths.  



Measurement Protocol Tasks 

 

378   Improvision 

When the Trajectory Variation model is selected, the Trajectory Variation slider is used to alter the 
sensitivity of the algorithm to variation. Lower trajectory variation restricts the calculated tracks to 
smoother trajectories. If this value is set too low, tracking may fail to find any valid tracks. 

Other Options 

 If required, enable the Ignore Static Objects and Ignore New Objects checkboxes. 

 Restrict track start position to ROI requires an ROI to be drawn on the image. When this 
option is checked, tracks will only be measured if they start with the drawn ROI. 

 Automatically Join Broken Tracks is a feature that allows tracks to be continued, even if the 
object was not detected in periods of up to two consecutive timepoints along the trajectory.   

 With Automatically Join Broken Tracks off, the default setting, a track will terminate if a 
timepoint is reached where no centroid can be found that is likely to be part of the track based 
on the restrictions determined by the parameters entered in the Track Objects dialog. 

 When Automatically Join Broken Tracks is on the tracking algorithm will join a partial track 
to another partial track beyond the missing section as long as the whole track has a 
consistent trajectory. 

It may be appropriate to allow Volocity to Automatically Join Broken Tracks where objects 
have not been measured in all timepoints along their path length. An object may fail to be 
detected in a timepoint because of factors such as noise or inconsistent illumination.  

Users may also join tracks manually after the creation of a measurement item using the Join 
Objects option in the Raw menu. See page 385. 

 Maximum distance between objects must be set for both tracking models. 

 Estimate automatically: Volocity will calculate a maximum, effective matching distance to 
use as an upper bound for possible motion tracking between timepoints in a sequence based 
on the size of the dataset (¼ of the diagonal of the volume). 

Volocity will then attempt to make a shortest path matching between the first two timepoints 
using this calculated upper bound. The maximum distance between objects calculated for this 
dataset is the average distance between all the matched object centroids in the first two 
timepoints plus one standard deviation. This value is then used for the maximum distance 
throughout the data set. The text box for Use this distance mode displays the last used value 
for the maximum distance between objects, including when this value was estimated 
automatically. This feedback may be referred to when refining tracking parameters. 

 Use this distance: Volocity will use the user-specified distance as the maximum limit for 
matching object centroids between timepoints. 



VOLOCITY QUANTITATION REFERENCE 

February 2008   379 

Tip: Establish a maximum distance to set by scanning the time series and choosing two timepoints 
between which the greatest movement is apparent. Obtain a value to enter in the Track Objects 
dialog by measuring this movement using the line tool. Adjustment to this distance can be made for 
subsequent measurement, if required.  

The tracking algorithm assigns a tracking ID to objects. If it determines that an object in a timepoint is 
the same as an object in a previous location, it gives that object the same ID. The track (or line 
connecting all the objects with that ID) also has the same ID.  

Viewing Tracks 
Tracks measured are added to the same Measurements item as the objects. Use the quick filter 
drop-down to view only tracks.   

 
Select a track row in the Measurements Item to show feedback of the track within the image data 
that it came from. If that data is open to a view that supports feedback, the objects associated with 
that track, objects with the same tracking ID, will also be shown as Measurements feedback. 

Use the feedback options to show or hide the objects or to show the objects only in the current 
timepoint. This is useful of you want to make a movie showing the objects moving along their tracks. 

Manually Track Objects (Tools menu) 
When it is not possible to use Volocity's automatic tracking algorithms to track moving objects within 
a time-resolved data set, manual tracking will allow you to create track objects in a Measurement 
item by manually marking the object location in each timepoint. 

Open the image sequence containing the data you wish to track. 

1. View the Image or Measurements View. These views allow use of the point and ROI tools which are 
needed to mark object locations. 

2. Select Manually Track Objects from the Tools menu. 

3. Follow the instructions given by the Manual Tracking wizard. 

Clear, Save, Restore and Export Protocol 
 Select Clear Protocol from the Measurements menu to remove a protocol from the 

Measurements View without saving it. 
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 Select Save Protocol… from the Measurements menu to save a protocol and use it again in the 
future. Protocols are stored as preferences at user level.   

 
 Select Restore Protocol… from the Measurements menu to restore an existing protocol and use 

it with the active Measurements View. 

 
You can also use this dialog to manage protocols. It allows renaming and deletion of existing 
protocols. Use Import… to add a protocol exported as a settings file (.assf extension) to the 
protocol on the system. 

 To share protocols with other users, click Export… on either the Save Protocol dialog or the 
Restore Protocol dialog. This will create a settings file, with the extension .assf. Settings files are 
not recognized as protocols unless they are imported. 
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Applying Saved Protocol Batch Processing Measurements 
1. Select Measure… from the Tools menu. 

 
2. Select the protocol to be applied to the selected items from the drop-down menu, which lists all 

saved protocols by name. 

3. Either, select Store the measurements in a new measurement item called: and enter a name for 
the Measurement item that will contain all the measurements made by the selected protocol on the 
selected items. Or, select Add the measurements to this existing measurement item: and 
choose from the measurement items that already exist in the library. In this case, all the 
measurements from all the selected items will be added to the measurements already in the table. 

4. For each task in the protocol that operates on a specific channel (i.e. the Protocol dialog contains a 
drop-down for channel selection when the task is configured), there will be an entry under Apply the 
protocol’s tasks to these channels: The drop-down lists the unique channel names found within 
the selected items. Channels with the same name will all be processed. 

5. The Measurement item created will contain all the measurements made on all the selected items. 
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Measurement Items 
Make Measurement Item 

Once you are happy with the measurements from points, lines and regions marked on the 
Measurements View, use Make Measurement Item… from the Measurements menu to record 
measurements. 

 
Volocity records measurements to the specified Measurement item. You can then view the 
measurements as a table. This table has a number of views. 

A Measurements item is also created when a saved protocol is applied to selected items in the 
library (using the Measure dialog from the Tools menu). 

Note: The FRAP Analysis... command in the Tools menu generates a measurement 
item.  Designed specifically for FRAP analysis this measurement item will appear different from one 
created by other measurement actions in Volocity and you will interact with it differently. See “FRAP 
Measurement Item” on page 429. 
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There are now three stages that you can work through to extract patterns or trends from image data. 

 Organize and filter the raw data so that it is ready for analysis. 

 Analyze the raw data.  

 Chart the results. 

Raw Data View 
The initial table view shows the Raw measurement data.  

 
There are a number of ways of organizing and filtering the raw data so that you can review it before 
analysis. 

Working with Columns 
Column headings show which measurements were made. N/A in a column means the data is not 
available. For example, if a session contains both line and region measurements, Total Length is 
not a relevant measurement for a region so that column will have N/A against all region rows. 

 To reorganize columns click the column heading, drag it to its new position and release.  

 To sort columns click on the column heading—an arrow shows that the column is sorted and the 
direction of the arrow indicates whether the sort order is ascending or descending. Click again to 
reverse the sort. For example: sort on the Name column to group together the same types of 
measurement. Sort on the Voxel Count column to find the largest and smallest objects. 

 To change the width of a column click on the cell border and drag.  
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 To resize all columns to fit contents, select Autosize Columns from the 
Raw menu. 

 To hide/show columns select Columns… in the Raw menu.  
All columns that can currently be shown will be displayed in the dialog. 
To show a column, check the box corresponding to the column name 
and click OK. (Click Hide All or Show All to uncheck/check all boxes 
respectively.)  

Filter 

Set up filters to hide unwanted data. Quick filtering on the basis of type of measurement can be 
achieved with the Filter drop-down. Choose to show just object measurements or just line 
measurements. 

 
For more advanced filtering select Filter... from the Raw menu or click on the filter button at the top 
of the window. 

 
Filter out rows by selecting the column to filter on and entering values to select by. And/Or 
expressions are permitted, as is the use of brackets. 

Click on the Save... button to save a filter as a preference to easily access the same criteria again. 



VOLOCITY QUANTITATION REFERENCE 

February 2008   385 

Once a filter is applied the number of filtered measurements is displayed. To cancel a filter open the 
Filter dialog and click Clear.  

Extract or Merge Data 
You can create new Measurements items from existing items by combining their contents. 

Where applying a filter has created a new table that you would like to process further, use Extract 
Filtered Data... from the Raw menu to create a new Measurement session containing just that data. 
Name the new Measurement Item to be created. 

To add the contents of the current table to a Measurement Item that already exists in the library use 
Merge Data...This tool allows you create tables that are combinations of other data. 

 Remove duplicate rows will ensure that the same measurement is not repeated. 

 Merge similar rows will ensure that different measurement criteria, indicated by the column 
heading, for the same object are kept in one row, not spread over two or more. 

Join Objects 
This feature can be used to join two or more objects, polylines or tracks. Any number of objects can 
be joined.  

Select the objects to be joined in the table and click Join Objects in the Raw menu. A new object will 
be created in the table, consisting of the union of all selected objects. 

Note that this object may be non-contiguous, that is, it may contain two distinct areas which do not 
touch. However, for the purposes of measurement and feedback it is considered to be a single object. 
This new object will be re-measured, with all the appropriate measurements. Note that the previously 
selected objects are not deleted or altered in any way. 

  
Measured lines can also be joined using this command when two or more lines are selected in the 
table. The ends of each line which are closest to each other are joined together, creating a single line. 
This new line is added to the table and re-measured. Again, the previously selected lines are not 
deleted or altered. 
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Finally tracks can also be joined, but only under certain circumstances. Two tracks which track an 
object through the same timepoint cannot be joined. For example: if Track A tracks an object from 
timepoint 1 to timepoint 5, and Track B tracks an object from timepoint 5 to timepoint 9, the tracks 
cannot be joined, as they both track an object through timepoint 5. 

If Track C tracks an object from timepoint 1 to timepoint 4, then it can be joined with Track B. The 
tracks do not share a timepoint. If the tracks selected cannot be joined, the command will be disabled 
in the Measurements menu. Any number of tracks can be joined, providing that no two selected 
tracks share a timepoint. 

  
When two or more tracks are joined, a new track is created in the Tracking table. This track is 
assigned a new Tracking ID, and is re-measured for length, velocity, etc. All objects which were 
previously associated with the selected tracks are now only associated with the new track, and their 
tracking IDs will all be reassigned to the new track.  

Note that this does not delete or alter the tracks previously selected; however the objects previously 
associated with them will now be associated with the new track instead. 
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Exporting Measurements 
Once you have created a Measurements table, you can also export the measurements. Select 
Export from the File menu and select the required file format.   

.  

Feedback from the Raw View 
If a row in the Raw View of a Measurement Item corresponds to a single measured object, its 
location in the original image data can be shown using feedback. When the row is selected the object 
will be shown using colored feedback in any open Image, Measurements or 3D View (if available) of 
the data from which that measurement was made. 

Select measurements in a view by clicking on a row, shift and click to select multiple rows. 
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Open the corresponding image data, usually an image sequence, and the feedback will be shown. 

 
 

To control how feedback is displayed: 

 Use the Feedback Options… command in the Measurements menu to define the feedback 
display.  

 Use the Change Object Colors… command in the Raw menu to define the color of object 
feedback.  
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Feedback Options Dialog  
The Feedback Options dialog is tabbed, with one tab for each type of measurement object that may 
be present in the table. The types available vary with different software products in the Volocity 
family. 

Each option changes how the feedback will be shown in views of the original data that support 
feedback display. 

 
Use these options to change how the feedback appears:   

 Show in current timepoint only is an option for viewing feedback within time resolved data. 
When this option is checked only feedback that relates to measurements made from the current 
timepoint will be shown. Changing the timepoint using the Navigation palette will change the 
feedback so that only objects in the new timepoint are shown. 

 Show measurement will allow any of the measured parameters to be shown alongside the 
colored shape that represents the measurement. 

Note: Some options do not take effect for feedback shown in 3D views. All feedback in 3D views is 
shown as solid isosurfaces. 
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Change Object Colors 
This dialog changes the color used to represent the selected objects with this dialog. 

When Rainbow colors is applied, all selected objects or tracks will be colored according to their 
position in the table. Objects at the top of the table will be colored red; objects further down the table 
will step down through the visible spectrum, with objects at the bottom colored violet. 

This feature can be used to color objects according to any attribute measured by Volocity. The 
following example colors objects according to their measured volume.  

1. Click on the header at the top of the Volume column to order all objects in the table by their 
measured volume. 

2. Select all the objects in the table that you wish to recolor and select Change Object Colors… in the 
Measurements menu.  

3. Select Use Rainbow Colors and click OK. 

The color coding on the measurements feedback in the other views now reflects the objects’ 
measured volume. 



VOLOCITY QUANTITATION REFERENCE 

February 2008   391 

 

If Feedback is not Displayed 
If feedback is not displayed as expected, check the item name column for the selected 
measurements. The correct image data must be open.   

Check the Feedback Options dialog to check that the feedback is prominent enough against the 
image data. 

Check the status of Show objects in current timepoint only. Use the Navigation palette to move to 
the correct timepoint or uncheck this option to show all objects regardless of the timepoint in which 
the object was measured. 
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Analysis View 
Click on the Analysis tab of a measurement item to work with the data and organize it in different 
ways. The Analysis View is the second step in the process of extracting patterns or trends from 
image data. 

The top part of the view will show the reorganized data, the lower part shows the raw table. Select 
Hide Raw Data from the Analysis menu to show only the reorganized data. 

 
Select Analyze... from the Analysis menu to open the dialog that will allow you to perform this 
powerful organization. 
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Analyze these data: The drop-down shows all the measured criteria available for the objects in the 
Raw table, select one as the subject of analysis. If the analysis is to look at intensity over time, select 
a column containing intensity values. 

Summarized by: Choose from Value, Mean, Sum, Product, Count, Min/Max, Variance/SD. 

Organize the data by: Select other measured criteria from the raw table to show the relationship 
between those criteria and the subject of the analysis selected in Analyze these data: If the analysis 
is to look at intensity over time, select the time or timepoint column here. 

It is possible to organize the data by up to three criteria, rows, columns and pages. 

Grouped into bins will allow you to divide the rows, columns and/or pages into groups to best 
present the data.    

Data filtered out of the Raw View will not be included in analysis but the filter may be edited at any 
time by selecting Filter... from the Analysis menu or clicking on the filter button at the top of the 
screen. 

The Analysis menu contains options for working with the analysis table created. 

Extract Analyzed Data... creates a new Measurement item containing just the 
analyzed or reorganized data, which can be analyzed further. 

Merge Data... adds the analysis table to an existing measurement item.   

Remove duplicate rows ensures that the same measurement is not repeated. 

Merge similar rows ensures that different measurement criteria, indicated by the 
column heading, for the same object are kept in one row, not spread over two or 
more. 
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This could be used to combine two or more different analysis methods in one table. The result of one 
way of organization is extracted to a new measurement item then the original item reorganized and 
the result merged with the item created in the first step.  

Change the appearance of the tables shown in this view by using the options for columns in the 
Analysis menu. 

 To re-organize columns click the column heading, drag it to its new position and release.  

 To sort columns click on the column heading—an arrow shows that the column is sorted and the 
direction of the arrow indicates whether the sort order is ascending or descending. Click again to 
reverse the sort. For example: sort on the Name column to group together the same types of 
measurement.  

 To change the width of a column click on the cell border and drag.  

 To resize all columns to fit contents, select Autosize Columns  

 To hide/show columns select  Analysis or Raw Columns… in the Analysis menu.  
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Analysis Examples 
Find the Total Number of Objects Measured 

A measurement item Raw View contains one row of information per object. In the following example 
a protocol was applied to five image sequences and the table contains over 32000 measurements. 

 
To find the total number of objects measured in each of the image sequences the Analysis dialog in 
the Analysis View is configured as follows: 

 Analyze this data: ID. Anything that has been measured for each item could be used here. 

 Summarized by: Count. The total number of IDs and therefore the total number of objects. 

 Row: Item Name. Show the name of the library item to organize the data by image sequence. 

 Column:  Not required. 

 Page:  Not required. 
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The Analysis View looks like this: 

 



VOLOCITY QUANTITATION REFERENCE 

February 2008   397 

The analysis table arranges the data for a chart. This table could be displayed as a bar chart: 

 

Find the Total Number of Objects Measured per Timepoint 
Using the same table of data as the previous example, to find the total number of objects measured 
per timepoint. the Analysis dialog in the Analysis View is configured as follows:  

 Analyze this data: ID. Anything that has been measured for each item could be used here. 

 Summarized by: Count. Generate a count of the total number of unique IDs and therefore the 
total number of objects. 

 Row: Timepoint.  

 Column: Not required. 

 Page: Not required. 
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The Analysis View looks like this: 
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Find the Mean Intensity of Objects per Timepoint per Image Sequence 
Using the same table of data as the previous example, to find out whether there is a pattern to 
intensities of objects dependent on timepoint and experiment, the Analysis dialog in the Analysis 
View is configured as follows:  

 Analyze this data: Mean Intensity. Where more than one channel has been measured in the 
data set choose the mean intensity column for the channel of interest. 

 Summarized by: Mean. If multiple objects have been measured in every timepoint this will 
present the mean of the mean intensities. 

 Row: Timepoint.  

 Column: Item Name. The Item Name is the name of the image sequence so there will be one 
column for each image sequence measured. 

 Page: Not required. 
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The Analysis View looks like this: 

 

Mean Number of Objects per Cell 
Objects have been measured to identify those that are within measured cells. Objects have been 
given a Parent ID according to the objects they are found within, using Internalize Measured 
Objects in a measurement protocol.   
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To find out how many objects are within each of the larger objects, the analysis dialog is configured 
as follows: 

 Analyze this data: ID. Anything that has been measured for each item could be used here. 

 Summarized by: Count. The total number of IDs and therefore the total number of objects. 

 Row: Parent ID. Organize the objects by the ID of the object they were found within. 

 Column: Not required. 

 Page: Not required. 
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The Analysis View looks like this: 
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Show Changes in Intensity with Object Volume 
 Analyze this data: Mean. For a single channel data set this represents the mean intensity of each 

object. 

 Summarized by: Mean 

 Row: Volume. Since there are many volumes represented in the table, showing each one 
individually will be excessive data to process. Rows, Columns and Pages may all be shown 
grouped into bins to prepare data in the style of a histogram. 

 Column: Not required. 

 Page: Not required.   
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The Analysis View looks like this: 

 

Show Changes in Object Velocity over Time 
Object tracking measures not only an average Velocity for the whole track, shown in the Raw View in 
the Track Velocity column but also each object velocity from one timepoint to another. These 
velocities may be analyzed to illustrate the nature of the object movement over the time course of the 
experiment. 
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The Analysis dialog is configured as follows: 

 Analyze this data: Velocity.  

 Summarized by: Value.   

 Row: Relative Time. Time may be absolute, relative or by timepoint. 

 Column: Track ID. All the objects that make up a track are related to each other by the Track ID.  

 Page: Not required. 
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The Analysis View looks like this: 
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This could be illustrated in a line chart. The following chart indicates that the objects accelerate and 
decelerate throughout the experiment.  
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Chart View 
The Chart View shows a graphical representation of the data in the analysis table. To generate a 
chart: 

 First, set up an analysis table in the Analysis View. 

 Then click on the Chart tab. 
To configure chart style and appearance select Chart... from the Chart menu or click on the chart 
button at the top right of the window. 

 
The chart will show only data that is not filtered out. Edit the filter from the Chart View by selecting 
Filter... from the Chart menu or clicking on the filter button at the top right of the window. 

The Analysis table which is being represented in the chart can also be changed without returning to 
the Analysis tab. Choose Analyze... from the Chart menu or click on the analyze button at the top 
right of the window. 

Exceptions to this description are the Track Charts. These are examples of special case charts 
where the information required to generate them is extracted directly from the raw data in the Raw 
View. When working with tracks click directly on the Chart tab to view XY or XYZ Tracking Charts 



VOLOCITY QUANTITATION REFERENCE 

February 2008   409 

Available chart types are: 

 Bar - compare values across categories 

 Stacked Bar - compare contribution of a value to the total across categories 

 100% Stacked Bar - compare percentage contribution across categories 

 Line - display trend across categories 

 Stacked Line - display trend of contributions to the total across categories 

 100% Stacked Line - display trend of percentage contributions across categories. 

 XY (Scatter) - compare pairs of values 

 Pie - display contribution of each value to total 

 Horizon -  compare values 

 XY Track - display XY positions over time 

 XYZ Track - display XYZ positions over time 
 

To keep an image of the chart select Capture Snapshot from the Chart menu. A 2D image of the 
chart will be added to the library. This may be exported in any of the formats for 2D images. 
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Chart Examples 
For each chart type configuration options are offered for style, series, category axis and value axis. 

Style: A wide range of styles is available and each style has a number of user configurable options. 
The following examples illustrates options for a bar chart. 

 
Series: To change the series style, select Series from the Edit Chart dialog. Color and pattern may 
be changed, as required. 
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Category Axis: To change the categories, select Category Axis from the Edit Chart dialog. Axis 
scale limits and divisions may be changed, as required. 

 
Value axis: To change the categories, select Category Axis from the Edit Chart dialog. Axis scale 
limits and divisions may be changed as required. 
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Colocalization 
Colocalization is part of the Volocity Quantitation product designed specifically for Colocalization 
analysis as described by Manders et al (1993).  
Colocalization in the context of digital fluorescence imaging can be described as the detection of 
signal at the same voxel location in each of two channels. The two channels are made up of images 
of two different fluorochromes taken from the same sample area.  

Colocalization calculates measurement statistics based on the voxels and their intensity. It provides 
the user with a tool for evaluating how similar the images from two channels are. It provides a 
separate Colocalization view that shows: 

 An extended focus merge of the two channels as a preview 

 A scatter plot that represents the intensity values found within the images 

 Statistics, which consist of Pearson’s Correlation and Overlap Coefficients for the whole image 
and Colocalization Coefficients for regions of interest drawn on the scatter plot 

 Any thresholds that have been applied to the data 
The Colocalization View has a tool bar and a view specific menu. These are both used when working 
with the view.  

  
Colocalization menu Colocalization tool bar 



VOLOCITY QUANTITATION REFERENCE 

February 2008   413 

The Colocalization View 

 

Preview 
This is an extended focus merge of the two channels selected in the Channel X and Channel Y drop-
downs. The current timepoint is shown and controlled by the Navigation palette.  

Show the absolute or relative timestamp of the current timepoint in the preview by selecting Show 
Time from the Colocalization menu.  

The following tools from the tool bar may be used on the preview image: rectangular, freehand, 
circular, magic wand and lasso ROI tools, zoom and pan.  

scatter 
plot 

statistics thresholds 

preview 
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Colocalized voxels selected in the scatter plot are shown using colored feedback in the preview. Use 
View Options… in the Colocalization menu to change the color and opacity of this feedback.  
 

 

Scatter Plot 
Each axis represents the ascending gray levels present within the two analyzed volumes. The axis is 
assigned according to the drop-downs at the top of the view.  

For example: if a voxel in image x has an intensity value of 100 and the corresponding voxel in 
image y has an intensity value of 30, a point will be plotted at co-ordinates 100,30. It does not matter 
how may voxels in the two channels have intensity values of 100,30; only one point will be plotted on 
the scatter plot. 
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Two perfectly colocalized images, i.e. identical, will generate a scatter plot where the points fall in a 
line at 45 degrees to either axis. 

 
Select All and Select None in the Edit menu operate on the scatter plot. You can also use the 
shortcuts Apple-A on Mac OS and Ctrl-A on Windows to select all. 

If required, select sub-regions of the scatter plot for analysis. Use the ROI tools to draw a region of 
interest on the scatter plot. The preview will update so the overlay shows the location of just the 
selected, colocalized voxels. The statistics will also update to reflect the selected voxels. 

Thresholds 
There are three ways of setting thresholds: 
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 Use the ROI tool to draw a region of interest on the Preview. Select Set Thresholds from ROI 
from the Colocalization menu. Volocity calculates the mean intensity of the ROI for each channel 
and sets it as the minimum threshold value for that channel. 

 
 Enter the required values manually into the Threshold Maximum and Minimum boxes for each 

channel or drag the slider controls on the scatter plot. You will be able to see where voxels have 
been excluded on the scatter plot.  

 
 Select Automatic Thresholding from the Colocalization menu to generate thresholds 

automatically. Volocity uses statistical tests to set thresholds objectively. Automatically calculating 
thresholds will take time, and this time will increase with increasing dimensions of the data set. 



VOLOCITY QUANTITATION REFERENCE 

February 2008   417 

Turning automatic thresholding on disables manual setting of thresholds and Set thresholds 
from ROI. For multi-timepoint data sets, Volocity will recalculate thresholds for each timepoint 
viewed. Change the current timepoint using the Navigation palette. 

 
Any voxels of intensity outside threshold will be removed from the preview image for that channel. 
Any point on the scatter plot that is outside threshold for either channel will be removed from the 
scatter plot leaving only points that are positive for both x and y, i.e. colocalized. 

If thresholds are not set, voxels where both images show background intensity levels may be 
interpreted as colocalized. 

Automatic Thresholding 

The aim of the Automatic Thresholding is to determine thresholds that exclude voxels for which 
Pearson’s Correlation between the two channels is less than, or equal to, 0. It is a two-step process. 
First, a best-fit regression line of the Channel X and Channel Y intensities over all the voxels is found. 
Second, the thresholds are moved along the regression line until the point is reached where 
Pearson’s Correlation for voxels below threshold is less than, or equal to, 0. This technique is based 
on the method proposed in: 

S. V. Costes, D.Daelemans, E. H. Cho, Z. Dobbin, G. Pavlakis & S. Lockett  
Automatic and Quantitative Measurement of Protein-Protein Colocalization in Live Cells 
Biophysical Journal 2004 Vol. 86, pp. 3339-4003 

Automatic Thresholding is turned on or off by selecting Automatic Thresholding from the 
Colocalization menu. It is possible that Automatic Thresholding may not be able to determine 
thresholds for a data set, in which case a message is shown. Automatic Thresholding may determine 
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different thresholds depending on the data set; therefore, it should not be used if the same 
thresholds are to be applied across a series of data sets or timepoints within the same data set. 

Any voxels of intensity outside threshold will be removed from the preview image for that channel. 
Any point on the scatter plot that is outside threshold for either channel will be removed from the 
scatter plot leaving only points that are positive for both x and y, that is colocalized. 

If thresholds are not set, voxels where both images show background intensity levels may be 
interpreted as colocalized. 

Statistics 
While Volocity is generating the scatter plot and calculating statistics a progress indicator is shown in 
the top right-hand corner of the view. 

The statistics presented in the Colocalization window are calculated as follows:  

  xi = intensity of voxel i in image unless  xi is outside threshold in which case   xi = 0  

  yi  = intensity of voxel i in image y unless  yi  is outside threshold in which case   yi =0 

  

Pearson's Correlation =  
(xi − xaver ) • (yi − yaver )

i
∑

(xi − xaver )
2 • (yi − yaver )

2

i
∑

 

Pearson’s Correlation is a statistical test for a linear relationship between two variables. Pearson’s 
Correlation can vary between –1 and 1. A correlation of 0 means there is no linear relationship 
between the variables.  –1 and 1 indicate perfect negative and perfect positive linear relationships 
respectively. Interpreting the degree of colocalization from negative values is difficult.   

  

Overlap Coefficient (R) =  
xi • yi

i
∑

(xi )
2 (yi)

2

i
∑

i
∑

 

  

Overlap Coefficient (kx) =  
xi •yi

i
∑

(xi)
2

i
∑

 

  

Overlap Coefficient (ky) =  
xi •yi

i
∑

(yi)
2

i
∑
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Colocalization Coefficient (Mx) =  
xi,coloc

i
∑

xi
i

∑
 

  

Colocalization Coefficient (My) =  
yi,coloc

i
∑

yi
i

∑
 

Where   xi,coloc = xi   if   yi  is within the intensity range defined by the ROI,   xi,coloc = 0 if  yi  is 

outside the intensity range and  yi,coloc = yi  if  xi is within the intensity range defined by the 

ROI,   yi,coloc = 0, if   xi is outside the intensity range. 

Colocalization Coefficients may be values between 0 and 1. 0 indicates that none of the signal within 
thresholds in that channel exists as colocalized with the other channel. A value of 1 indicates that all 
of the signal within thresholds in that channel exists as colocalized with the other channel. 

For further explanation of these statistics see the following references: 

M.M. Manders, P. J. Verbeek & J. A. Aten 

Measurement of co-localization of objects in dual colour confocal images 

Journal of Microscopy 1993 Vol. 169, pp. 375-382 

 

Generating Output  
There are two methods for generating output using the principles of the Colocalization View: 

 Generate Colocalization, which can be set up to generate a field statistics measurement, a 
scatter plot and a colocalization channel for the current or all timepoints. 

 Measure Object Colocalization task used in a measurement protocol, which measures the 
colocalization coefficients Mx and My for each object and displays them in the table area of the 
Measurements View. 
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Generate Colocalization  

Select Generate Colocalization from the Colocalization menu and choose the required output for 
the current timepoint or all timepoints in the image sequence.  

 
 Field statistics are measurements representing the whole volume rather than objects within it. 

One timepoint in an image sequence will give rise to one measurement row in the Measurements 
table. In a row, the colocalization statistics (Mx and My) are generated from the region of interest 
selected on the scatter plot.  

 The scatter plots are saved to a folder in the current library. Each scatter plot is stored as a 2D 
image and may be exported. 

 A Colocalization channel is made from the selected colocalized voxels. These voxels are marked 
in the Colocalization View preview with the colored overlay. The channel is produced from a 
brightest point merge honoring the color and intensity of those voxels in the original channels.  

Measure Object Colocalization 

Use this task within a measurement protocol in the Measurement View. Find objects using tasks 
added to the protocol and then add Measure Object Colocalization to find Mx and My for each. As 
discussed above, it is essential to set thresholds for each channel and the Measure Object 
Colocalization task allows thresholds to be set. Alternatively, after configuring the Colocalization 
View the settings in the view may be read into the task. 

Important Considerations 
It is important to have adequate separation of the two fluorescence signals, with no overlap between 
emission of one and excitation of the other. This affects choice of filters as well as fluorochromes 
themselves.  

Colocalization can only analyze the voxel values presented in the selected images. It is the user’s 
responsibility to ensure the images are valid for the study they are carrying out.   

Users may wish to deconvolve images before processing. Iterative Restoration is appropriate for this 
application since it preserves voxel intensity values, see page 451. 
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Colocalization assumes that there has been no voxel shift between the capture of the two channels 
and that they are perfectly aligned. Adequate controls are also essential to avoid the possibility of 
false colocalization, for example generated by non-specific labeling. 

FRAP Analysis 
Carrying Out FRAP Analysis 

Only data that has been acquired with Volocity FRAP Acquisition may be analyzed with Volocity 
FRAP Analysis. 

Prior to carrying out FRAP analysis you should consider applying the following corrections to your 
FRAP recovery data:  

 Background correction 

 Photobleaching correction 

Background Correction 

Volocity provides a flexible background correction tool that allows you to correct images based on 
either division of images with a bright reference image, subtraction of a dark reference image or 
subtraction of fixed offset values from images (for more details please Correcting Background). 

If you wish to apply background correction to your FRAP image sequences, acquire any correction 
images that you require and create your background correction item in your library. Select the 
images that you wish to correct and apply background correction from the Tools menu.   

Photobleaching Correction 

The Volocity photobleaching correction tool corrects for photobleaching by applying correction 
factors to images that restore their intensity to the intensity of the first image in an image sequence. 
Without photobleaching correction it is likely that you will get an underestimation of the mobile 
fraction from you FRAP analysis.   

There are two methods of applying photobleaching correction. Apply whichever is appropriate for 
your experiment. 

 Based on a region of interest. To apply a correction based on a region of interest you must 
have your image sequence open in the Image View.  Select an ROI and then select Correct 
Photobleaching… from the Tools menu. Make sure that you select the appropriate channel for 
correction; in our example we are correcting the “FRAP (bg corrected) channel”. 
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When photobleaching correction based on an ROI is applied Volocity multiplies the whole image 
by whatever correction factor is required for each time point to keep the ROI at 100% intensity 
throughout the image sequence. Because it requires an ROI to be selected it cannot be used to 
batch correct multiple channels. 

 Based on the whole image. Select Correct Photobleaching… from the Tools menu. Make 
sure that you select the appropriate channel for correction. Volocity multiplies the whole image by 
whatever correction factor is required for each time point to keep the whole image at 100% 
intensity throughout the image sequence. Photobleaching correction based on the whole image 
does support batch processing. To batch process several images sequences, select them in your 
Volocity library before selecting Correct Photobleaching… from the Tools menu.  

Normalization  

You may include as many data sets as you wish in a single FRAP analysis. So that multiple data sets 
can be pooled, Volocity normalizes FRAP data by setting the intensity of bleach areas in the last 
frame before bleaching to 1 and by setting the intensity in the first frame after bleaching to 0, all 
intensity measurements are then made according to this scale.  

Select the image sequences that you wish to include in your analysis and select FRAP Analysis… 
from the Tools menu. 

FRAP Analysis 

 
1. Select the channel on which FRAP analysis is to be performed. 

2. Select the appropriate bleaching mask channel; this is the FRAP template channel created when we 
acquired the image sequence (the correct mask channel should be selected by default provided that 
the channel names have not been changed). 

3. Select the appropriate equation. 

 The Single Exponential equation is appropriate for a single binding state (see Sprague and 
McNally (2005) for further information on single binding states). 

 The Single Constrained Exponential equation is appropriate for a single binding state where you 
wish to constrain the curve fit to have a value of 0 at time 0, i.e. pass through the origin. 
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 The Double Exponential equation is appropriate for two binding states or more complex transfer 
barriers. However, be aware that this equation will fit almost all recovery curves and does not 
necessarily indicate two binding states for your molecule of interest (see Spague and McNally 
(2005) for further information on two independent binding states and the caution required to use 
this equation). 

 The Soumpasis analytical solution (Soumpasis1983) provides a solution for pure diffusion. 

 Specify a name for the measurement item in which to store the result and click Analyze.  When 
analysis is complete your measurement item will automatically open in the Chart view. 
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FLIP Analysis 
As with FRAP analysis, you may wish to background correct and photobleaching correct your image 
sequence before analysis.  

1. Open your image sequence in the measurements view.  

2. Select ROIs for analysis. In this case ROI A may be connected to the bleach area (mobile molecules 
would be free to diffuse between the bleach area and ROI A), but ROI B can not possibly connected 
to the bleach area.  A dramatically higher bleach rate for ROI A than ROI B would demonstrate that 
molecules are freely diffusing between ROI A and the bleach area.  
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3. Select Measure all timepoints from the Measurements menu. 

4. Select Create measurements item from the Measurements menu. 

5. Name your measurements item and click OK. 

6. Open the measurements item and select the Analysis tab. Select Analyze from the Analysis menu. 
The Edit Analysis dialog opens. 



VOLOCITY QUANTITATION REFERENCE 

February 2008   425 

 
Set the Analysis dialog as follows: 

 Analyze these data = Mean 

 Summarize by = Value 

 Row = Timepoint 

 Column = Name 

 Page = None 

7. Check the Include normalized data to the control in row box, and select timepoint 1 from the drop 
down menu. This results in intensity values being calculated as a percentage of their initial values. 
This makes changes in intensity clearer, and makes comparison of the intensity changes in the two 
areas possible. 

8. Click OK. 
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9. Your Analysis now contains four columns. Two with raw intensity values over time and two with 

normalized intensity values over time. So that you plot only the normalized values hide the columns 
containing raw values. Select Analysis Columns… from the Analysis menu and uncheck the boxes 
corresponding to the raw values (leaving the boxes that correspond to normalized values checked) 
and click OK. 
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10. Select the Chart Tab. 

11. Select the Setup Chart button 

12. In the Edit chart dialog set the chart to “Line” and click OK.  
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In our example we can see that ROI A (plotted in Red) loses fluorescence in comparison to ROI B 
(plotted in blue). This demonstrates that the fluorescence material in ROI A is able to move freely 
into and out of the bleaching area, unlike the material in ROI B which can never enter the bleaching 
area. In this case photobleaching was corrected based on a third ROI, which was unconnected to 
ROI A or B.  



VOLOCITY QUANTITATION REFERENCE 

February 2008   429 

The same analysis without photobleaching correction is shown below. Even without photobleaching 
correction fluorescence is clearly lost at a much higher rate in ROI A (red) than ROI B (blue).  

 

FRAP Measurement Item 
The FRAP Analysis... command in the Tools menu generates a measurement item. Designed 
specifically for FRAP analysis the information in this measurement item will be laid out in a different 
way compared to one created by other measurement actions in Volocity and you will interact with it 
differently. 

The Chart View provides the most accessible view of the results. The FRAP measurement item will 
open to the Chart View by default. 



FRAP Measurement Item 

 

430   Improvision 

 
FRAP charts show the normalized recovery for each of your bleached areas (each recovery is 
plotted in its own color and style), as well as the best fit curve (shown with a line joining each point by 
default).   



VOLOCITY QUANTITATION REFERENCE 

February 2008   431 

Parameters that are displayed either graphically or in the legend are shown in the table below. 

Parameter Method of Calculation Chart or Legend Reference 

T 1/2 Time taken for the intensity of the 
bleached area to recover to half of 
the plateau intensity 

Both  

Mobile 
Fraction (Fm) 

Normalized intensity at plateau Both  

Immobile 
Fraction (Fi) 

Normalized pre-bleach intensity-
normalized intensity at plateau 

Both  

Diffusion 
Coefficient (D) 

 Legend Axelrod et al 1976 

Fitted 
Equation 

Equations are fitted to the raw data 
using the least squares method 

Legend  

TD 
(Characteristic 
diffusion time, 
Soumpassis 
equation only) 

Derived by fitting the Soumpassis 
equation to the raw data 

Legend Soumpassis 1983 

 

For a more detailed view of the normalized intensity values from your recoveries as well as the curve 
fitted recovery values select the Raw tab. Note the Rel Time column; this represents the time relative 
to the first frame to be acquired after bleaching, which is set to 0.  
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Ratioing 
Volocity ratioing allows you to carry out offline analysis of ratioed pairs of images. It requires an 
image sequence containing at least two channels. The channels must be the same depth but may be 
8-bit, 16-bit or floating point. The ratio is always calculated as Channel A / Channel B, therefore, it is 
important to specify the channels correctly in the Ratio dialog.  

Applying Ratio Calculation 
1. Open an image sequence containing 2 or more channels.  

2. Choose Ratio… from the Tools menu. The ratio option is available when any of the tabs in the image 
sequence are active, but working from the Image View allows you to use an ROI drawn in that view 
to set background values for subtraction.    
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3. Select which channels in the image sequence should be used for Channel A and Channel B. A 

constant background value may be subtracted from every voxel in every image of each channel, if 
required. If source images are already background subtracted, go to step 4. 

Note: Subtraction of a background constant is relevant only if the source images are evenly 
illuminated. 

Enter a value in the Subtract field or draw an ROI on the Image View before opening the Ratio 
dialog and click Get from ROI next to the Subtract field. Volocity will use the mean intensity from that 
ROI for each channel as the value to subtract. This value will be subtracted from the intensity value 
of every voxel before processing the ratio calculation. 

4. Set threshold values for each channel by typing a value in the Threshold field. Thresholds allow 
removal of signals that would interfere with interpretation of results. 

For example, there will be areas in the images where low intensities in each of the A and B channels 
produce similar ratio values to higher intensities in other areas. Thresholds will mean a result of  0 
(zero) is set when one of the source voxels has an intensity at or below the threshold.  

Use the Voxel Spy to pick out an exact threshold value or ask Volocity to Calculate the value for you. 
The calculate option determines the modal intensity value for the channel and uses it as the 
threshold.  

5. You may wish to apply rainbow colors to the ratioed channel. Check the Apply a rainbow LUT to 
the ratio channel. To optimize the use of the rainbow across the range of ratio values present within 
the results enter Display R minimum and Display R maximum values. This allows the finite range 
of colors available in the lookup table to be used to illustrate most effectively any changes in the ratio 

preview window 
and multiple 
timepoint play 
controls 
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values. Click Calculate and the maximum and minimum ratio values for the current timepoint will be 
used. To easily compare ratio images with rainbow colors applied, they should all have the same 
Display R minimum and Display R maximum set. In the rainbow LUT the minimum value is shown 
as blue, the maximum as white. By setting Display R minimum and Display R maximum you are 
setting the black and white point of the images. This is what is done automatically by the Auto 
Contrast command in the Tools menu. Auto Contrast should, therefore, be used with caution if ratio 
images are to be used comparatively.  

 
6. If required, generate an intensity modulated channel that will appear as a new channel in the image 

sequence. Select the modulator image from the Generate drop-down list. This generates a millions 
of colors display channel and may show morphology more clearly at the same time as indicating ratio 
values. 

 
7. If a calibrated channel is required, select one of the two methods in the Generate a calibrated 

channel using drop-down list and enter the appropriate values in the table.    

 Grynkiewicz: Edit the four constants, as appropriate. These values will be applied to the 
Grynkiewicz equation (see page 436). The relevant constants for the current experiment must be 
determined according to Grynkiewicz et al (1985). 

 
 Multi-point: Use the values previously obtained from a calibration experiment for known 

correction of ion. Use the + button to create up to 11 (eleven) points in the table as required and 
enter the Ratio value and corresponding Calibrated value. These points are fitted to a third 
order polynomial or S-shaped curve. The preview graph provides a visual check that the 
calibrated values entered are sensible.  
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The preview shows a brightest point merge of the resultant ratioed image for the current timepoint. If 
the sequence contains multiple timepoints, use the play controls to view the effect of the parameters 
through the time series.  

8. Click Ratio to apply the ratio calculation and create a ratio channel in the image sequence. If 
specified, Volocity also creates a calibrated ratio and an intensity modulated channel. Channels may 
be hidden using the controls on the Navigation palette. 

Note: If appropriate, use the Save.. and Restore… buttons to save the settings for use in other 
experiments. 

Measuring Ratio Channels 
Target the appropriate channel when carrying out measurements, so that you obtain the required 
measurement units: ratio units or calibrated units. If drawing regions of interest to follow changes 
over time it may be beneficial to use the intensity measurements that ignore 0.  

Using Color Reference with Ratio Images 
To display ratio or calibrated images it may be beneficial to show the color reference on the Image 
View. This will show the values represented by the colors. Select Show Color Reference from the 
Image menu. 
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Grynkiewicz equation 
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Ca2+ = intracellular Ca 2+ concentration 

KD = dissociation constant of fura -2 

B = fluorescence signal at 340 nm at 0µM.l-1 Ca2+/fluorescence signal at 380 nm at 39.8µM.l-1Ca2+. 

Grynkiewicz, G. Poenie, M. and Tsien, R. Y.  
A new generation of Ca2+ indicators with greatly improved fluorescence properties.  
Journal of Biological Chemistry 1985 Vol. 260, pp. 3440-3450 

FRET Analysis 
FRET analysis allows accurate FRET measurements and generation of net FRET (or “corrected” 
FRET) and normalized FRET images for publication.  
The analysis currently offered by Volocity is the 3-image FRET technique, as described by Gordon et 
al. (1998) and Xia and Liu (2001).  
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FRET 
FRET (Fluorescence Resonance Energy Transfer) is the non-radiative transfer of energy from an 
excited fluorophore (donor) to another fluorophore (acceptor). FRET only occurs when the molecules 
concerned are in very close proximity (1-10nm). This makes it a valuable technique for studies where 
distances and interactions between molecules are of interest.  

Data Acquisition 
Three images are required for each data point: a Donor image, an Acceptor image, and a FRET 
image. For example, one typical donor/acceptor pair is CFP and YFP.  

 Donor image = Excite with CFP filter, CFP dichroic, emit with CFP filter 

 Acceptor image = Excite with YFP filter, YFP dichroic, emit with YFP filter 

 FRET image = Excite with CFP filter, CFP dichroic, emit with YFP filter 
Volocity combines the three input images on a voxel-by-voxel basis according to the chosen FRET 
method. The output is a floating-point value at each voxel. 

 All images should be in proper register before FRET analysis.  

 Images must be grayscale 8, 16 or floating bit depth. 

 All images must be the same depth. 

Calculating Bleed-through Constants 
Volocity requires two values that represent the bleed-through or cross-talk of each dye (Donor and 
Acceptor) into the FRET filter set. These values are calculated at the start of the experiment and 
should be recalculated if any change is made to the system that could affect transmission 
characteristics or sensitivity to wavelengths of light.  

Note: The FRET bleed-through dialog does not offer subtraction of any background values. If you 
wish to subtract background from the images used to calculate bleed-through, this should be done 
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before using the images in FRET analysis. Alternatively, calculate your own bleed-through using 
values obtained by measuring appropriate ROIs in the images, as follows: 

(intensity within cell(s) recipient-background intensity recipient) / (intensity within cell(s) source-
background intensity source) 

1. First set up the constant for the Donor channel. An image sequence containing donor and FRET 
channels from a sample containing only the donor fluorochrome is required. 

2. Define an ROI or multiple ROIs on the Image View.  

3. Select FRET Bleed-through… from the Tools menu. 

 
4. Nominate a Source channel (where the bleed-through is coming from, in this case the donor 

channel) and a Recipient channel (where the bleed-through is detected, in this case the FRET 
channel). In a sample containing only donor fluorochrome any signal detected in the FRET channel 
must be bleed-through.  

5. Select the channel to which the bleed-through constant should be applied in the Use as default 
bleed-through constant for drop-down list, in this case Donor.  

6. Click on Save. The constant will be applied when you carry out the FRET calculation, as described in 
the next section. The bleed-through value is a normalised percentage between 0.0 and 1.0. 

 The value is calculated as the mean intensity of the recipient divided by the mean intensity of the 
source. 

 If you have defined multiple ROIs, Volocity calculates a mean of the mean values. 
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7. Now create the constant for the Acceptor channel. An image sequence containing acceptor and 
FRET channels from a sample containing only the acceptor fluorochrome is required. Repeat steps 2 
to 6. 

. 

Using the FRET dialog 
1. Open an image sequence containing 3 or more channels, which represent a Donor channel, an 

Acceptor channel and a FRET channel.  

2. Choose FRET… from the Tools menu.     

                                    

preview window 
and multiple 
timepoint play 
controls 
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3. Select the Method of FRET calculation to be used from the drop-down list. 

 
4. Select which channels should be used for Donor, FRET and Acceptor. A constant background 

value may be subtracted from every voxel in every image of each channel, if required. If source 
images are already background subtracted, go to step 5. 

Note: Subtraction of a background constant is relevant only if the source images are evenly 
illuminated. 

 
Enter a value in the Subtract field or draw an ROI on the Image View before opening the FRET 
dialog and click Get from ROI next to the Subtract field. Volocity will use the mean intensity from that 
ROI for each channel as the value to subtract. This value will be subtracted from the intensity value 
of every voxel before processing the FRET calculation. 

5. Set threshold values for each channel by typing a value in the Threshold field. Thresholds allow 
removal of signals that would interfere with interpretation of results. 

For every voxel position for which one of the source voxels has an intensity value at or below 
threshold, the value of that voxel position in the result image is set to 0 (zero). 

Use the Voxel Spy to pick out an exact threshold value or ask Volocity to Calculate the value for you. 
The calculate option determines the modal intensity value for the channel and uses it as the 
threshold. 

6. Enter bleed-through constants to be used. Click Restore Defaults to apply the Bleed–through 
constants stored from the last bleed-through calculation. 
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7. Preview the corrected FRET image. The preview shows a brightest point merge of the resultant 

FRET image. If the sequence contains multiple timepoints, use the play controls to view the effect of 
the parameters through the time series. 

8. You may wish to apply rainbow colors to the output channel. Check the Apply a rainbow LUT to the 
net FRET channel. To optimize the use of the rainbow across the range of values present within the 
results enter Display minimum and Display maximum values.  

This allows the finite range of colors available in the lookup table to be used to illustrate most 
effectively any changes in the FRET values. Click Calculate and the maximum and minimum FRET 
values for the current timepoint will be used. To easily compare FRET images with rainbow colors 
applied, they should all have the same Display minimum and Display maximum set. In the 
rainbow LUT the minimum value is shown as blue, the maximum as white. By setting Display 
minimum and Display maximum you are setting the black and white point of the images. This is 
what is done automatically by the Auto Contrast command in the Tools menu. Auto Contrast should, 
therefore, be used with caution if FRET images are to be used comparatively. 

 
9. If required, generate an intensity modulated channel that will appear as a new channel in the image 

sequence. Select the modulator range from the Generate drop-down list. This generates a millions of 
colors display channel and may show morphology more clearly at the same time as indicating FRET 
values. 

 
10. Click FRET to apply FRET calculation and create a corrected FRET channel in the image sequence. 

If specified, Volocity also creates an intensity modulated channel. All channels are also visible in the 
Navigation palettes and Voxel Spy palette. Channels may be hidden using the controls on the 
Navigation palette. 

Measuring Corrected FRET Channels 
FRET channels in image sequences may be measured in the same way as any other channel. When 
measurements are made on a FRET channel values for min, max, mean will be in the appropriate 
FRET units. If drawing regions of interest to follow changes over time, it may be beneficial to use the 
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intensity measurements that ignore 0. This will ensure that if background areas are included when 
the ROIs are drawn, they will not influence the results. 

See other sections of this chapter for details on how to use measurement tools and the classifier.   

Using Color Reference with FRET images 
To display corrected FRET images it may be beneficial to show the color reference on the Image 
View. This will show the values represented by the colors. Select Show Color Reference from the 
Image menu. 

Intensity Modulated Images 
The IM image uses pseudocolor and intensity to display a FRET output image. Color is used to 
represent FRET values, intensity represents the intensity of one of the input images. This technique 
helps reflect spatial information since the intensity of the original images is reflected in the resultant 
image.  

To produce the IM image the intensity of each voxel of the FRET output image is scaled based on 
the range of intensities in the input images. The source image used for this is called the modulator 
image. The modulator image can be one of the source images, the brightest of the source images or 
the average of the source images. 

The range of colors in the IM image is determined by the look up table applied to the FRET output 
image.  

The range of intensities in the IM image is determined by the range of intensities in the modulator 
image. 

The IM image is a millions of colors image. It is, therefore, a visualization tool not suitable for 
quantitation. 
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Volocity Restoration 

Overview 
Volocity Restoration is an additional product that must be purchased separately. See page 35 for 
more information about activating extension modules.  

Volocity Restoration offers two powerful techniques that allow you to apply deconvolution to an 
image sequence or volume. These techniques are: 

 Iterative Restoration, which is a restorative technique that reassigns out-of-haze focus (it does 
not subtract it from the data). It is designed to minimize out-of-haze focus and noise throughout 
the volume. Iterative restoration not only gives improvement in resolution in X and Y, but most 
significantly also in Z. The results are applicable for 3D visualization and all 3D measurements 
provided by Volocity Quantitation, including intensity. The processing required to achieve this is 
both time and memory intensive.  

 Fast Restoration, which is a rapid, single pass process that acts on the volume as a whole. It 
gives resolution improvement in X and Y.  

Note: For both techniques, the first time a data set is deconvolved, it may take slightly longer than 
the second and subsequent times a data set of the same dimensions is processed. This is because 
one optimization present within Volocity Restoration is the storage of the method by which the Fast 
Fourier Transform (FFT) of a data set will be calculated. The next time a data set of those 
dimensions is encountered the method for calculating the FFT is already available, thus saving a 
processing step. 

Data Acquisition 
Restoration is performed on z series of images that are managed within Volocity as either individual 
volumes or within image sequences. The acquisition process requires careful consideration to obtain 
optimum results from Volocity Restoration. In particular, the following acquisition issues may affect 
the quality of the deconvolved image data:  

 undersampling, particularly in the z axis 

 saturation of the signal within images 

 uneven illumination due to an unstable light source 

 premature cropping of the signal by capturing too little in X, Y and Z around the sample 

Please refer to Appendix A on page 459 for a more detailed discussion about the requirements for 
sampling wide field microscopy data for deconvolution. 
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PSF items 
In order to apply either technique, you must first create a PSF item. This is used to model the 
behavior of light in the optical system and must be appropriate for the data that is to be deconvolved. 
You can create a PSF in two ways: 

 Calculated PSF, which is based on values entered into the Calculate PSF… dialog box. These 
values should be the same as the parameters under which the data for deconvolution was 
acquired. The application uses the values to calculate an appropriate PSF and create a new PSF 
item.  

 Measured PSF, which is based on a volume (typically made from a z series of images of a sub-
resolution, fluorescent bead) acquired under the same conditions as the experimental data. The 
application measures the PSF in the bead volume and creates a new PSF item.  

Note: See Appendix B for a discussion of the reasons why beads might appear as ellipses instead of 
spheres in optical microscopy.  

Creating PSF volumes can be time consuming. Improvision, therefore, recommends that you create 
a library of PSF volumes for different objectives and camera settings and drag them into the active 
library as they are needed. If you double click on a PSF icon in the library, it will open an Image View 
with an extra column on the right of the window containing the PSF data. 

Note: Please see the Glossary for a definition of PSF parameters. 

Data Calibration 
The method of calculating and using point spread functions within Volocity 2.5 and later requires that 
all data used within Volocity Restoration be correctly calibrated before use. This applies to raw data 
for deconvolution as well as volumes from which a PSF is to be measured. Check the data 
calibration before commencing by selecting Properties from the Edit menu. Correct the X, Y or Z 
micron/pixel values, if necessary. See also page 54. 
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Calculate PSF 
This dialog is used to calculate all types of PSF available in Volocity, including Widefield, Confocal, 
Two Photon and Spinning Disk Confocal PSFs.   

1. From the Actions menu, select Create New and Calculated PSF…  

2. In the dialog select the required type of PSF from the drop-down menu box. 

 
3. Enter the values relevant for the data to which the PSF will be applied. Please see over the page for 

examples of the various PSF types. 

4. Click on Create to create the PSF item.  

The PSF calculated from the dialog is supersampled. When you enter the values for deconvolution, 
Volocity will read the calibration from the volume and automatically subsample this supersampled 
PSF. This ensures an accurate PSF with the correct settings for deconvolution. 

Note that when deconvolving the volume, Volocity requires the calibration values to be correctly set, 
or the PSF used will not be accurate. If you attempt to deconvolve a volume for which the calibration 
values appear not to have been set, you will be reminded to set these values before proceeding. 

The spinning disk is used in such systems as the PerkinElmer UltraView. This PSF is unique to a 
spinning disk with the spiral pinhole configuration, pinhole size, and pinhole spacing of the 
CSU10/CSU22 spinning disk and should not be used to calculate the PSF for any other type of 
spinning disk.   
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Measure PSF 
This dialog is used to measure all types of PSF available in Volocity. 

1. Make a volume from PSF measurement data, such as z sections taken of a sub resolution, 
fluorescent labeled bead. 

2. Select the PSF bead volume in the library and, from the Actions menu, select Create New and 
Measured PSF…  

 
3. In the dialog select the required type of PSF from the drop-down menu box. All other values are 

optional. You may like to record the other acquisition parameters for the PSF bead as a reminder, 
but they are not used to create the PSF item.  

The following example shows the dialog for a widefield PSF. 
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4. Click on Measure.   

Note that when deconvolving the volume, Volocity requires the calibration values to be correctly set, 
or the PSF used will not be accurate. If you attempt to deconvolve a volume for which the calibration 
values appear not to have been set, you will be reminded to set these values before proceeding.  
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Applying Fast Restoration 
You can apply Fast Restoration to a single volume or an image sequence, or multiple volumes or 
image sequences selected in the library. 

Make sure the library contains the required PSF volumes. You will need a PSF for each wavelength 
and lens type. 

1. Select items to be restored in the library. All items must be correctly calibrated, by setting X, Y and Z 
properties to correctly use PSFs. 

2. Fast Restoration… from the Tools menu. The dialog will show a list of all the unique channel names 
identified in the selected data. 

3. Select the appropriate PSF for each channel from the drop-down menu. This means channels with 
the same name will be restored using the same PSF. 

 
4. For large data sets, you may like to check the Break images into blocks checkbox. Deconvolution 

is a very memory-intensive operation and the software needs to hold multiple copies of the volume in 
memory at the same time so the space occupied in memory during restoration is much greater than 
the physical space occupied by the original data.  

Restoration will proceed fastest if all data required for the processing can be held in physical memory. 
When the data set size exceeds the amount of physical memory Volocity can break the images down 
into blocks which will fit, using the following calculation. 

Memory per processor = physical RAM/number of processors. 



VOLOCITY RESTORATION 

February 2008   449 

Block size will vary therefore, not only with data set size but also with hardware configuration. 

Based on this calculation the volume is divided into blocks allowing an overlap between blocks. This 
overlap is used in the processing of each block but not copied to the result to minimize the 
deterioration of quality caused by breaking the images down. 

Restoration will proceed more quickly since data will not have to be paged in and out of virtual 
memory. On systems with multiple processors blocks may be processed simultaneously, further 
increasing speed. Breaking images into blocks may lead to a slight deterioration in quality; 
depending on the nature of the data it may be possible to detect the edges of the blocks the data 
was broken down into. 

Note: If it is calculated that the data fits into memory as a single block, it will be restored as a single 
block, even if the checkbox is checked. 

5. Click on Start to apply Fast Restoration.  

The preview window shows each volume as restoration is applied. While the deconvolution is being 
carried out the Start button will change to Pause. You can pause the process at any time, for 
example if you want to interact with the preview. Click on the button (now labeled Start) a second 
time to restart the processing. If you click Done while the deconvolution is paused, the deconvolved 
data will not be saved. 

The Status window shows progress details.    

6. Once all the selected channels have been deconvolved, click Done. When deconvolution is 
completed, each channel will have a deconvolved equivalent with a name indicating that Fast 
Restoration was applied; the raw data is not replaced with deconvolved data.  

For single volume(s) the name of the new volume includes the text ‘Fast DCI’ and the name of the 
PSF used.  
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For image sequences the results are added as new channels, so this information is in the name of 
the new channels and the tooltip shown when the mouse is hovered over the channel. If the data 
was broken down into blocks the number of blocks is recorded. 
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Applying Iterative Restoration 
You can apply Iterative Restoration to a single volume, or an image sequence, or multiple volumes or 
image sequences selected in the library. When you set up the restoration parameters, as illustrated 
in the following example, you also specify an iteration limit and a confidence limit, as a percentage. 
After each iteration, Volocity calculates a confidence in the current image. This is expressed as a 
percentage. The deconvolution process will continue until either the required number of iterations is 
reached, or the confidence limit of the current iteration exceeds the value entered. 

Make sure the library contains the required PSF volumes. You will need a PSF for each wavelength 
and lens type. 

1. Select items to be restored in the library. 

2. Select Iterative Restoration… from the Tools menu.  

 
3. Select the appropriate PSF for each channel from the drop-down menu. This means channels with 

the same name will be restored using the same PSF. 

4. Set parameters to determine when the deconvolution will end. Either set a confidence limit or an 
iteration limit.  An iteration is one repetition of the restoration algorithm towards the result. The 
confidence limit is a measure of image convergence. 100% confidence indicates that restoration can 
offer no further improvement to the image. Whichever is reached first will terminate the deconvolution. 
Confidence is calculated after each iteration and is the result of testing the results of deconvolution 
against the original data. 100% confidence may take many iterations to reach. Many datasets can be 
deconvolved extremely successfully with the confidence limit set to 98% or 99%. It may take a 
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different number of iterations to reach the same confidence limits for different channels. The iteration 
limit will stop deconvolution after the required number of iterations. We recommend an iteration limit 
of 25. You should not need to change this for different data sets. 

5. For large data sets, you may like to check the Break images into blocks checkbox. Deconvolution 
is a very memory-intensive operation and Volocity needs to hold multiple copies of the volume in 
memory at the same time so the space occupied in memory during restoration is much greater than 
the physical space occupied by the original data.  

Restoration will proceed fastest if all data required for the processing can be held in physical memory. 
When the data set size exceeds the amount of physical memory Volocity can break the images down 
into blocks which will fit, using the following calculation. 

Memory per processor = physical RAM/number of processors 

Block size will vary, therefore, not only with data set size but also with hardware configuration. 

Based on this calculation the volume is divided into blocks allowing an overlap between blocks. This 
overlap is used in the processing of each block but not copied to the result to minimize the 
deterioration of quality caused by breaking the images down. 

Restoration will proceed more quickly since data will not have to be paged in and out of virtual 
memory. On systems with multiple processors blocks may be processed simultaneously, further 
increasing speed. Breaking images into blocks may lead to a slight deterioration in quality, 
depending on the nature of the data it may be possible to detect the edges of the blocks the data 
was broken down into. 

Note: If it is calculated that the data fits into memory as a single block, it will be restored as a single 
block, even if the checkbox is checked.. 

6. Click on Start to apply Iterative Restoration.  
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Feedback on progress is different depending on the use of Break images into blocks. When Break 
images into blocks is not enabled the preview window shows a brightest point merge, updated with 
each iteration as restoration progresses. It is normal for the results of the first iterations to look worse 
than the original data since the first estimate of the true nature of the data in the image is based on 
the image itself. 

The confidence factor will rise significantly with each iteration, however, the rate of increase will slow 
with successive iterations.   

Note: While the deconvolution is being carried out the Start button will change to Pause. You can 
pause the process at any time, for example if you want to interact with the preview. Click on the 
button (now labeled Start) a second time to restart the processing. If you click Done while the 
deconvolution is paused, the deconvolved data will not be saved.    

If Break images into blocks is enabled feedback on progress is provided less frequently. The 
preview image, a brightest point merge of the volume is updated as each block is completed. The 
status box will show the number of volumes of the total completed and the number of blocks of the 
current volume completed. Progress will not be updated with each iteration. 

7. Once all the selected channels have been deconvolved, click Done. When deconvolution is 
completed, each channel will have a deconvolved equivalent; the raw data is not replaced with 
deconvolved data.  

After Iterative Restoration the result is meaningfully labeled, according to the processing it underwent.  

For single volume(s) the name of the new volume includes the number of iterations, the confidence 
limit reached, the number of blocks, if applicable, and the name of the PSF used.  



Illumination Correction 
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For image sequences the results are added as new channels, so this information is in the name of 
the new channels and the tooltip shown when the mouse is hovered over the channel. If the data 
was broken down into blocks the number of blocks is also recorded.   

Illumination Correction 
Minor anomalies in excitation light intensity over time, such as lamp flicker, can lead to poor 
deconvolution results. This will manifest itself as one or more inconsistently bright or dark layers in 
the deconvolved volume. The flicker may not be apparent during inspection of the raw data.  

Better results can be obtained by applying illumination correction, then deconvolving the data again.  

Select the required volume(s) and select Correct Illumination from the Tools menu. 

Correct Illumination operates within each individual volume and bases any intensity correction solely 
on the trends shown within that volume. It does not normalize time resolved data to account for 
bleaching and cannot correct severe problems with lighting during the experiment. Ideally, lamp 
flicker should be avoided by using a stable light source. 
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Glossary 

The definitions below explain the terminology used in this guide.  

3D Renderer 

Volocity calculates a projection—a screen image of how the volume appears from a specific 
viewpoint—using direct rendering from the 3-dimensional data. 3D Rendering is orthographic. 

Adopted item 

If you want to edit an image and change it in any permanent way, you need to adopt it first. An item 
that is adopted into the library has the image data stored within the library. This means that any 
changes made to the item are only applied to the adopted item not the original image data.  

Black Level 

The Black Level allows you to control opacity rendering. It sets the lower level for opacity, thus 
allowing you to create an offset from 0. The 3D Renderer will treat anything below the value specified 
as completely transparent.  

Cloak 

There may be times when you want to exclude images from a particular view of the data. For 
example, you may want to run a movie from a Gallery View, but do not want to include all the images 
in a gallery. The cloak command allows you to hide the images without removing them from the 
library.   

Detector Pinhole Size 

This is a parameter in the calculation of a confocal PSF. It is the diameter of the pinhole used while 
acquiring the optical sections.  Note: this is measured in airy units not micrometers. 

Displacement  

This is the straight line distance between the first centroid in a track and the last centroid.  

Displacement rate 

This is the displacement/(time of the last timepoint in the track – time of the first timepoint in the 
track). Displacement rate may also be defined as the average displacement per second. 

Duplicate 

The duplicate command allows you to duplicate items in the library, so that you can include items in 
a number of different folders. 
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Emission/Light Wavelength 

This is a parameter in the calculation of a PSF. It is the emission maximum of the fluorochrome 
imaged in the data set. 

Excitation Wavelength 

This is a parameter in the calculation of a confocal PSF. It is the excitation maximum of the 
fluorochrome imaged in the data set. 

Fast Restoration 

This is a rapid, single-pass process that acts on the volume as a whole. It gives resolution 
improvement in X and Y. 

Folder 

The library may be organised into a number of different folders that best suit your archiving/sorting 
requirements. Each folder may hold sub-folders or individual items. In this way you can organize your 
images into a number of different categories, each with a number of different levels.  

Gallery 

If you have sub-folders in the library of files whose format supports multiple images, for example 
Openlab LIFF files. The gallery view displays all the images in a single view.  

HR Renderer 

Volocity calculates a projection—a screen image of how the volume appears from a specific 
viewpoint—using direct rendering from the 3-dimensional data. HR Rendering is a perspective 
rendering.  Two types of HR Rendering are available: HR Opacity and HR Intensity. 

Image 

This relates to the bottom-level view of the library - the individual image, which may be 2D or 3D. 
Double click on an image or volume thumbnail to display the image in a new window where you can 
view and manipulate it, if required. For 3D items, the view shows the 3-dimensional cross-section of 
all planes (top left section) and each of the axes/planes. 

Image Sequencer 

The Image Sequencer allows interaction with multiple channel, time resolved data by providing an 
easy-to-use interface for this data. 

Iterative Restoration 

This is a restorative technique that reassigns out-of- focus haze (it does not subtract it from the data). 
It is designed to minimize out-of-focus haze and noise throughout the volume. Iterative restoration 
not only gives improvement in resolution in X and Y, but most significantly also in Z.  The results are 
applicable for 3D visualization and all 3D measurements provided by Volocity Classification, 
including intensity.  
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Keywords 

A keyword is an item property that you enter on the Properties dialog to provide additional data about 
that item that can be used in the Find command. 

Library 

This is the structure within which the digital images are collected and organised.  

Linked item 

When items are added to a library, a link is created to the original source data wherever it is held, for 
example on the hard disk, on a CD or on a network server. No image data is stored with the item in 
the library. When you view the linked image, the image data is retrieved from the original image file. 
You cannot make changes to linked items. You must adopt them into the library if you want to apply 
any of the commands that change image data. 

Note: If the library has been moved from one machine to another or the original data has been 
deleted, the item thumbnail will still appear in the library and gallery views, but you may not be able 
to display it as a single image or movie.  

Meandering index 

This is the displacement rate / velocity, which provides a measure of a track’s deviation from a 
straight line. The meandering index is always a value less than or equal to 1. A meandering index of 
1 indicates that the track is a perfect straight line; the smaller the value of the meandering index, the 
greater the meandering of the track. 

Medium refractive index 

This is a parameter in the calculation of a PSF. It is the refractive index of the medium between the 
objective lens and the cover slip. Typical values are 1.0 for air, 1.33 for water and 1.515 for oil. 

Movie 

From the gallery view, you can select the Movie tab to display the contents of the gallery as a movie. 

Movie Sequencer 

The Sequencer allows you to define a number of tasks that manipulate the 3D Views and combine 
them together to produce a movie view of the volume. 

Numerical aperture 

This is a parameter in the calculation of a PSF. It is the numerical aperture of the objective lens. It 
can normally be found engraved on the objective lens. 

Properties 

These describe an item in the library. There are fixed properties, such as image size, source location 
and date details, which cannot be changed. Other properties, however, allow the user to add or edit 
information, such as adding keywords or changing the name.  
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PSF (Point Spread Function) 

Images seen through a microscope contain information from the focal plane of interest plus out-of-
focus information from other focal planes on the image. Volocity Restoration uses a technique called 
deconvolution to remove the out-of-focus information. This is a mathematical technique that 
calculates the out-of-focus information from other images using the “point spread function”, or PSF, 
and subtracts this from the image plane of interest. It processes the Z stack of images as a complete 
data set, converting pixels to voxels (volume elements) to produce high-resolution, deconvolved 
images. 

Skeletal length 

This is the maximum length in the selected object and is shown in the Measurements. The selection 
is eroded evenly from its border inwards until it consists of a one-voxel thick, skeletal representation 
along its entire length. This "skeleton" is then measured. 

Smooth zoom 

The Smooth Zoom command on the View menu applies interpolation to the view to give better quality 
when viewing zoomed images and automatically sets the best quality for printing.  

Thumbnail 

The thumbnail is a representation of an item for quick display. This may be a folder or image. The 
application automatically creates a thumbnail for each image or each layer in a multi-layer image.  

Time span 

This is the number of timepoints spanned by a track. 

Volume 

A volume is the name for a 3-dimensional object within Volocity.  It can exist as a single item within 
the library, created from a series of 2D images related in the Z-dimension or within an image 
sequence, which is a powerful tool for creating a collection of volumes arranged by channel and 
timepoint.  

Voxel  

This is the 3-dimensional equivalent of a pixel, the smallest discrete spatial component of a digital 
volume. Volumes within Volocity consist of voxels, each with an associated color and /or intensity 
value.
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Appendices 

Sampling Widefield Data for Deconvolution 
Overview 

This technical note contains a discussion of some of the requirements of data sampling to achieve 
optimal deconvolution results when using Improvision deconvolution software. Deconvolution will 
generate the best results when presented with the highest quality data.  

Depth of Sample to Scan 
Point spread of light sources from within a sample can extend above and beyond the limits of the 
physical top and bottom of that sample. Deconvolution uses out of focus information to calculate true 
sample data therefore it is important to capture that which extends beyond the sample boundary. 
This means capturing a large enough image size in X and Y and taking sample slices above below 
the object. As a rule of thumb, capture from darkness below the object to darkness above or half the 
thickness of the object of interest above and below, therefore total scanned distance is twice 
thickness of sample object. 

Measured PSFs 
The acquisition of data for a measured PSF must be subjected to the same strict controls as the 
experimental data. Effort must be taken to minimise artefacts or aberrations. If these cannot be 
avoided then the data for the measured PSF should be collected with the same artefacts and 
aberrations as the experimental data. The bead used for measuring PSFs must be a speck bead of a 
size below the resolution of the microscope for the results to be valid. PSFs must be measured from 
a point source of light. 

Optics and Illumination 
The illumination pathway must be clean, free from dust and correctly aligned. Refer to the 
documentation supplied with the microscope to confirm how to align the epi-fluorescence light path. 

Use high numerical aperture lenses. Try to match refractive indices through sample, cover slip and 
immersion medium. 

If the illumination source power output varies during the collection of a data stack this will result in 
there being differences in intensity between z planes. These may be more apparent after 
deconvolution. Volocity Restoration offers a Correct Illumination function which can alter the data to 
remove these variations. It is always preferable to avoid introducing artefacts into images rather than 
correct for them later. Use an illumination source with a stable power supply. Lamp flicker is worse 
towards the end of the life of an arc lamp, replace bulbs if they show signs of flickering and always at 
the end of their recommended life. 
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Practical Considerations 
The above information is for an ideal situation and it may be necessary to compromise on some of 
the recommendations to stay within the performance limits of the hardware and to ensure survival of 
the specimen for the desired duration of the experiment. 

Although operating the camera at its highest resolution will satisfy the Nyquist theorem for sampling 
frequency, it may be necessary to use binning to minimise sample exposure to UV light. In many 
cases the XY sampling will still be approximately half the size of the smallest resolvable object. 

Imaging many stacks over time or imaging a sample which shows photo bleaching may require 
compromise on the number and spacing of z slices. It may be worth considering a volume 
deconvolution technique rather than an iterative restoration if the number of slices has to be reduced. 

Sampling Frequency  
A biological structure labeled with a fluorescent probe consists of continuous distribution of 
fluorescence. Imaging a biological sample means taking samples of this continuous fluorescence at 
discrete points in XYZ space (i.e. images). The frequency at which images are taken therefore 
affects the quality of the final result. 

Nyquist Theorem 

The Nyquist theorem states that in order to fully describe objects they must be sampled at a rate of 
twice the smallest resolvable object in the data. 

For iterative restoration the Nyquist sampling rate is the minimum necessary and higher sampling 
rates will lead to superior deconvolution results. 

For volume deconvolution lower sampling rates in z may be acceptable. The lower the number of 
neighbors being considered in the deconvolution the larger the z spacing that may be acceptable.  

Sampling frequency in X and Y is determined by pixel size of the camera and objective magnification. 
Sampling frequency in z is determined by the distance between slices. 

Sampling in x and y 

Sampling frequency in x and y is determined by the spacing of the pixels on the camera. 

sampling frequency = camera pixel size/total magnification 

XY or lateral resolution: d = 0.61λ/NA 

Where λ =  wavelength and NA = numerical aperture of objective lens 

Minimum sampling frequency in X and Y therefore = d/2. 

If sampling frequency is less than or equal to d then sampling theory is obeyed. 

Sampling in z 

Find the depth of focus of the system and sample at half that distance.  
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A method of calculating DOF is: 

λ/2NA2  

Where λ = wavelength and NA = numerical aperture of objective lens. 

Example 

A sample labeled with GFP (emission wavelength 510nm) is imaged with a 63x oil immersion 
objective with NA of 1.4. The immersion medium has a refractive index of 1.518. The camera has a 
pixel size of 6.45μm2. 

XY or lateral resolution = 222 nm or 0.222 μm 

Z or axial resolution = 130 nm or 0.13 μm 

To follow the Nyquist theorem the sampling interval should be half of these: 

XY sampling = 0.111 μm 

Based on the description above the camera will sample at 0.102μm in X and Y. 

Z sampling = 0.065 μm 

It is as important to sample accurately as it is to sample at the correct frequency. Always use a 
motorised stage, manual adjustment is not only tedious and slow, it is not accurate enough. 

Calculation of the optimum sampling rate will give results of very small values. If the equipment 
available cannot reproducible produce such fine movement, compromise is necessary to maintain 
accuracy. Sample at the smallest reproducible z step.  Biological samples may not tolerate exposure 
to the excitation wavelength for the time necessary for such intensive sampling, and sampling ideals 
will again need to be compromised, as discussed below. 

Avoid backlash in microscope focus mechanisms by moving against the load, or against gravity. 
Move the focus in one direction only during the acquisition. Once started never reverse the direction. 
To avoid backlash at the beginning of a stack focus to the first imaging point, move to below that 
start point then, back up to the start to capture the first frame. 

Signal to Noise 
Maximise signal to noise ratio in images, use longest exposure possible which the sample will 
tolerate without bleaching.   

Avoid pixel saturation; deconvolution will accentuate this and lead to blooming. 

Perform background subtraction on images before deconvolution. 

Spherical Aberration 
Spherical aberration is asymmetry in the spread of light from a point source. It can be detected by 
viewing fluorescently labeled beads with the system. Focus through the beads and look for 
symmetrical spread of light on either side. 
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Use the correct cover slip. Lenses are designed for optimum performance used with certain cover 
slips. A lens will not perform to its specification if used with a different thickness of cover slip. 

Match refractive indices between sample, sample medium, immersion medium and lens. Mismatched 
refractive indices can cause spherical aberration and can lead to optical z section size varying from 
physical z step size, because the path of the emission light is changed at each boundary between 
different RI. 

Try to ensure that all the materials that the light passes through are closely matched for RI.  

It may be preferential to use a lower NA, water immersion lens which more closely matches the RI of 
a watery sample than an oil immersion lens. Also consider dipping objectives which are lowered into 
the medium surrounding the sample. 

Vibration 
Vibration of the acquisition system will cause lateral and axial shifts in the image acquired which will 
degrade the quality of the stack and therefore deconvolution. There is no way to correct for this; 
therefore, systems must be protected from vibration. 
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What Causes Axial Elongation of Structures in Optical Microscopy? 
Overview 

Fluorescently-labeled beads are used for a variety of purposes in optical microscopy, from 
measuring a point spread function to assessing the performance and calibration of the system. The 
beads supplied by manufacturers such as Molecular Probes are manufactured under strict controls 
and can be considered as spheres. Why then do 3D visualisations of these beads, reconstructed 
from 2D sections, appear, not as spheres, but as ovoid?  

The reasons why beads might appear as ellipses instead of spheres in optical microscopy are 
different depending on the size of the objects being observed.  

Working with Small Objects 
The z (axial) resolution of a widefield or confocal microscope is normally three to four times less than 
its xy (lateral) resolution. In other words, the smallest object that can be resolved is approximately 
200 nm in xy and 700 nm in z. 

When working with small objects, such as 200 nm-point source beads for measuring a PSF, this 
effect is significant. The beads will appear to be 3-4x elongated in z.  

The elongation effect caused by the difference in resolution in z is only significant on small structures 
around the resolution limit of the microscope. It is a fact of optical microscopy and should be taken 
into consideration when interpreting data. 

Working with Larger Structures 
When working with larger structures (>10 um) you can sometimes also see elongation. The cause of 
this is normally different. It is due to a mismatching of refractive indices, either between the 
immersion medium of the objective and the sample medium or between the sample medium and the 
sample itself. 

If the refractive indices are mismatched then the physical distance moved by the focus drive is not 
the same as the optical distance. This gets worse as you move deeper into the sample, away from 
the cover slip. Optical distance is less than focus drive distance and the result is stretching in z.  

To minimize this effect we recommend that refractive indices are matched as closely as possible. For 
example if your specimen consists mainly of water and is mounted in an aqueous medium, it would 
be preferable to use a water immersion lens of a slightly lower NA than an oil immersion lens of the 
same magnification and higher NA. 

Another factor which can also effect elongation is spherical aberration from high NA lenses. Most 
microscope manufacturers have special flat-field objectives that will reduce this effect. Consider 
evaluating lenses for spherical aberration before accepting the final example. 

These factors apply to structures within biological samples equally as to beads therefore they should 
be taken into account when interpreting 3-dimensional data.  
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OptiGrid Structured Light Algorithm 
Structured light illumination systems such as the OptiGrid project a sinusoidal pattern onto 
specimens by placing a one-dimensional grating in the microscope’s illumination path.   

The grid is moved in the Y plane into three different positions and an image is acquired at each 
position. The following algorithm is used to produce a single, derivative, confocal image from which 
the grid pattern has been removed.  

Confocal Image= √ ((I1-I2)2+(I1-I3)2+(I2-I3)2) 
I1=Image with the grid in position 1 

I2=Image with grid in position 2 

I3=Image with grid in position 3 

 I1 I 2 I 3 (I1-I2)2 (I1-I3)2 (I2-I3)2 Grid Image 

Strongly 
Focused 

1 1 0 0 1 1 1.41 

Weakly 
Focused 

0.8 0.8 0.2 0 0.36 0.36 0.84 

Out of  
focus 

0.5 0.5 0.5 0 0 0 0 

 

Other sources of information 
Improvision 

TN424: A study of fluorescence standards confirms that OptiGrid confocal images are suitable for 
quantitative microscopy 

Barlow and Guerin (2007)  

Quantization of Widefield Fluorescence Images Using Structured Illumination and Image Analysis 
Software. Microscopy Research and Technique 70:76-84 

Neil MAA, Juskaitis R and Wilson T (1997)  

Method of obtaining optical sectioning by using structured light in a conventional microscope. Optics 
Letters 22: 1905-1907 

Puch AC (2005)  

Resolution Performance in Structured Illumination Microscopy: Comparison of OptiGrid to Traditional 
Confocal Microscopes. Independent Resolution Testing. Thales Optem technical note.
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Index 

2D items, 64 

3D Items, 65 

3D menu, 252 

3D preferences, 257 

3D rendering 

adjusting MIP and opacity example, 277 

adjusting MIP example, 274 

adjusting opacity example, 275 

3D rendering, 249, 272 

3D rotate object task, 291 

3D rotate world task, 291 

3D toolbar, 254 

3D view 

contrast enhancement, 251 

create bookmark, 279 

movie interface, 281 

scale, 253 

view options, 253 

3D zoom task, 290 

A 
acquiring data, 41 

acquisition 

adding points, 216 

auto-focus, 223 

capturing multiple channels, 225 

data quality, 443 

device controls, 130 

devices, 126 

events and logs, 228 

fast restoration, 145 

feedback, 227 

focus limits, 204, 223 

optigrid, 165 

preferences, 126 

scanning, 219 

set up protocol, 222 

acquisition examples 

FLIP, 197 

FRAP, 192 

multi-point, 210 

single point, 188, 200 

xy stage, 210 

acquisition protocols 

FRAP, 192 

multiple channels over time, 232 

multiple channels, multiple z-planes, 234 

multiple channels, multiple z-planes over time, 237 

single channel over time, 231 

single channel, multiple z-planes, 233 

single channel, multiple z-planes over time, 236 

single frame, 230 

activating products, 35 

add data 

drag and drop, 42 
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image sequence, 45 

add points, 216 

adopt items command, 96 

align volumes, 296 

analysis examples 

changes in intensity with object volume, 403 

changes in object velocity over time, 404 

mean intensity of objects, 399 

mean number of objects per cell, 400 

total number of objects measured, 395 

total number of objects measured per timepoint, 
397 

analysis view, 392 

aperture diaphragm 

adjusting, 181 

auto contrast 

uses of, 98 

auto contrast command, 97 

auto-focus, 223 

axial elongation, 463 

B 
background correction 

FLIP, 423 

FRAP, 421 

background corrections 

creating, 106 

inspecting, 109 

why it is needed, 105 

batch processing 

measurements, 381 

photobleaching, 422 

batch processing, 96 

black level task, 293 

bleed-through constants 

fret analysis, 437 

bookmarks 

create, 279 

create movie, 281 

delete, 280 

edit, 280 

move, 280 

use, 280 

bookmarks, 250 

bright reference images, 107 

brightness task, 292 

C 
calculate psf, 445 

calibrate 

objective lens, 135 

calibration 

FRAP acquisition example, 189 

MicroPoint, 184 

optigrid, 165 

photokinesis accessory, 155 

calibration tool, 135 

capture 

image sequences, 225 

capture snapshot command, 91 

CCD active area, 143 

change size command, 100 

changes in intensity with object volume, 403 

changes in object velocity over time, 404 

channel 

target, 347 
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channels 

compress, 81 

show/hide, 85 

chart examples, 410 

chart types, 409 

chart view, 408 

clear movie, 286 

clip objects to ROI, 359 

cloak command, 101 

close 

library, 41 

colocalization 

considerations, 420 

generate, 420 

measure object, 420 

scatter plot, 414 

statistics, 418 

statistics, 418 

thresholds, 415 

colocalization, 335, 412 

colocalization menu, 412 

colocalization toolbar, 412 

colocalization view, 335, 413 

color balance command, 102 

color depth command, 98 

color objects, 359 

color reference 

FRET, 442 

colors command, 99 

combine objects, 359 

compact library command, 60 

compress channels, 81 

connecting optigrid 

manual focus model, 162 

motorized focus model, 159 

contrast enhancement, 142, 251 

contrast enhancement command, 103 

copy 

between libraries, 56 

items, 57 

copy timepoints command, 78 

correct background command, 109 

correct registration command, 114 

create 

background corrections, 106 

bookmark, 279 

folders, 55 

image sequence, 45 

library, 39 

movie sequence, 289 

movie using bookmarks, 281 

protocol, 304 

QTVR movie, 253, 294 

registration corrections, 111 

spectral signatures, 240, 242 

volume, 46 

crop to selection command, 116 

D 
dark reference images, 108 

data acquisition 

FRET, 437 

fret analysis, 437 

data calibration, 444 

delete items, 59 
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density task, 292 

device controls, 130 

device latencies, 137 

devices 

installing and configuring, 126 

setup, 129 

devices, 153 

Devices, 183 

devices preferences, 127 

dichroic, 154 

discrimination mode, 154 

docking palettes, 93 

dongles, 29 

E 
event flag, 228 

exclude non-touching objects, 360 

exclude objects by shape, 360 

exclude objects by size, 361 

exclude objects not touching roi, 361 

exclude objects touching edge, 362 

exclusively combine objects, 362 

export 

as AVI movie, 122 

as QuickTime movie, 122 

export command, 120 

export measurements, 387 

exposure controls, 132 

extended focus command, 67 

F 
fast restoration 

acquisition, 145 

applying, 448 

description, 443 

feedback 

acquisition, 227 

change object colours, 388 

measurement objects, 351 

options, 388 

raw view, 387 

file formats, 49 

fill holes in objects, 362 

filter measurement data, 384 

filter measurements, 362 

filters, 129 

find command, 57 

find objects by % intensity, 363 

find objects by intensity, 364 

find objects in roi, 365 

find objects using hsi, 366 

find objects using rgb, 368 

find objects using sd intensity, 369 

FLIP 

background correction, 423 

photobleaching correction, 423 

FLIP, 197, 423 

FLIP acquisition example, 197 

fly-around tool, 254 

focus controls, 132 

focus limits, 204, 223 

folders 

copy and move, 56 

create, 55 

FRAP 

acquisition protocol, 192 
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background correction, 421 

measurement item, 429 

normalization, 422 

photobleaching correction, 421 

FRAP, 187, 188, 189, 190, 192 

FRAP, 429 

FRAP acquisition 

overview, 187 

preparing experiment, 188 

preparing for, 189 

FRAP acquisition example, 192 

FRAP analysis, 421 

FRAP analysis, 422 

FRAP Preview, 190 

free flight camera control, 255 

FRET 

color reference, 442 

FRET analysis 

applying calculation, 439 

bleed-through constants, 437 

data acquisition, 437 

FRET analysis, 436 

FRET analysis 

data acquisition, 437 

measuring channels, 442 

FRET dialog, 439 

G 
gallery options, 88 

gallery view, 87 

gamepad, 255 

genate colocalization, 420 

grid AF, 171 

grid confocal images 

capturing multi-channel, 178 

capturing single channel, 174 

grid controls, 171 

grid modes, 172 

group measurements, 370 

Grynkiewicz equation, 436 

H 
hand tool, 72 

hardware shaders, 257 

hints 

enabling and disabling, 32 

histogram, 340, 356 

HR intensity rendering 

adjusting brightness example, 261 

adjusting rendering modes example, 266 

HR intensity rendering, 259 

HR opacity rendering 

adjusting black level, density and brightness 
example, 265 

HR opacity rendering, 263 

HR rendering, 249 

I 
Illumination correction, 454 

image menu, 66 

image sequence 

create new, 45 

measure multiple, 317 

timeline view, 77 

image sequence view, 76 

image sequences 

capturing, 225 
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image toolbar, 70 

image view 

2D items, 64 

3D items, 65 

measurements, 340 

image view, 64 

import 

preferences, 42 

import command, 48 

important concepts, 38 

inspection tool, 70 

install 

MicroPoint, 183 

installation 

dongles, 29 

server systems, 29 

single license, 29 

starting after, 30 

intensity modulated images, 442 

internalize measured objects, 371 

intersect objects, 371 

invert objects, 371 

iterative restoration 

applying, 451 

description, 443 

J 
join objects, 385 

joypad, 255 

joypad preferences, 255 

K 
keyframe 

create, 283 

edit, 284 

L 
lambda stacks, 246 

laser power, 154 

lasso tool, 72, 345, 346 

library 

close, 41 

compact, 60 

creating, 39 

definition of, 39 

format, 40, 52 

organizing data in, 51 

selecting items, 63 

storage icons, 54 

Library 

opening, 41 

library menu, 52 

library thumbnails, 53 

library toolbar, 53 

library view, 52, 62 

license server 

change password, 31 

installing Volocity with, 29 

switching to individual license, 31 

License server 

switching to, 31 

light path manager, 138 

light path settings, 140 

line tool, 341 

live enhancement tool, 142 

logs, 228 

M 
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magic wand tool, 73, 345, 346 

magnifying tool, 72 

make measurement item, 355, 382 

make movie, 286, 290 

make volumes command, 46 

make well overlay, 213 

mean intensity of objects measured, 399 

mean number of objects per cell, 400 

measure and track multiple timepoints, 325 

measure channels 

ratio, 435 

measure device latencies command, 137 

measure FRET channels, 442 

measure lines, 371 

measure multiple image sequences, 317 

measure multiple timepoints, 309 

measure object colocalization, 372, 420 

measure objects, 373 

measure objects command, 309 

measure points, 374 

measure psf 

sampling, 459 

measure psf, 446 

measure single timepoints, 304 

measure skeletal length, 375 

measurement item 

FRAP, 429 

measurement item, 308, 355, 382 

measurement protocol, 304 

measurements 

count points, 343 

draw lines, 341 

draw regions, 344 

export, 387 

feedback, 387 

filter data, 384 

histogram, 340, 356 

image view, 340 

join objects, 385 

object feedback, 351 

measurements menu, 353 

measurements protocol 

batch processing, 381 

clear, save, restore,export, 379 

measurements protocol, 341, 358 

measurements view 

feedback options, 388 

measurements view, 340 

merge channels command, 78 

merge planes command, 117 

MicroPoint, 183 

minimum system requirements, 29 

move 

folders, 56 

items, 57 

movie 

clear, 286 

make, 286, 290 

resize, 286 

save and restore, 287 

movie interface, 281 

movie sequence 

3D rotate object task, 291 

3D rotate world, 291 
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3D zoom, 290 

black level, 293 

brightness, 292 

create, 288 

density, 292 

opacity, 293 

switch items, 294 

switch items backwards, 294 

switch timepoints, 294 

switch timepoints backwards, 294 

movie sequencer, 250 

movie view 

navigation palette, 89 

movie view, 89 

multiple channels over time acquisition, 232 

multiple channels, multiple z-planes acquisition, 234 

multiple channels, multiple z-planes over time 
acquisition, 237 

multi-point acquisition example, 210 

N 
navigation palette 

classic 3D rendering, 272 

HR intensity rendering, 259 

HR opacity rendering, 263 

movie view, 89 

play back timepoints, 80 

ray tracer, 270 

slice view, 301 

navigation palette, 82 

noise, 461 

normalization 

FRAP, 422 

notes view, 91 

Nyquist theorem, 460 

O 
objective lenses, 135 

offsets, 109 

opacity task, 293 

open 

library, 41 

OptiGrid 

calibration, 165 

capturing multi-channel grid confocal images, 178 

capturing single-channel grid confocal images, 174 

connecting manual focus model, 162 

connecting motorized focus model, 159 

grid controls, 171 

how to use, 171 

manual focus model preferences, 165 

motorized focus model preferences, 164 

structured light algorithm, 464 

troubleshooting grid imaging, 181 

troubleshooting installation and calibration, 168 

OptiGrid, 158 

overlays 

save and restore, 215 

overlays, 213 

P 
page setup command, 120 

palette 

docking, 93 

navigation, 82, 89, 259, 263, 270, 272, 301 

voxel spy, 86 
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pan tool, 72 

photobleaching correction 

FLIP, 423 

FRAP, 421 

PhotoKinesis accessory, 151 

pivotal point of rotation, 254 

point tool, 343 

points 

inspect and edit, 218 

random, 217 

save and restore, 219 

scanning, 221 

points, 216 

preferences 

3D, 257 

after installation, 31 

for acquisition, 126 

import, 42 

joypad, 255 

optigrid manual focus model, 165 

optigrid motorized focus model, 164 

photokinesis accessory, 151 

UltraVIEW, 149 

print command, 120 

print preview command, 120 

properties, 54 

protocols 

setup and run, 222 

psf 

calculate, 445 

measure, 446 

psf items, 444 

Q 
QTVR movie, 253, 294 

quantitation 

measure and track multiple timepoints, 325 

measure multiple image sequences, 317 

measure multiple timepoint, 309 

measure single timepoint, 304 

quit Volocity, 34 

R 
ratioing 

apply calculation, 432 

color reference, 435 

measure channels, 435 

measuring channels, 435 

ratioing, 432 

raw data view, 383 

ray tracer, 268 

reference images, 107 

registration corrections 

automatically create, 112 

inspecting, 113 

manually create, 112 

registration corrections, 111 

remove items command, 59 

remove noise command, 117 

remove noise from objects, 375 

renderers 

selecting, 258 

types of, 249 

rendering view, 250 

resample timepoints command, 79 

reset channels command, 66 
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resize movie, 286 

restoration 

data quality, 443 

types of, 443 

restore objects, 376 

retain objects, 376 

reveal in finder/explorer command, 60 

ROI 

selecting on video preview, 144 

ROI options, 74 

ROI options, 74 

ROI tools, 72, 344 

rotate commands, 53 

rotate slice tool, 298 

rotate tool, 254 

rotate volume tool, 300 

S 
sampling 

depth of scan, 459 

sampling for deconvolution, 459 

sampling frequency, 460 

save and restore movie, 287 

scan points, 221 

scanning, 219 

scatter plot, 414 

selection tools, 72, 73 

separate color images, 244 

separate monochrome images, 246 

separate touching objects, 376 

serial ports preferences, 126 

Session log, 33 

shading defects, 105 

show color reference command, 67 

show data command, 92 

show in library command, 60, 90 

show scale command, 69 

show time command, 67 

shutter controls, 134 

single channel over time acquisition, 231 

single channel, multiple z-planes acquisition, 233 

single channel, multiple z-planes over time 
acquisition, 236 

single frame acquisition, 230 

single point acquisition example, 200 

size 

changing, 100 

slice view 

create data, 302 

navigation palette, 301 

slice view, 250, 297 

slicing orientation, 297 

sliders, 135 

smooth zoom command, 66 

snapshots, 91 

software updates 

automatic check, 32, 34 

license server, 35 

software updates, 34 

sort by command, 92 

spectral separation, 239 

spectral signatures 

create from color, 240 

create from monochrome, 242 

separating color, 244 
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separating monochrome, 246 

spherical aberration, 461 

spinning disk, 445 

spinning disk illumination, 148 

split multi-colored items command, 118 

split volumes command, 119 

stage setup, 210 

starting Volocity, 30 

statistics 

colocalization, 418 

statistics, 418 

status bar (Windows), 63 

subtract objects, 376 

supported file formats, 49 

switch items backwards task, 294 

switch items task, 294 

switch timepoints backwards task, 294 

switch timepoints task, 294 

T 
target channel, 347 

technical support, 28 

thresholds, 415 

thumbnails 

in library, 53 

thumbnails command, 52 

timeline view 

zoom, 79 

timeline view, 77 

timepoint sequence 

add, 283 

edit, 285 

timepoints 

absolute or relative, 78 

copy, 78 

measure and track, 325 

measure multiple, 309 

measure single, 304 

play back, 80 

resample, 79 

total number of objects measured, 395 

total number of objects measured per timepoint, 397 

track multiple timepoints, 325 

track objects, 377, 379 

track objects task, 328 

troubleshooting 

grid imaging, 181 

OptiGrid installation and calibration, 168 

U 
UltraVIEW 

testing calibration, 158 

UltraVIEW, 149, 152, 153 

UltraVIEW VoX, 148 

undo command, 96 

unlock codes, 35 

using the optigrid, 171 

V 
vibration, 462 

video feedback, 145 

video preview 

CCD active area, 143 

centering XY stage, 144 

cropping, 143 

selecting ROI, 144 

zooming, 143 
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video preview window, 141 

view 

3D, 250 

analysis, 392 

chart, 408 

colocalization, 335, 413 

export as AVI or QuickTime movie, 124 

gallery, 87 

image, 64 

image sequence, 76 

library, 52, 62 

measurements, 340 

movie, 89 

notes, 91 

raw data, 383 

rendering, 250 

slice, 250, 297 

xy stage, 211 

view options 

roi settings, 74 

view options, 72 

view tracks, 379 

visualization 

bookmarks, 250, 279 

movie sequence, 288 

movie sequencer 

separating color, 250 

rendering and 3D view, 250 

select renderer, 258 

set pivot for rotation, 254 

what it does, 249 

Volocity 

important concepts, 38 

quitting, 34 

volumes 

align, 296 

create, 46 

split, 119 

voxel spy palette, 86 

W 
wells 

overlays, 213 

scanning, 220 

X 
XY stage 

centering on video preview, 144 

XY stage, 210 

xy stage example, 210 

xy stage view 

add overlays, 213 

XY stage view, 211 

Z 
zoom 

video preview, 143 

zoom tool, 72 
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